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Introduction
This document explains how to install Cisco UnifiedWorkforce Optimization Quality
Management 11.0 on a server in a Cisco Unified Contact Center Express (Unified CCX)
environment.
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Introduction

What's New in This Version

Version Changes

11.0(1) n Merged the Desktop Requirements Guide, Desktop Applications Deployment

Guide and Firewall Configuration Guide into the Installation Guide

n Added support for Network Based Recording using the Cisco Unified

CM Recording functionality from either an IP phone (BIB) or gateway. Network

Based Recording supports Cisco CUBE Recording via SIP and CiscoMedi-

aSense.

n Added information on hard disk drive (HDD) partitioning.

n Added information on configuring a customer relationship management (CRM) sys-

tem.

n Added information on integrating SNMP.

n Added the Kerberos Authentication check box to the Enterprise Settings window.

When enabled, a user must enter the AD credentials to access Recording controls.

n Added support for cloud based recording storage for Quality Management.

n Added support for two stage upload. Two stage upload functions in one of two

manners:

1. If you are using Desktop Recording (or Gateway Recording), the Desktop

Recording service will round robin through all Recording Servers asso-

ciated with the site. This will happen regardless of the location of the

Recording Servers. If you are using Desktop Recording and need to limit

your uploads to a local Recording Server, you will need to configure a site

for that location.

2. If you are using Server Recording, the Desktop Recording service will

round robin through Recording Servers that are in the same cluster as the

agents. All recordings will go to your local Recording Cluster. If no con-

figuration information is available for your local Recording Cluster, no

recordings will upload from those agents.

n Added support for Unified CCX version 11.0, Unified CM 11.0(1a), andMediaSense

11.0.
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System Requirements
The following topics list theminimum system requirements for QualityManagement.

Quality Management Environment

QualityManagement 11.0 is compatible with CiscoWorkforceManagement (WFM) 11.0.

Supported Environments

QualityManagement has been verified with the following environments:

Environment Version

Cisco Unified Contact Center

Express

8.5, 9.0, 10.0, 10.5, 10.6, 11.0

Cisco Unified Communications Man-

ager

8.0, 8.5, 8.6, 9.1(2), 10.0, 10.5 SU2a, 11.0(1a), 11.5

CiscoMediaSense 8.5, 9.1, 10.0, 10.5, 11.0

Cisco PhoneModel Support Unified CM Silent Monitoring/Recording Supported Device

Matrix

QualityManagement has direct dependencies on Cisco Unified CommunicationsManager
(CM) for CTI and SIP events. Therefore, QualityManagement compatibility with Unified CM is
generally limited to the corresponding Unified CM version at the time of release and at least
one prior version. Previous versions of QualityManagement are not generally updated for
compatibility with new versions of Unified CM.
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SystemRequirements

QM Versions 10.0, 10.5, and 11.0

QM All in ONE (QM, Recording, and SQL) OVA

TheQMAll in OneOVA provides a single server solution that includes the recording service for
voice recording sessions via Server Recording (SPAN), Network Recording “Built-in Bridge”,
MediaSense Recording, andGateway (CUBE) Recording including a SQL Server database
instance.

Specifications 2 vCPU 4 vCPU 6 vCPU 8 vCPU

Maximum concurrent recording

service sessions1
25 100 300 400

vCPU 2 4 6 8

Minimum Processor Speed 2GHz 2GHz 2GHz 2GHz

vRAM 4 4 6 8

Minimum input/output operations

per second (IOPS)

143 143 143 143

HDD Partitioning

System Storage (GB) for Operating

System

32GB 32GB 32GB 32GB

Application Storage (GB) (QM/SQL

Binaries)

40 GB 40GB 40GB 40 GB

1Concurrent recording service sessions are tested for the amount of concurrent recording
sessionswhile alsomonitoring 3 times that amount in active calls. “Monitoring” active call
sessions entails registering a device for JTAPI events but not necessarily recording that device.
Testing this way allows you to perform additional load testing on theQualityManagement CTI
service with respect to active recordings.
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Specifications 2 vCPU 4 vCPU 6 vCPU 8 vCPU

SQLDatabase Partition (mdf, ldf)

Note: Only applies if SQL is

coresident with Quality

Management.

100GB 100GB 100GB 100 GB

Optional daily storage partition See Daily

Recording Stor-

age

See Daily

Recording Stor-

age

See Daily

Recording

Storage

See Daily

Recording

Storage

Optional permanent storage par-

tition

See Permanent

Recording Stor-

age

See Permanent

Recording Stor-

age

See Per-

manent

Recording

Storage

See Per-

manent

Recording

Storage

Concurrent recording sessions—themaximumnumber of concurrent recording sessions over a
period of 24 hours for the QM recording service.

Concurrent active calls—themaximumnumber of device calls actively beingmonitored via
JTAPI registration by theQMCTI Service.

Example: If you aremonitoring JTAPI events for 75 active calls over a period of 24
hours, themaximumnumber of concurrent recording sessions handled by the recording
service is 25.

Expansion Recording Server OVA

You can add expansion Recording servers to an existing QMAll in oneOVA to increase
recording capacity.
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Specifications 2 vCPU 4 vCPU 6 vCPU 8 vCPU

Maximum concurrent recording service

sessions1
150 300 500 600

vCPU 2 4 6 8

Minimum Processor Speed 2GHz 2GHz 2GHz 2GHz

vRAM 4 4 6 8

Minimum input/output operations per

second (IOPS)

143 143 143 143

HDD Partitioning

System Storage (GB) for Operating

System

32GB 32GB 32GB 32GB

Application Storage (GB) (QM/SQL Bin-

aries)

40 GB 40GB 40GB 40 GB

Optional daily storage partition See Daily

Recording

Storage

See Daily

Recording

Storage

See Daily

Recording

Storage

See Daily

Recording

Storage

Optional permanent storage partition See Per-

manent

Recording

Storage

See Per-

manent

Recording

Storage

See Per-

manent

Recording

Storage

See Per-

manent

Recording

Storage

1Concurrent recording service sessions are tested for the amount of concurrent recording
sessionswhile alsomonitoring 3 times that amount in active calls. “Monitoring” active call
sessions entails registering a device for JTAPI events but not necessarily recording that device.
Testing this way allows you to perform additional load testing on theQualityManagement CTI
service with respect to active recordings.
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IOPS and Storage System Performance
Requirements

Theminimum IOPS for QM9.0 and later is 143.

Cisco WFO Desktop Recording

Desktop Recording is a recordingmethod where a recording client application is installed on a
client desktop to capture packets of an IP phone that is daisy chained to the client desktop.
Desktop recording can be used in addition to any of the existing OVA designswhichmay use
the Recording Service for Server Recording (SPAN), Network Recording “Built in Bridge”,
MediaSense Recording, or Gateway (CUBE) Recording.

Daily Recording Storage

You need to determine your hard disk space requirements for the daily recording storage. Daily
recording storage is where the recording service will store recorded files temporarily until they
are uploaded to permanent storage. The formula used to determine hard disk space
requirements, in GB, for a single recording server configuration is as follows:

The daily recording storage requirements are as follows:

n For 8-bit WAV—the value is 2 GB for voice recording only or 2.5 GB for voice and screen
recording

n For 16-bit WAV—the value is 6 GB for voice recording only or 6.5 GB for voice and
screen recording

Daily Recording Storage Formula:

n C= GB

n D= Number of Recording users

Daily Storage = C xD

Example: (.5 GB x 100 Recording users) = 50GB Daily Storage
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Permanent Recording Storage

To calculate the storage that required for your contact center, you need to collect the following
data:

n Number of agents who will be recorded

n Average length of calls that are recorded

n Number of calls that are recorded per agent per day

n Number of work days per agent per month

n Number of months that recordingswill be kept

The number of minutes that will be recorded every day is the product of three numbers: the
number of agents being recorded, the average call length, and the average number of calls that
are recorded for each agent per day.

To estimate the amount of disk storage required for your system, use the following formulas:

Amount File Format Formula

Daily recordedminutes (# of Agents) × (Avg. call length) × (# of Calls) = Daily Recor-

dedMinutes

Total recordedminutes

to store

(Daily RecordedMinutes) × (Days per Month) × (Months to

store) = Stored

Voice recording stor-

age (MB)

SPX Stored = 0.12MB/Minute = Voice

8-bit WAV Stored = 0.48MB/Minute = Voice

16-bit WAV Stored = 1.44MB/Minute = Voice
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Amount File Format Formula

Note: The storage requirement

for screen recording depends

on three factors: screen

activity, monitor resolution, and

the number of monitors being

recorded. The value shown

here is based on low to

moderate screen activity, 768 x

1024 resolution, and a single

monitor. This ratemay increase

by 200-400% when recording

dynamic, graphical, or media-

intensive applications.

Stored = 1.20MB/Minute = Screen

Cisco WFO QM OVA Design Examples

The following examples show how to scale QualityManagement by adding a separate
Expansion Recording Server OVA whenQualityManagement reaches its recording capacity.
This applies to all three QMAll in ONE OVA solutions.

Example 1—All in one 2 vCPU OVA with Expansion Recording server

OVA Description Concurrent Users

2 vCPU QM all in oneOVA (includes SQL server) 25 for Network Recording

2 vCPU Expansion Recording server OVA 150 for Network Recording

Total concurrent recording users 175 for Network Recording
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Example 2—All in one 4 vCPU OVA with Expansion Recording server

OVA Description Concurrent Users

4 vCPU QM all in oneOVA (includes SQL server) 100 for Network Recording

4 vCPU Expansion Recording server OVA 300 for Network Recording

Total concurrent recording users 400 for Network Recording

Example 3—QM + Recording server OVA + Standalone SQL server

OVA Description Concurrent Users

4 vCPU QM all in oneOVA  100 for Network Recording

4 vCPU Expansion Recording server OVA 300 for Network Recording

4 vCPU QM all in oneOVA for Standalone SQL server N/A

Total concurrent recording users 400 for Network Recording

Example 4—Redundant CTI with Standalone SQL server

OVA Description Concurrent Users

4 vCPU QM all in oneOVA  100 for Network Recording

4 vCPU Expansion Recording server OVA 300 for Network Recording

2 vCPU QM all in oneOVA (Redundant CTI server) N/A

4 vCPU QM all in oneOVA for Standalone SQL server N/A

Total concurrent recording users 400 for Network Recording

Example 5—Redundant CTI and Recording servers with Standalone SQL server

OVA Description Concurrent Users
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Example 5—Redundant CTI and Recording servers with Standalone SQL server

6 vCPU QM all in oneOVA  300 for Network Recording

6 vCPU Expansion Recording server OVA 500 for Network Recording

6 vCPU Expansion Recording server OVA (Redundant Record-

ing server)

500 for Network Recording

2 vCPU QM all in oneOVA (Redundant CTI server) N/A

4 vCPU QM all in oneOVA for Standalone SQL server N/A

Total concurrent recording users 800 for Network Recording

Server Operating Systems

QualityManagement supports 64-bit WindowsServer 2008 R2, 2012, and 2012 R2.

Note: SinceQualityManagement does not have direct version/update dependencies, it
is permissible to apply updates to the server operating system as recommended by
Microsoft.

Best Practices: If you installWireshark on aMonitor server or aMediaMonitor server
whereWindows 2012 or 2012 R2 is installed, youmust disableWinPcap at startup and
restart the server to ensure thatWireshark andQualityManagement serviceswill both
work simultaneously.

Microsoft SQL Server

Microsoft 64-bit SQL Server 2008, 2008 R2, 2012, and 2014.

When determining your Microsoft SQL server requirements, note the following:

n QualityManagement only supports the Express Edition if the overall number of contacts
in the database is less than 500,000 contacts, and the following SQL Express limitations

23



SystemRequirements

are not exceeded. The Express Edition of theMicrosoft SQL Server has the following
limitations:

n Limited to the lesser of 1 socket or 4 core.

n Maximumof 1 GB RAM. This affects large databases.

Example: The size limitation can affect paging in large databases.

n Maximumdatabase size is 10 GB.

n SQLProfiler is not included in the Express Edition. Cisco’s ability to troubleshoot
performance issueswill be limited.

n TheNTRights utility (ntrights.exe), available in theWindowsResource Kit, is required to
grant the external storage user Log on as a Service rights. For more information, see
http://support.microsoft.com/kb/315276.

SQL Server Guidelines and Contact Metadata

The contact metadata for QualityManagement is stored inMicrosoft SQL database server. To
ensure satisfactory response rates from theMicrosoft SQL database the resources listed in the
following tablemust be available and configured for use byMicrosoft SQL on its hosting server.

Standalone SQL Server

You have the option to deploy a standaloneMicrosoft SQLDatabase server to improve
response rates and allow for scalability. If you choose to implement a standalone SQL Server
then use theQMAll in OneOVA template for the purpose of SQL Server deployment.
Determining vCPU requirements should be based on your Contact Metadata calculations (call
volumes, retention periods, number of agents, and so on).

Increasing vRAM for SQL

You can also scale RAM in increments of 2 GB for the SQL Server as the number of contact
metadata increases. This will ensure satisfactory response rates from theMicrosoft SQL
Server database. Please reference the table below for guidelines. This applies to coresident
SQL in QMAll in OneOVA and the standalone SQL Server deployments.

Use the following formula to estimate themaximumnumber of contacts stored in the database:

A × B × C × D = E

where:

24
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n A = Number of agents

n B = Average number of recorded contacts per day per agent

n C = Number of days per month the contact center handles calls

n D = Configured retention time inmonths

n E = Total saved contacts in the database

Example: 300 (agents) x 25 (average, contacts/day) x 22 (# days/month) x 12 (retention
months) = 2.1million recorded calls (contacts in database)

Specifications
All in One System

All in ONE

+ Expan-

sion

Server

System

2 vCPU 4 vCPU 6 vCPU 8 vCPU 8 vCPU

Number of Record-

ing Users

25 100 300 400 600

Average number of

recorded contact

per day/per user

40 40 40 40 40

Number of days

per month taking

calls

22 22 22 22 22

Configured reten-

tion time inmonths

12 12 12 12 12

Example cal-

culations of total

saved contacts in

the database

based onOVA

264,000 1,056,000 3,168,000 4,224,000 6,336,000
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Specifications
All in One System

All in ONE

+ Expan-

sion

Server

System

2 vCPU 4 vCPU 6 vCPU 8 vCPU 8 vCPU

Total saved con-

tacts in the data-

base

Less than 500,000 contacts 500,000 -

2Million

contacts

2 - 3mil-

lion con-

tacts

4+ million

contacts

6+ million

contacts

Minimum SQLEdi-

tion

SQL Express (up to 500K

Contacts) or SQL Standard

Edition—seeMicrosoft SQL

Server for additional inform-

ation

SQL

Standard

Edition

SQL

Standard

Edition

SQL

Standard

Edition

SQL Stand-

ard Edition

Requires anOff-

boardMicrosoft

SQL Server

No No No Yes Yes

Optional Stan-

dalone SQL Server

Use 2 vCPU QM All in One

OVA for SQL

Use 4

vCPU

QM All in

OneOVA

for SQL

Use 6

vCPU

QM All in

OneOVA

for SQL

Use 8

vCPU

QM All in

OneOVA

for SQL

Use 8

vCPU QM

All in One

OVA for

SQL

You can useMicrosoft SQL Server Express if the overall number of CiscoWFOcontacts in the
database is less than 500,000 contacts, and the followingMicrosoft SQL Express limitations
are not exceeded:

n Limited to the lesser of 1 socket or 4 cores

n Maximum1GB RAM. This affects large databases.

Example: The size limitation can affect paging in large databases.

n Maximumdatabase size is 10GB.
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Supported VMWare

A virtual server environment requires hardware resources equivalent to those required for a
physical server (see Server Hardware). QualityManagement must be installed in its own
computing environment that is not shared with multiple hosts.

QualityManagement supports VMware ESXi 4.0, 4.1, 5.0, 5.1, and 5.5.

Important: VMware Snapshots are only supported for QualityManagement when calls
are not being recorded. A snapshot impacts server resources that are critical to Quality
Management. Recording failures will occur if snapshots are taken while Quality
Management is recording calls. Before you take a snapshot, verify that there is no
current recording activity and stop the services for QualityManagement or pause or shut
down the server. You can use the RecordingMonitoring application to verify that there
are no calls currently being recorded. After you take a snapshot youmust restart Quality
Management services. You can restart services for QualityManagement by restarting
the appropriate signaling service or running a service restart script.

The recommended VMWare settings are as follows:

Setting Description

Shares Guarantee that VMs are given a percentage of an available resource (CPU, RAM,

Storage I/O, Network)

Limits Guarantees that a VM does not consumemore than a specified resource limit

Resource Reser-

vation

Provides an allocated resource for a VM on startup.

Quality Management in a Cisco UCS Environment

QualityManagement is certified to run on anyCisco Unified Computing System (UCS) server
with resources available to support the OVA/OVF template.

The virtual server requirements for deployments on UCS servers are specified on the Cisco
wiki page "Virtualization for Cisco UnifiedWork ForceOptimization Suite for Cisco Unified
Contact Center Express" located at this URL:
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http://docwiki.cisco.com/wiki/Virtualization_for_Cisco_Unified_Work_Force_Optimization_
Suite_for_Cisco_Unified_Contact_Center_Express

Exchange

n Microsoft Exchange Server 2007, 2010, and 2013

n Microsoft Office 365

Event Timestamps

Many featureswithin QualityManagement rely on timestamps of events to properly associate
data with the correct person or call. QualityManagement requires that all servers running
Cisco software are configured to use the sameNetwork Time Protocol (NTP) server asCisco
Unified CommunicationsManager. Windows Time Service is onemethod that can be used for
this purpose.

The agent's timestamp for a call depends on where the call is recorded.

n Desktop Recording—The call is recorded on the agent's desktop so the timestamp and
time zone for the call will be associated the agent's desktop.

n Recording server—The call is recorded on a Recording server so the timestamp and time
zone for the call will be associated with the Recording server. If the agent is in one time
zone and the Recording server is in another timezone, the timestamp and time zone for
the call will be associated with the Recording server. If you havemultiple Recording serv-
ers and they are in different time zones, the timestamp and time zone used will be based
on where each Recording server is located.

Quality Management Port Usage

The following topics list the inbound port requirements for the QualityManagement server
components and the server connections to external integration points.

All outbound communications uses dynamic ports unless otherwise listed. A server may
contain one or more components and not all ports are required for all recording types. Ports
marked with an * are the default port and can be changed in the configuration.
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SeeWindows Firewall or Internet Connection Sharing Service for additional information on
Microsoft SQL Server and Informix JDBC Driver ports.

Windows Firewall or Internet Connection Sharing Service

For UnifiedWorkforce Optimization to function correctly, the ports listed in this document must
be opened inWindows Firewall.

If Windows Firewall or the Internet Connection Sharing (ICS) service is running when Unified
Workforce Optimization is installed, the installation process opens the necessary firewall ports
except those in the following table, whichmust be openedmanually.

Product Open Manually

Quality Management Microsoft SQL Server: ports 1433 and 1434

Informix JDBC Driver: port 1504 (Unified CCX environment only)

See Adding Firewall Exclusions by Program for information on addingWindows Firewall
exclusions and allowing remote connections for Microsoft SQL Server and Informix
JDBC Driver.

Portsmust be openedmanually in these situations:

n If another firewall is used

n If you turn on theWindows Firewall after UnifiedWorkforce Optimization is installed

See your firewall documentation for instructions on configuringmanual port exceptions.

Note: Any non-UnifiedWorkforce Optimization services that use the ports listed in this
document must be configured to use a different port.

Configuring Firewall Port Exceptions

Portsmust be openedmanually in these situations:

n If another firewall is used

n If you turn on theWindows Firewall after the WFOproduct is installed
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Adding Firewall Exclusions by Program

Remote connections require that theMicrosoft SQL Server ports are accessible through the
firewall. If you use a named instance, then the port that Microsoft SQL Server uses is dynamic
so that excluding port numbers in the firewall can be difficult. An easier method is to exclude a
program by name.

1. On the server that hostsMicrosoft SQL Server, choose Start > Control Panel > Check
Firewall Status.

TheWindows Firewall application starts.

2. Click Allow a Program or Feature throughWindows Firewall.

The Allowed Programswindow appears, listing all programs on the server.

3. Click the Allow Another Program button.

The Add a program dialog box appears.

4. Click Browse and navigate to theMicrosoft SQL Server engine (sqlserver.exe).

5. ClickOPEN.

6. In theWindows Firewall window, verify that sqlservr.exe is in the list of Programs and
click Add.

All ports that theMicrosoft SQL Server opens are now accessible.

Quality Management Jetty Component

TheMonitoring and Recording Jetty service uses TCP ports 80, 443, and 7001. Make sure that
you do not have any other web service that use these ports installed on the Base server and
Site Upload server or the Jetty servicemight fail.

Example: Microsoft SQL Server 2008 Reporting Services andMicrosoft Internet
Information Services (IIS) might use these ports.

Port 7001 is reserved exclusively for QualityManagement for encrypted data transfer.

The SQL Server 2008 Reporting Services is a tool that provides a web-basedGUI to present
SQL performance information. You can configure this tool to use another port so it does not
interfere with the Jetty service.
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Consult your SQL Server documentation for instructions on changing the port used by
SQL Server 2008 Reporting Services.

Base Component

The following table lists the inbound ports on the base server that must be opened in the
Windows Firewall.

Port Type Destination Source

80 TCP Jetty service (Jetty port) All servers and

clients

443 TCP Jetty service (Jetty SSL port) All servers and

clients

7001 TCP Jetty service (Jetty alternate port) All servers and

clients

59011 TCP Sync service Quality Man-

agement Admin-

istrator client

59103 TCP Jetty service (Data API service)

Note: The surrogate port is located on the Base server.

The Data API Service uses this port to communicate with

the Surrogate through the Jetty service.

Data API

59112 TCP Jetty service (Data API service) Data API

Inbound Ports

Port Type Destination Source

1504 TCP Unified CCX Informix data-

base

Sync for Unified CCX

External Communication
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Port Type Destination Source

8443, 443,

or 80

TCP Unified CM Publisher and

Subscribers

MANA, Sync, andQuality Management Admin-

istrator

389* or

636*

TCP Active Directory Data API andQuality Management Administrator

25* TCP SMTP Server MANA and Jetty

* TCP SNMP MANA

1433 TCP SQL System Configuration Setup (postinstall.exe),

Data API, and Sync

CTI Component

The following table lists the ports on the recording CTI server that must be opened in the
Windows Firewall.

Port Type Destination Source

52102 TCP CTI Service All servers and clients

5060 UDP/TCP CTI Service Recording CTI service (SIP Messaging)

5061 TCP CTI Service Recording CTI service (secure SIP Messaging)

59110 TCP CTI Service AACC withMLS

Inbound Ports

Port Type Destination Source

1433* TCP SQL database DB Proxy

TCP Unified CM CTI Manager CTI service

External Communication
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CUBE SIP CTI Component

The following table lists the ports on the CUBE SIP CTI server that must be opened in the
Windows Firewall.

Port Type Destination Source

5060 UDP/TCP CUBE SIP CTI service CUBE Voice Gateway

59106 TCP CUBE SIP CTI service All servers

Inbound Ports

None

External Communication

Database Component

The following table lists the ports on the Database server that must be opened in theWindows
Firewall.

Port Type Destination Source

52103 TCP DB Proxy service All servers

Inbound Ports

Port Type Destination Source

1433* or

1434*

TCP SQL database

Note: This port can be changed or be dynamic if you are

using a named instance.

DB Proxy

External Communication
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MediaSense Subscription Component

The following table lists the ports on theMediaSense Subscription server that must be opened
in theWindows Firewall.

Port Type Destination Source

59104 TCP MediaSense Subscription service All servers

59105 TCP MediaSense Subscription service All servers

Inbound Ports

Port Type Destination Source

8440* TCP MediaSense API Server MediaSense Subscription Service

External Communication

Monitor Server Component

The following table lists the ports on theMonitor server that must be opened in theWindows
Firewall for Server Recording deployments.

Port Type Destination Source

59101 TCP Monitor service All servers

All All Monitoring NIC SPAN Session

Inbound Ports

None

External Communication

Voice Record Component

If you are not usingWindows Firewall, the following table lists the ports on the Voice Record
server that must be opened.
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Port Type Destination Source

59102 TCP Network Recording ser-

vice

All servers

39500 to

41500

UDP Network Recording ser-

vice

BiB RTP stream from phones or RTP stream from

CUBE

Inbound Ports

Port Type Destination Source

8440* TCP MediaSense Record Server Voice Record Server

External Communication

Site Component

The following table lists the ports on the Site Upload server that must be opened in the
Windows Firewall.

Port Type Destination Source

80 TCP Jetty service (Jetty port) All servers and clients

443 TCP Jetty service (Jetty SSL port) All servers and clients

7001 TCP Jetty service (Jetty alternate

port)

Used for both site and base server

59100 TCP Upload Controller service All servers and clients

59108 TCP Jetty service AudioCodes Telephony Signaling port, MEDIA

API

Inbound Ports

Port Type Destination Source

135 to 139 and 445 TCP Storage Location Jetty Service (File Transfer)

External Communication
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Media Encoder Component

The following table lists the ports on theMedia Encoder server that must be opened in the
Windows Firewall.

Port Type Destination Source

59109 TCP Media Encoder service All servers

Inbound Ports

Port Type Destination Source

135 to 139 and 445 TCP Storage Location Jetty Service (File Transfer)

External Communication

Reconciliation Component

The following table list the ports for the Reconciliation service that must be opened in the
Windows Firewall.

None

Inbound Ports

Port Type Destination Source

8443, 443, or 80 TCP Unified CM Publisher and Subscribers Reconciliation

1433* TCP SQL Reconciliation

1504 TCP Unified CCX Informix database Reconciliation for Unified CCX

External Communication
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Desktop Client, Citrix Server, or Windows Terminal Services
Component

The following table lists ports that must be opened in theWindows Firewall on the desktop
client, Citrix server for thin client users, or Windows Terminal Services if you want to use the
Live ScreenMonitoring feature.

Port Type Destination Source

49152 to 65535 TCP Thin Client Screen Recording service Live ScreenMonitoring Client

Inbound Ports

Desktop Requirements

The following topics describe the required desktop hardware and software requirements for
each Cisco UnifiedWorkforce Optimization product.

Cisco Unified Workforce Optimization Suite Requirements

The following desktop requirements apply to all products in the Cisco UnifiedWorkforce
Optimization suite, except where noted.

n Client Requirements

n Browser

n Supported Third Party Software

Client Requirements

These desktop hardware requirements apply to Recording andQualityManagement.

PC Hardware

NIC 100Mbit NIC

NICs must support Promiscuous Mode.
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PC Hardware

Disk

Space

Screen storage formula:

# of Recordings x Avg Call Length x 1.20MB/Minute = MB of Required storage per day

Note: The storage requirements for screen recordings depend on three

factors: screen activity, monitor resolution, and the number of monitors being

recorded. The value shown here is based on low tomoderate screen activity, 768 x

1024 resolution, and a single monitor. This ratemay increase by 200-400% when

recording dynamic, graphical, or media-intensive applications.

The operating system requirements for the Cisco UnifiedWorkforce Optimization suite are as
follows:

Product Operating System

CAS and

Recording

andQuality

Management

n Windows 8.1 Update 1 (32/64-bit)—Professional

Windows Media Player is required. Only Windows 8.1 Volume License (VL)

includes Windows Media Player. For all other versions of Windows 8.1, you

must download and install theMedia Feature Pack forWindows 8.1

separately to addWindows Media Player.

n Windows 7 (32/64-bit)—Professional, Enterprise, Ultimate

Windows Media Player is required. Windows Media Player is not included in

Windows 7 N or KN. If you are usingWindows 7 N or KN, youmust download

and install Windows Feature Pack forWindows N and KN separately to add

Windows Media Player.

Note: Cisco supports the operating system’s latest Service Pack.

Windows Aero Theme

WindowsAero theme is not supported by the Desktop Recording service.

Live screenmonitoring is based on theMicrosoft WindowsDesktop Sharing API. This same
API is used byMicrosoft WindowsRemote Assistance. One limitation of theMicrosoft
WindowsDesktop Sharing API is that it does not support theWindowsAero theme for the PC
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running the Desktop Recording service. Every time the Desktop Recording Service starts,
Windowswill automatically switch your PC to theWindowsBasic theme. TheWindowsBasic
themewill remain until the Desktop Recording service is stopped.

If this is not the desired behavior, choose one of the following work arounds:

n Configure your PC to always use theWindowsBasic theme. Then when theQM
Desktop Recording service starts it does not have to change to that theme since it is
already in place.

n Disable the live screenmonitoring feature in Monitoring and Recording Administrator by
clearing the Enabled check box under Live ScreenMonitor in the Interface Settingswin-
dow under Recordings. This will disable live screenmonitoring for all users. When live
screenmonitoring is disabled, it will not switch to theWindowsBasic theme.

Browser

n Internet Explorer 11 (32-bit), Desktopmode

n Internet Explorer 9 (32-bit)

Note: The Emulationmode for Internet Explorer must be Internet Explorer 9 or
greater. The Cisco Analytics plug-in does not support the EmulationMode set to
less than Internet Explorer 9.

Note: If your site requires a SSL certificate, the SSL certificatemust be installed on the
Web Base server by your administrator.

Internet Explorer and Windows 8.1

By default, Windows 8.1 opens 11 in theMetromode. Thismode is not supported in the
Cisco UnifiedWorkforce Optimization suite. All products in the Cisco UnifiedWorkforce
Optimization suite require that Internet Explorer be run in Desktopmode.

To run Internet Explorer in Desktopmode, pin it to theWindows taskbar and launch it
from there.

You can identify whichmode of Internet Explorer you are using by the icon that appears in
theWindows taskbar:
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Required Internet Explorer Options

The following options are required for all products in the Cisco UnifiedWorkforce Optimization
suite:

n Security Level for this Zonemust beMediumHigh

n File Downloadsmust be enabled

n Cookiesmust be enabled

Note: TheWeb Base server uses the browser cookies to return state information
to theWeb Base server. The state information is used for authentication, user
session identification, and user preferences (for example, language preference).

The following options are required for Recording andQualityManagement:

n Assign theWeb Base server URL to Trusted Sites and clear the check box for Enable
ProtectedMode. See "Adding a Trusted Site to Internet Explorer" in the User Guide for
more information.

n SomeActiveX Controls in Internet Explorer must be enabled if you want to use live
screenmonitoring. See "Enabling ActiveX Controls in Internet Explorer" in the User
Guide for instructions.

Note: If you try to use a browser that does not support ActiveX Control (for
example, Firefox) , the Live ScreenMonitoring icon in the LiveMonitoring
application will be disabled.

n Pop-up blockersmust be disabled for theWeb Base server.
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GPO for PCI Compliance

Note: This information only applies to Recording andQualityManagement.

If you apply a Group PolicyObject (GPO) for Payment Card Industry Data Security Standard
(PCI DSS) compliance to your browsers, include the following values to the settings in the
Group PolicyManagement Editor:

n All Processes—Disabled

n Internet Explorer Processes—Enabled

Supported Third Party Software

Adobe Reader 6.0 or later—the Adobe Reader is required to open PDF-based reports and user
documentation. A free Acrobat Reader download is available at www.adobe.com.

If you are running antivirus software youmight need to create exceptions for the Quality
Management installation directory and both temporary and permanent storage locations.

Thin Client Requirements

n Citrix XenApp 4.5, 4.6, 5.0, 6.0, 6.5, 7.6

n Microsoft Terminal Services for WindowsServer 2008 R2

Note: Recording andQualityManagement only supports Citrix XenApp installed on the
supportedWindowsServers. See "Server Operating Systems" in the Installation Guide
for more information.

n Citrix XenApp, XenDesktop, or Microsoft Terminal Services using the Thin Client
application requires a remote desktop session to be record screen. If no remote desktop
session is presented, alternatively installing the Desktop Recording Service will do
screen recording on the desktop, including any XenApp applications.

n Use Immediate Screen Upload if you are using Thin Clients or non-persistent desktops.

n If you are using a Terminal Services or Citrix XenApp for recording purposes, these
servers require additional server resources for recording screen. The resource
requirements will vary depending on the actual design andmight require some detailed
hardware designs that should be reviewed byCisco prior to deployment.
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n If your virtual image has access to your local NIC, you can use the Desktop Recording
Service for agent-side recording.

Note: If you are planning to use a virtual or Citrix environment, see Supported VMWare
or Citrix XenApp or Windows Terminal Services for additional information.

Citrix XenApp or Windows Terminal Services

Install Citrix XenApp or Windows Terminal Services per the product documentation.When
installing Citrix XenApp or Windows Terminal Services, use the following settings to support
screen recording in Recording andQualityManagement:

n Serversmust include a supported browser to access the UnifiedWorkforce Optimization
Container.

l Publish the browser locally to each server.

l Ensure the security settings allows end users to play back recordings through
Citrix XenApp or Windows Terminal Services. For more information on security
settings, see KB 933991 available at http://support.microsoft.com/kb/933991.

Each server can support a maximumof 25 concurrent screen recordings.

n Additional configuration settings are required to fully access the UnifiedWorkforce
Optimization Container. See the “Installing Server Applications” in the Installation Guide
for complete details.

n Limit the number of simultaneous sessions per user to a single session.

l For Citrix XenApp, follow the instructions at
http://support.citrix.com/proddocs/topic/xenapp5fp-w2k8/ps-sf-connections-limit-
v2.html

l For Windows Terminal Services, follow the instructions for “Restrict Terminal
Services users to a single remote session” at http://technet.microsoft.com/en-
us/library/cc731606%28v=ws.10%29.aspx

You also need to configure the following settings:

n The Audio Player for Citrix XenApp requires the QmWmpAudioPlayer class

n On the server that hosts the QualityManagement database, set the dbProperties flag in
SQMDB to isCitrix
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For Citrix XenApp client services, youmust also install the Recording Thin Client. The
Recording Thin Client records screens fromCitrix XenAppClient sessions.

When these settings are configured, Recording andQualityManagement supports recording
playbackwith screen.

Desktop Applications

n QualityManagement Administrator

n Desktop Recording service

n Cisco Recording Controls

n Microsoft Visual C++ 2005 Redistributable Package (x86)

Note: TheMicrosoft Visual C++ 2005 Redistributable Package is only required
for managers and supervisors that want to use the Live ScreenMonitoring
feature.

n Cisco Screen Player Plug-in
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Planning Ahead
QualityManagement workswith a variety of operating systems, software, and Automatic Call
Distributors (ACDs). Deployment planning is required to ensure that the installation goes
smoothly.

Use the information provided in the following topics to prepare for QualityManagement
deployment and installation activities.

Pre-Installation Checklists

Use the following pre-installation checklists to gather configuration information and prepare the
servers before you install QualityManagement.

Preparing a Site for Installing Quality Management Checklist

Use the following checklist to prepare the customer’s site for installing QualityManagement.

1. Complete the QMSite Configuration worksheet for your environment.

This worksheet allows you to determine storage requirements for the primary recording
storage location and the Recording Server temporary storage location (optional).

This worksheet is available through the Cisco Implementation ServicesHelp Desk or
portal.calabrio.com.

2. Validate the QualityManagement server hardware and capacity requirements for the
following servers:

n WebBase server

n Recording Server

n Monitor server

Note: TheMonitor server is not supported in an Avaya environment.

See Server Hardware and Scalability for more information on hardware requirements.

3. Order the server hardware.
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4. Install theMicrosoft WindowsServer operating system on theQualityManagement
server. For Microsoft WindowsServer 2008 R2 and 2012:

n Update to the latest service pack (SP)

n Verify IIS or Web Services are not enabled (using port 80 or 443)

n Install the Telnet client—Optional component for troubleshooting.

SeeMicrosoft WindowsServers for more information onMicrosoft WindowsServer
2008 R2 or 2012.

5. Create the user accounts. You will need the following user accounts:

n Local administrator account for installation on the server.

n User account to connect to the external storage location—optional. This is only
required for Site servers. The requirements for this account are as follows:

l Local administrator

l Set permission to run services

6. Install theMicrosoft SQL Server. When installing theMicrosoft SQL Server:

n Verify Collation is SQL_Latin1_General_CP1_CI_AS

n VerifyMixedMode Authentication

n Create a DBCreator user

SeeMicrosoft SQL Server for information on settings.

7. Verify all required ports are open to the servers. See the Port Usage for more inform-
ation.

8. Verify the QualityManagement software and license files are copied to the QualityMan-
agement base server.

9. Download the latest QualityManagement Service Release (SR) and the latest Engin-
eering Special (ES) from the Cisco website.

10. Load theQualityManagement License on the Cisco Unified CCX server.

11. Review the Release Notes.

Preparing a Site for Installing Quality Management Checklist

Use the following checklist to prepare the customer’s site for installing QualityManagement.
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Steps Task Notes Done?

Step 1 Complete the QM

Site Configuration

worksheet for

your environment.

This worksheet allows you to determine storage

requirements for the primary recording storage location and

the Recording server temporary storage location (optional).

This worksheet is available through the Cisco

Implementation Services Help Desk.

Step 2 Validate the Qual-

ity Management

server hardware

requirements.

Verify the hardware requirements for the following servers:

n Base server capacity

n Recording server capacity

n Monitor server capacity

See System Requirements for more information on

hardware requirements.

Step 3 Order the server

hardware.

Step 4 Order the Quality

Management soft-

ware and license.

Step 5 Install the

Microsoft Win-

dows Server oper-

ating system on

theQuality Man-

agement server.

For Microsoft Windows Server 2008 and 2012:

n Update to the latest service pack (SP)

n Verify IIS orWeb Services are not enabled (using

port 80 or 443)

n Install Desktop Experience—see

http://technet.microsoft.com/en-

us/library/cc754314.aspx for instructions on

enabling Desktop Experience.

n Install the Telnet client—Optional component for

troubleshooting.

SeeMicrosoft Windows Servers for more information on

Microsoft Windows Server 2008 or 2012.
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Steps Task Notes Done?

Step 6 Create the user

accounts.

You will need the following user accounts:

n Local administrator account for installation on the

server.

n User account to connect to the external storage

location—optional. This is only required for Site

servers. The requirements for this account are as

follows:

l Local administrator

l Set permission to run services

Step 7 Install the

Microsoft SQL

Server.

When installing theMicrosoft SQL Server:

n Verify Collation is SQL_Latin1_General_CP1_CI_

AS

n Verify MixedMode Authentication

n Create a DBCreator user

SeeMicrosoft SQL Server for information on settings.

Step 98 Verify all required

ports are open to

the servers.

See theQuality Management Jetty Component for more

information.

Step

109

Verify the Quality

Management soft-

ware and license

files are copied to

the Quality Man-

agement base

server.
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Steps Task Notes Done?

Step

1110

Download the

latest Quality Man-

agement Service

Release (SR) and

the latest Engin-

eering Special

(ES) from the

Cisco website.

Step

1211

Load theQuality

Management

License on the

Cisco Unified

CCX server.

Step

1312

Review the

Release Notes.

Cisco Checklists

Use the Cisco checklists to gather configuration information and prepare the servers before
you install QualityManagement. The pre-installation checklists are as follows:

n Cisco Unified CM Configuration Checklist

n Cisco Unified CCX Configuration Checklist

Cisco Unified CM Configuration Checklist

Use the following checklist to configure Cisco Unified CM.

Steps Task Notes Done?

Step

1

Associate phones with the

JTAPI user.

See JTAPI User for more information.
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Steps Task Notes Done?

Step

2

Configure Network

Recording or

Network Based Recording

(optional).

See the Cisco documentation for details.

n Create a recording profile

n Create a SIP trunk

n Create a route pattern

n Assign the recording profile to the DN's to be

recorded

n Configure DN for amonitoring calling search

space

n Confirm the DN’s monitoring calling search

space includes a route pattern

See Configuring Cisco Unified CM Administration for

Network Recording for more information.

Step

3

Verify the phone con-

figuration parameters.

Verify the following parameters for phone con-

figuration are enabled:

n PC Port

n PC Voice VLAN Access

n Span to PC Port—Desktop Recording only

These phone device parameters are enabled by

default. You only need to re-enable the parameters if

they are disabled.

Note: Not all devices or Unified CM versions

use all these settings. Configure those that do

appear for your device and Unified CM

version.
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Steps Task Notes Done?

Step

4

Complete the VoIP Device

Table tab in the QM Agent

List.

This worksheet is only required for CiscoMedi-

aSense Recording, Network Recording, Network

Based Recording, or Server Recording.

This worksheet is available through the Cisco

Implementation Services Help Desk.

Cisco Unified CCX Configuration Checklist

Use the following checklist to configure Cisco Unified CCX.

Task Notes Done?

Set the password for the uccxworkforce user.

Gamification Checklist

Use the following checklist to gather configuration information for the gamification feature
before you install QualityManagement.

Note: Qualitymetrics are configured by default. No additional information is required.

Steps Task Notes Done?

Step 1 Provide the IP address or hostname for theWFM server container.

Step 2 Provide the port number for theWFM server container.

Deployment Checklists

Use the deployment checklists when installing QualityManagement and running the System
Configuration Setup tool. The deployment checklists are as follows:

n Single Server Installation Checklist

n QualityManagement Administrator Configuration Checklist
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n Application Installation Checklist

n Optional FeaturesConfiguration Checklist

n Testing Checklist

Single Server Installation Checklist

Use the following checklist when installing QualityManagement components on a single
server.

Steps Task Notes Done?

Step

1

Install the required components on the

Base server.

Install the required components on the

Base server.

See Install Services on a Single Server for

more information.

Step

2

Install the latest SR or ES, if avail-

able.

See Installing a Patch for more information

on installing an SR or ES.

Step

3

Complete System Setup Con-

figuration (PostInstall)

Use the information entered in the Use the

information entered in the QM Express

Site Configuration worksheet.

See Configuring Quality Management for

more information.

Step

4

Update the digital certificate. SeeManaging Certificates.
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Steps Task Notes Done?

Step

5

Install any additional servers

(optional).

This could include one or more of the fol-

lowing servers:

n Backup CTI server

n Additional Cisco Unified CM

Cluster CTI server

n Recording server

n Monitor server

n Monitor server and Recording

server

Step

6

Verify the Screen Playback Gateway

(PROXY Pro Gateway) configuration

on the Site Upload server.

Quality Management Administrator Configuration Checklist

Use the following checklist to configure QualityManagement fromQualityManagement
Administrator. See the Administrator Guide for more information.

Steps Task Notes Done?

Step

1

Configure users. n Link ACD accounts (AD

Authentication) or

configure ACD accounts

(QM Authentication)

n Create Quality

Management users

n Assign roles

n License users

Step

2

Configure groups. n Create groups

n Assign teams

n Assignmanagers
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Steps Task Notes Done?

Step

3

Configure evaluation form worksheets. This is required for QM and AQM

licenses only.

Step

4

Complete the Business Users Worksheet for

each workflow.

This worksheet is available

through the Cisco Implementation

Services Help Desk.

Step

5

Configure evaluation forms. This is required for QM and AQM

licenses only.

Step

6

Configure workflows.

Step

7

Configure VoIP devices

This is only required for CiscoMediaSense

Recording, Server Recording, Network

Recording, and Network Based Recording.

n Enable devices for

recording

n Set recording type

n Assign agents to devices

or configure devices for

Hot Desking

n Assign a Recording server

n Assign aMonitor server

(Server Recording only)

Step

8

Configure export settings.

Desktop Application Installation Checklist

Use the following checklist when installing QualityManagement desktop applications.

Steps Task Notes Done?

Step

1

Install the Recording Thin Client on

Citrix servers.

Required only for a Citrix environment.

See Installing Server Applications for

more information on installing the

Recording Thin Client.
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Steps Task Notes Done?

Step

2

Install the Quality Management Admin-

istrator on select workstations.

See the Deploying Applications on a

Desktop for more information.

Step

3

Install the Desktop Recording service on

all PCs that require audio recording or

screen recording.

Step

4

Install the latest SR or ES on the

desktop, if available.

See Installing a Patch for more inform-

ation.

Optional Features Configuration Checklist

Use the following checklist when configuring optional features for QualityManagement.

Steps Task Notes Done?

Step

1

Configure the Inclusion List. See Inclusion List .

Step

2

Configure custommetadata. See "About User-Defined

Metadata” in the Administrator

Guide.

Step

3

Configure Silence and Talk Over events. See “Call Events Administration” in

the Administrator Guide.

Step

4

Configure theMANA CDR. SeeMonitoring and Notification.

This option is not required for Cisco

MediaSense Recording.

Step

5

Configure Hot Desking.

This is only required for Network Recording,

Network Based Recording, Cisco

MediaSense Recording, or Server

Recording.

1. Create a default Hot

Desking agent. See the

Administrator Guide for

instructions.

2. Install Recording Controls

on the base server. See

the API Programmer

Guide for instructions.
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Testing Checklist

Log in to UnifiedWorkforce Optimization and use the following checklist to verify Quality
Management is running correctly.

Steps Task Notes Done?

Step

1

Play back an audio recording. See “Playing Recordings” in the

User Guide.

Step

2

Play back a screen recording (AQM or AQMA).

Step

3

Play back a customer conversation.

Step

4

Monitor an active call using the LiveMonitoring

application.

Note: LiveMonitoring is only available if

you are using Network Recording.

See “LiveMonitoring” in the

User Guide.

Step

5

Run a report. See “Reporting” in the User

Guide.

Step

6

Export a recording. See “Export Selected Contact”

in the User Guide.
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Before you deployQualityManagement, you need to prepare the environment. The following
topics describes how to configure the environment to support QualityManagement:

n Cisco Environment

n Microsoft WindowsServer Guidelines

n Microsoft SQL Server

n WindowsSNMP Service

n Active Directory

n External Storage User

n Network Load Balancer

n Fully Qualified Domain Name

n Supporting Asian Languages or Unicode Font

Cisco Environment

If your site includesCisco Agent Desktop and you want to use the RecordingMonitoring
application, youmust select the following check boxes on the Agent Distribution tab in PG
Explorer:

n Enable agent reporting

n Agent event detail

n Agent real time data

n Agent historical data

Install Cisco Unified CMper the Cisco documentation. Follow these guidelineswhen installing
Cisco Unified CM:

n Create a user in Cisco Unified CMand assign the Administrative XML Layer (AXL) User
group to the user. TheQualityManagement administrator uses this user when:
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l Configuring the SOAP AXL Access and subscriber information in the Cisco
Unified CMwindow

l Loading the JTAPI jar during SystemConfiguration Setup (PostInstall.exe)

l Finding devices on the VoIP Deviceswindow in QualityManagement
Administrator

n See the following topics for additional information:

l Configuring Cisco Unified CMAdministration for Network Recording

l JTAPI User

Configuring Cisco Unified CM Administration

The following instructions explain how to configure Cisco Unified CMAdministrator for
Network Recording and Network Based Recording.

Steps Configuration Steps Related Procedures and Topics

Step

1

Enable IP phone BIB (Built-in

Bridge) to allow monitoring and

recording.

See “Cisco Unified IP Phone Setup” in the Cisco Unified

Communications Manager Administration Guide.

Note: BIB is required to use the silent monitoring

and whisper features in the LiveMonitoring

application.

Step

2

Add a user for themonitoring

and recording application.

See “Application User Setup” in the Cisco Unified

Communications Manager Administration Guide.

Step

3

Add the user to a access control

group that allows monitoring and

recording.

See “Application User Setup” and “Access Control Group

Setup” in the Cisco Unified Communications Manager

Administration Guide.

Step

4

Optional: Configure tones for

monitoring and recording.

You can enable a tone to alert parties on the call that they

are beingmonitored or recorded.

See “Service Parameter Setup” in the Cisco Unified

Communications Manager Administration Guide.

Step

5

Configure DN for amonitoring

calling search space.

See “Directory Number Setup” in the Cisco Unified

Communications Manager Administration Guide.
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Steps Configuration Steps Related Procedures and Topics

Step

6

Enable recording for a line

appearance.

See “Directory Number Setup” in the Cisco Unified

Communications Manager Administration Guide.

Step

7

Create a recording profile. See “Recording Profile Setup” in the Cisco Unified

Communications Manager Administration Guide.

Step

8

Optional: Create a SIP profile

for Recording CTI service.

See “SIP Profile Setup” in the Cisco Unified Com-

munications Manager Administration Guide.

step 9 Disable the Timer Keep Alive

Expires setting.

See “SIP Profile Setup” in the Cisco Unified Com-

munications Manager Administration Guide.

Step

10

Create a SIP trunk that points to

the Recording CTI service.

See “Trunk Setup” in the Cisco Unified Communications

Manager Administration Guide.

Note: If you are using Network Based Recording,

youmust select the This trunk connects to a

recording-enabled gateway check box.

Step

11

Create a route pattern for the

Recording CTI service.

See “Route Pattern Setup” in the Cisco Unified

Communications Manager Administration Guide.

Step

12

Configure the recorder for

redundancy.

See “Trunk Setup” in the Cisco Unified Communications

Manager Administration Guide.

JTAPI User

QualityManagement requires that you configure a JTAPI user for Unified CM. This JTAPI user
will be used by the Recording CTI service and CUBE SIP CTI service to log in to Unified CM.
The JTAPI username and password will be required when you configure QualityManagement
for Unified CM.

Note: If you are configuring QualityManagement for GatewayRecording or Cisco
MediaSense Recording, you only need a JTAPI user if you intend to record screen.
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To add a JTAPI user for Unified CM, see the “Adding a New User” section in the Cisco Unified
JTAPI DevelopersGuide for Cisco Unified CommunicationsManager. This document is
available on the Cisco website (www.cisco.com).

When you configure the JTAPI user, consider the following guidelines:

n QualityManagement can share the same JTAPI user with other applications.

Example: Unified CCX andCisco Agent Desktop can share the same
JTAPI user.

n Assign all devices that you want to record to the JTAPI user.

n Assign the Standard CTI Enabled group to the JTAPI user. You also need to assign the
Standard CTI Allow Call Monitoring group to the JTAPI user. LiveMonitoring requires
the permissions provided by this group.

Microsoft Windows Server Guidelines

Follow these guidelineswhen installing aMicrosoft WindowsServer:

n The hostname for the server must not contain underscores if you are usingMicrosoft
Internet Explorer to access the UnifiedWorkforce Optimization Container.

n Cisco only supports the US English locale on the server’s operating system. Both the
server and the server's local system user must use the US English locale.

n If a web service is installed on the server, make sure it does not use TCP ports 80, 443,
and 7001. These ports are used by the Jetty service. SeeQualityManagement Jetty
Component for more information.

n If you are installing QualityManagement onWindowsServer 2008 or 2012, youmust
install Desktop Experience. Desktop Experience allows the end users to export screen
recordings,WindowsAudio File Format (WAV), or MPEG-4 Video (MP4) from the
UnifiedWorkforce Optimization interface. See theMicrosoft documentation for
instructions on installing Desktop Experience at the following website:
http://technet.microsoft.com/en-us/library/cc754314.aspx
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Microsoft SQL Server

Before you install the QualityManagement, youmust install Microsoft SQL either co-resident
with theWeb Base server or on an off-board server, and configure it for QualityManagement
as described in the following topics:

n InstallingMicrosoft SQL Server

n Microsoft SQLRoles

n Microsoft SQL Server Maintenance Plan

n SQLServer Browser

Installing Microsoft SQL Server

Youmust install Microsoft SQL Server co-resident on theWeb Base server or on an off-board
server, and configure it for QualityManagement.

For detailed information about how to install Microsoft SQL Server, see theMicrosoft SQL
Server installation documentation.When you install Microsoft SQL Server, youmust configure
the following items as follows:

n Select one of the following options for Instance Name:

l Default Instance

l Named Instance. If you choose this option, specify the named instance.

n Under Start Services at the End of Setup, highlight SQL Server and SQL Browser. By
default, the SQL Browser Service is set to be startedmanually, not automatically.

Note: If you are using an instance name and not the default instance, youmust
set the SQL Browser Service to start automatically after you install Microsoft SQL
Server.

n ChooseMixedMode authentication.

n For SQLCollations, select the following option:

Dictionary order, case-insensitive, for use with 1252 Character Set.
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Note: This option is required to assign the Latin1_General_CP1_CI_AS property
to Server Collation in the Server Properties window. See
http://msdn.microsoft.com/en-us/library/ms180175.aspx for more information.

Microsoft SQL Roles

Create several user logins for theMicrosoft SQL Server.

Example: You can configure one user login responsible for installation and upgrades
and another user login responsible for day-to-day database activities.

For information on creating user logins for Microsoft SQL Server, see theMicrosoft
documentation.

The user must be configured in SQL Server Management Studio as follows:

n Choose SQL Server Authentication as the authenticationmode.

n When entering the password, clear the Enforce Password Policy check box and choose
English as the default language.

Note: TheQualityManagement database uses the English date format. If you
assign a language other than English to the SQL Server user the languagemight
use a different date format, causing Screen Recording DB errors and Sync
errors. TheMicrosoft SQL Server user must use English as the default language.

n Choose the server roles for the user.

l For new installations and upgrades, choose the dbcreator check box from the list
of server roles. This user is the db_owner of the SQMDB database.

l For day-to-day database activities, choose the following check boxes from the list
of server roles: db_datareader, db_datawriter, and db_owner.

Note: If you are upgrading fromMicrosoft SQL Server 2000 toMicrosoft
SQL Server 2008 on an existing QualityManagement system, also select
the db_datareader and db_datawriter server roles.
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Microsoft SQL Server Maintenance Plan

TheMicrosoft SQL Server requires regular maintenance to ensure peak performance. You
can automate themaintenance task and schedule it for once a week.

The common database tasks include:

n CheckData Integrity—checks the structural integrity of the data. It verifies the database is
not corrupt.

n Reorganize Indexes—moves index pages into amore efficient search order.

n Rebuild Indexes—recreates the indexeswith a new fill factor which determines the
amount of empty space left in the indexes for future rows.

n Update Statistics—performs sampling of the data in the database to optimize tables and
indexes so they can be usedmore efficiently, increasing performance for the distribution
of data in the tables.

Important: Do not select the Shrink Database check boxwhen creating a
maintenance plan as it might degrade performance in the SQMDB database until
it “reaches equilibrium” where DB Cleaner is removing the same number of
records as are being added in a normal day. This does not occur until the system
has been running for at least the longest retention time (or 13months, whichever
comes last). Until this point, the databasemust be allowed to grow.

You can add backups to this schedule if it’s appropriate to your business needs. If you have
specific requirements for backup, you should probably set up a different maintenance plan that
runs on a different schedule.

Example: Running backups three times a week.

See theMicrosoft SQL Server documentation for instructions on creating amaintenance plan.

SQL Server Browser

The SQLServer Browser, a component in Microsoft SQL Server 2008 andMicrosoft
SQL Server 2012, allows a client to search for named instances. By default, the service status
for this component is Stopped and the service startup type isManual. The required service
status for the SQL Server Browser is as follows:
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n If you are using a default instance, no changes are required for the SQL Server Browser
service.

n If you are using a named instance, you need to start the SQL Server Browser service in
theWindowsServices utility by changing the properties for the service fromManual to
Automatic.

Note: If the database uses a named instance, sqlbrowser.exe needs to be
running and added to the exception list in the firewall. If you are using the default
instance (that is, the Instance Name field in QMDatabases is empty), you do not
need to add sqlbrowser.exe to the firewall exception list. See Adding Firewall
Exclusions by Program for more information.

Windows SNMP Service

The SimpleManagement Network Protocol (SNMP) Service addsmonitoring capabilities and
exposes key information to other computers on your network.

QualityManagement uses SNMP to send error messages to specified IP addresses. (You can
specify the IP addresseswhen you run the SystemConfiguration Setup tool.) Install SNMP on
the base server running either WindowsServer 2008,WindowsServer 2012, or VMware ESX
Server.

The SNMP Service requires that you ensure:

n The logged in user has Administrator privilege or is part of the Administrators group

n The network policies do not prevent installing newWindows services

For more information on installing and configuring this tool, see theMicrosoft SNMP
documentation.

Active Directory

Use Active Directory with QualityManagement to:

n Allow users to use their existingWindows user name and password to accessQuality
Management. Using theWindows user name and password eliminates the problem of
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remembering andmaintaining a separate user name and password.

n Enforce password security policies, in a single instance across one or more domains.

Example: Security policies like complexity level or duration.

If your system uses Active Directory, the SystemConfiguration Setup tool prompts you to
provide domain information for Active Directory.

When a user logs into UnifiedWorkforce Optimization, QualityManagement collects the user’s
username and password. If you configure QualityManagement for Active Directory, it sends
the login information to the domain’s Active Directory server for authentication.When the
QualityManagement server receives the authentication results, it accepts or rejects the user’s
access based on the authentication results.

Active Directory Configuration Guidelines

If you are using Active Directory with QualityManagement, observe the following guidelines.

n TheQualityManagement server must be on the same domain as the end users who log
in to UnifiedWorkforce Optimization.

n Theremust be at least one configured domain.

n Each domainmust have at least one configured user path.

n If you are using Citrix, set up a recording security group within your Active Directory. A
recording security group reduces the number of connections to the server.

n TheQualityManagement server must be able to access the Active Directory server for
user authentication using the port number specified in the Domain Information dialog
box in the SystemConfiguration Setup tool. See “Active Directory Systems” in the
Administrator Guide for more information.

Active Directory Information

Before you install QualityManagement, you need the following domain information for Active
Directory.

n Base DN

n Domain name—you can locate the Active Directory Domain Name on themachine
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running Active Directory by right-clicking Active Directory Users and Computers in
Administrative Tools, right-clicking the domain folder, and then choosing Properties.

n Active Directory host name or IP address

n Port

n Active Directory display name, password, and user search base

n Admin group—a list of Active Directory users who will be allowed to log into Quality
Management Administrator and UnifiedWorkforce Optimization as an administrator.

n User records—for recorded users (agents) and users who will log into Quality
Management Administrator and UnifiedWorkforce Optimization as an administrator.

External Storage User

If you are going to use external storage for voice and screen recordings, youmust create a
username and password for the external storage user on the external storage server. You will
need the username and password when you configure the recording file storage location in the
SystemConfiguration Setup tool.

The following services require the external storage user to access the external storage
location:

n Jetty service

n Screen PlaybackGateway (PROXY Pro Gateway) service

The external storage user must have admin rights to the local system and read/write access to
the external storage location. The user also needs a right called LogOn AsService that allows
a service to run as that user. Usually this right has to be added and is not part of the default
rights for admin users.

You can assign these rights to the external storage user before you install Quality
Management. Go to http://technet.microsoft.com/en-
us/library/cc739424%28v=ws.10%29.aspx for specific instructions.

If QualityManagement is already installed, you can assign these rights to the external storage
user by following the instructions above or bymanually configuring the service to log in as the
external storage user described in External Storage and Services.

66

http://technet.microsoft.com/en-us/library/cc739424(v=ws.10).aspx
http://technet.microsoft.com/en-us/library/cc739424(v=ws.10).aspx


Before Installing QualityManagement

Fully Qualified Domain Name

QualityManagement supports Fully Qualified Domain Names (FQDN) or hostnames and IP
addresseswhen configuring the system.

If you choose to use FQDN, observe the following guidelines:

n The hostnames specified for QualityManagement must be resolvable by the clients that
need to connect to it.

Note: The clients do not need to be part of the domain.

n The desktopmust be able to connect to the server using the hostname.

n If the client is using desktop recording, the client must be able to connect to the following
hosts:

l WebBase server (Jetty service)

l Database server (Upload Controller service)

l Recording servers

l Site Upload server (Upload Controller service, Jetty service, andMedia webapp)

n The administrator needs to connect to theWeb Base server (Jetty service).

Supporting Asian Languages or Unicode Font

If you have user-entered data in Asian characters or Unicode font (for example, a team name,
an agent name, or a question), youmust install the supplemental language support for East
Asian languages or a Unicode font. If you do not install supplemental language support or a
Unicode font, the characters do not appear in the Quality Reports when you generate a PDF
form. The following languages require supplemental language support.

n Chinese (China)

n Chinese (Taiwan)

n Japanese

n Korean

n Russian
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Installing Supplemental Language or Unicode Font Support

1. From the base server, choose one of the following options:

l WindowsServer 2008:

a. Choose Start > Settings > Control Panel.

b. Double-click Regional and Language. The Regional and Language win-
dow appears.

c. Click the Keyboards and Languages tab.

d. Click the Install/Uninstall Languages button.

e. Select the Install Display Languages and browse to the language pack,
and then follow the prompts to install the fonts.

l For WindowsServer 2012:

a. Choose Desktop > Control Panel > Clock, Language, and Regions >
Language. The Language window appears.

b. Click Add a Language, select a language, and then click Add.

2. Restart the base server. The server might automatically restart after you install the
fonts.

3. OpenWindowsExplorer and go to C:\Windows\Fonts. The Fonts window appears.

4. Select and copy the font you just added.

l batang.tcc (Russian and Korean)

l mingliu.tcc (Chinese and Japanese)

l A Unicode supported font (for example, Calibri)

5. Go to the C:\ProgramFiles\Cisco\WFO_QM\Java\lib\fonts folder and choose Edit >
Paste.

6. Restart theMonitoring and Recording Jetty service.

Supporting Asian Languages or the Unicode Font in PDF Reports

If you are using a non-Asian locale or a Unicode font, but want to include Asian characters or a
Unicode font in your PDF reports, youmust perform the following steps.
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Note: The HTML and CVS reports automatically display Asian characters and Unicode
fonts.

1. On the base server, go to the ...\ProgramFiles\Cisco\WFO_QM\Jetty\cisco-
solutions\reports folder and open the properties file associated with your locale.

Example: OpenQMReport_fr.properties if your locale is French.

2. Find encoding= and change it to encoding=UTF-8.

3. Find font=Arial and change Arial to one of the following fonts:

l batang.tcc (Russian and Korean)

l mingliu.tcc (Chinese and Japanese)

l A Unicode supported font (for example, Calibri)

4. OpenWindowsExplorer and go to C:\Windows\Fonts.

The Fonts window appears.

5. Select and copy the font you just added.

l batang.tcc (Russian and Korean)

l mingliu.tcc (Chinese and Japanese)

l A Unicode supported font (for example, Calibri)

6. Go to the C:\ProgramFiles\Cisco\WFO_QM\Java\lib\fonts folder and choose Edit >
Paste.

7. Save and exit the properties file.

8. Restart the Jetty service.
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Before You Begin

1. Request an upgrade plan fromCisco PDI.

2. Review the server hardware and scalability requirements. Your previous version of
QualityManagement might have different requirements thanQualityManagement11.0.
See Server Hardware and Scalability for more information.

3. Review the Release Notes and Administrator Guide for this release.

Upgrading from a Previous Version

QualityManagement supports direct upgrades from the following versions:

l QualityManagement 10.5

l QualityManagement 10.0

l QualityManagement 9.0

l QualityManagement 8.5(2)

Important: Over the top upgrades from version 10.5 and earlier to 11.0 are not
supported. All such upgradesmust bemanual. Thismeans that the old version of Quality
Management (but not your QualityManagement database) must be uninstalled before
the new version is installed. Over the top upgrades from 11.0 to newer versions of 11.0
are supported.

If you are installing from a version prior to 10.0, upgrade to version 10.0. Follow the upgrade
instructions in the Installation Guide for version 10.0.

Before you upgrade, consult the Release Notes for Cisco UnifiedWorkforce Optimization
QualityManagement for any last minute changes to the upgrade procedure.

To upgrade from a previous version, choose one of the options in the previous table, and then
complete the upgrade in the following order:
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1. Complete the steps in Upgrading.

Important: The system you are upgrading tomust be running a 64-bit Windows
Server. Upgrading from a 32-bit WindowsServer is not supported.

2. Upgrade the desktop applications. See Deploying Applications on the Desktop for
more information.

Proxy Host

When upgrading the Desktop Recording service or the Recording Thin Client software to the
latest version, the ProxyHost might bemissing. To restore the ProxyHost, locate the Cisco
UnifiedWFOQualityManagement in Programs and Features, right-click the Cisco Unified
WFOQualityManagement, choose Repair, and follow the prompts.

CDR Configuration

When upgrading from 10.0(1), note that the CDR Configuration buttonmoved to Unified CM
under TelephonyGroups in SystemConfiguration Setup (PostInstall.exe) and System
Configuration.

Playing a Voice Recording

When upgrading from 10.0 or earlier, note that the behavior for downloading and playing a
recording in theMedia Player has changed.

For 10.0 and earlier, voice recordingswere downloaded, unencrypted, and uncompressed
when you played the recording in theMedia Player. The voice recording was deleted when you
changed focus from theMedia Player to another application on UnifiedWorkforce
Optimization.

Starting with 10.5(1), voice recordings are downloaded, unencrypted, uncompressed, and
streamed to your web browser when you play the recording in theMedia Player. The voice
recording is deleted when you clear the cache in your web browser.
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Best practices: Use HTTPS to connect to UnifiedWorkforce Optimization through a
web browser and configure the QM certificate. SeeManaging Certificates for
instructions on generating certificates so that you can use HTTPS.

InMicrosoft Internet Explorer, select the Delete Browsing History on Exit check box on
theGeneral tab in the Internet Options dialog box. This ensures the cache, including all
voice recordings, is cleared every time you exit Internet Explorer.

Recording Methods

When upgrading from 10.0(1), the “Recording Types” section wasmoved to the
“Capture/RecordingMethods (In-depth View)” section of the Cisco UnifiedWFOQuality
Management DesignGuide.

Upgrading Quality Management

Use the following task to upgrade to 11.0.

1. On the SQL server, back up your QualityManagement database. SeeQuality
Management Database Disaster Recovery for instructions.

2. On theWeb Base server, back up the following custom files. These files include:

n Report Logo images—see Custom Logo File Recovery for instructions.

n (Unified CCE environment only) GenesysConnector properties file—see
GenesysConnector Properties File Recovery for instructions.

3. From the VoIP Deviceswindow in QualityManagement Administrator, export the VoIP
devices as a CSV file. See "VoIP Devices" in the Administrator Guide for more inform-
ation.

4. Install the latest QualityManagement 11.0 (the version can include the latest SR or ES)
on the web base server. See Installing QualityManagement for instructions.

5. If you installed QualityManagement onmultiple servers, run postinstall.exe on all serv-
ers. See SystemConfiguration Setup for more information.
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Upgrading Unified CM

Use the following task to updated to QualityManagement after a Cisco Unified CMupgrade.

1. On the SQL server, back up your QualityManagement database. SeeQuality
Management Database Disaster Recovery for instructions.

2. On theWeb Base server, back up the following custom files. These files include:

n Report Logo images—see Custom Logo File Recovery for instructions.

n (Unified CCE environment only) GenesysConnector properties file—see
GenesysConnector Properties File Recovery for instructions.

3. Double-click PostInstall.exemanually on anyQualityManagement server.
PostInstall.exe is located at:

<install folder>\WFO_QM\bin\postinstall.exe

where <install folder> is the path to postinstall.exe. The default path is C:\Program
Files\Calabrio\WFO_QM\bin\postinstall.exe.

4. ClickOK to bypass the initial SystemConfiguration Setup window.

5. From the VoIP Deviceswindow in QualityManagement Administrator, export the VoIP
devices as a CSV file. See "VoIP Devices" in the Administrator Guide for more inform-
ation.

6. Choose SystemConfiguration > TelephonyGroups and select a Unified CM telephony
group.

a. Select the current SOAP AXL version from the Version drop-down list.

b. Click CDR Configuration and select the current Unified CMVersion from the
drop-down list.

c. ClickOK, and then click Save.

7. On the server running the CTI service, select Tools > Download/Install JTAPI and
follow the prompts.

Note: If you are unsure where the CTI service is installed, go to the Status page
on theWeb Base serve and look at the list of Signaling Groups.
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Important: Do not manually install the JTAPI tools plugin fromUnified CM.
Installing the JTAPI fromSystemConfiguration Setup, ensures that additional
functions are performed to establish support for JTAPI in a QualityManagement
environment.

This stepmust be performed on all servers running the CTI service.

The new JTAPI client will be installed and tested. If any errors appear, validate the
Soap AXL configuration, JTAPI username and password, and try again.

System Configuration Setup

1. If SystemConfiguration Setup does not launch automatically, youmust launch it
manually. To launch PostInstall manually on anyQualityManagement server double
click:

<install folder>\WFO_QM\bin\postinstall.exe

where <install folder> is the path to postinstall.exe. The default path is C:\Program
Files\Cisco\WFO_QM\bin\postinstall.exe.

2. ClickOK to bypass the initial SystemConfiguration Setup window.

3. Choose SystemConfiguration > TelephonyGroups and select a Unified CM telephony
group.

a. Select the current SOAP AXL version from the Version drop-down list.

b. Click CDR Configuration and select the current Unified CM Version from the
drop-down list.

c. ClickOK, and then click Save.

4. On the server running the CTI service, select Tools > Download/Install JTAPI and
follow the prompts.

Note: If you are unsure where the CTI service is installed, go to the Status page
on theWeb Base serve and look at the list of Signaling Groups.

Important: Do not manually install the JTAPI tools plugin fromUnified CM.
Installing the JTAPI fromSystemConfiguration Setup, ensures that additional
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functions are performed to establish support for JTAPI in a QualityManagement
environment.

This stepmust be performed on all servers running the CTI service.

The new JTAPI client will be installed and tested. If any errors appear, validate the
Soap AXL configuration, JTAPI username and password, and try again.

76



Installing Quality Management
When you install QualityManagement 11.0, youmust choose one of the options in the following
table and install the components as described.

To: Do This:

Install a single

server configuration

1. On the server, complete the steps in Install Services on a Single

Server.

Important: When you run System Configuration Setup on the

Web Base andOperation servers, configure all off-board

servers.

2. Install the desktop applications (see the Deploying Applications on

the Desktop).

3. Update the digital certificate for theWeb Base server. SeeManaging

Certificates.

Installing Quality Management

Services for Quality Management

Install the services for QualityManagement according to your system architecture. See the
DesignGuide for more information.

Important: InstallWeb Base Services first in amultiple server configuration. You can
install the remaining services on the other servers in any order you wish.

SystemConfiguration Setup runs automatically after you have installed a services on a server.
When using SystemConfiguration Setup, youmust complete SystemConfiguration Setup
after an installation or an upgrade in order for the system to function.
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Install Services on a Single Server

To install services on a single server:

1. Copy the setup_MonRec_<version>.exe, where <version> is the version number, to
the server.

2. Double-click the file setup_MonRec_<version>.exe to start the installation wizard.

If the Open - SecurityWarning dialog box appears, click Run to display the Custom
Setup dialog box. The InstallationWizard prepares to install QualityManagement and
the InstallationWizard dialog box appears.

3. Click Next.

The Select Destination Location dialog box appears.

4. Enter the path where you want QualityManagement to be installed or use the default
path, and then click Next.

Note: The default path is C:\ProgramFiles\Cisco. If you need to change the
path, do not specify the root directory (for example, D:\ or E:\). Always include at
least one folder in the path (for example, D:\Cisco).

5. To install QualityManagement on a single server, select Single Server from the Select
Components drop-down list.

The following serviceswill be installed by default:

n WebBase Services

n Operational Base Services

n Signaling Services > CTI Service

Note: Youmust select at least one signaling service.

n Recording Services

n Site Upload Services

n Database Services

n Encoding Services

To choose an additional service, select the check box for that service.
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6. Click Next, and then click Install.

7. Click Finish to complete the installation of services.

The services you selected are installed, and SystemConfiguration Setup starts.

8. Complete the SystemConfiguration Setup. See Configuring QualityManagement for
more information.
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QualityManagement is upgraded periodically. The upgrade can be one of three types: an
engineering test (ET), and engineering special (ES), or a service release (SR).

Engineering

Test

ET is an additional installable component that contains the files needed to assist

developers in diagnosing a problem. ETs are intended for limited scope tests.

Engineering

Special

An ES is a version of the product that contains all fixes issued since the base release to

the latest ES. Installing an ES replaces the existing installation. It is a full installation

and can be installed on a server without the base release.

Service

Release

An SR is a version of the product that contains all fixes since the base release to the

latest SR. Installing an SR replaces the existing installation. It is a full installation on a

server without the base release.

Before you install a QualityManagement ET, ES, or SR, do the following:

n Schedule the installation for amaintenance period when your QualityManagement sys-
tem is out of production.

n Back up the SQL Server for QualityManagement database using SQL Server backup
tools.

n Uninstall any existing ET.

All patches are installed over the top of the existing installation. For instructions, see Installing
an Upgrade.

Running a Repair

You can use the Repair function in theWindowsPrograms and Features utility in Control Panel
to correct problems that might arise.

To repair Quality Management:

1. Log into QualityManagement as the localmachine administrator.

2. Start the Programs and Features utility in Control Panel.
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There can be up to three programs listed for QualityManagement, depending on what
you installed on the server:

a. Cisco UnifiedWFO Monitoring and Recording ServicesFramework

b. Cisco UnifiedWFO Monitoring and Recording Services

c. Cisco UnifiedWFO Monitoring and Recording Jetty

The repair function is only available for (b) or (c).

Note: If you are not sure where the problem lies, run a repair on both programs.

3. Select the Jetty program and run a repair on it first.

4. Select the Services program and run a repair on it.

Note: When the repairs are complete, restart the server if prompted.

5. Stop all QualityManagement services on this server.

6. Manually start PostInstall.exe.

7. Complete PostInstall.exe, providing any information that might not be present. The
repair function removes any changes that weremade to theWindowsRegistry so you
will have to enter some data to reconnect your QualityManagement installation to the
QualityManagement database.

Note: If there was an ET installed before you repaired QualityManagement, you
must reinstall it after the repair is complete.
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Configuring Quality Management
The SystemConfiguration Setup (postinstall.exe) tool is used to configure Quality
Management after you have installed QualityManagement services.

Note: SystemConfiguration Setup is generally referred to as "PostInstall" since its
executable is postinstall.exe, and that is how it is referred to in this section.

PostInstall has twomodes:

n Initial Mode. PostInstall is launched automatically in Initial Mode after the QualityMan-
agement installation (base, upgrade, and patches) finishes. After configure all of the
required parameters, the QualityManagement services start automatically and the sys-
tem is ready for use.

n Update Mode. Whenever you start PostInstall manually to change settings in an existing
system, it starts in UpdateMode. You start it manually to change the configuration set-
tings in an existing system.

Note: PostInstall is present on everyQualityManagement server. It detects the services
installed on that server and customizes the steps available accordingly. In amultiple
server configuration, the instance of PostInstall that can changeQualityManagement
settings is located on the web base server.

To launch PostInstall manually on anyQualityManagement server double click

<install folder>\WFO_QM\bin\postinstall.exe

The default path is C:\ProgramFiles\Cisco\WFO_QM\bin\postinstall.exe.

Postinstall.exe performs the following functions:

n Configures the system, including:

l The location of the servers

l The connection information for third party software

Example: You use postinstall.exe to configure the connection information
for SQL, ACD, and CTI.
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n Performs data upgrade from previous versions of the system

n Provides tools—tasks that typically occur during an installation or upgrade, youmay need
to complete these tasks outside an installation or upgrade

The following is a list of all possible windows or dialog boxes that can appear when you run
postinstall.exe in Initial or UpdateMode. See the section for each step for instructions on
completing the fields in the window or dialog box.

Note: Some steps trigger actions and do not display windows that contain fields to be
completed.

System Configuration Setup

1. Choose the network address type. Your options are:

l IP Address—the IP address of the base server

l Host Name—the FQDN or hostname of the base server

2. Enter the IP address or hostname of base server.

The base server is the computer where you installed theWeb Base Services,
Database Services, Voice/Screen Services, and signaling service.

3. Enter the IP address or hostname of the UnifiedWorkforce Optimization Container.

The UnifiedWorkforce Optimization Container is located on the base server.

If you also purchasedWorkforceManagement (WFM), and configured it to point to the
container, it will share the container with QualityManagement.

4. Choose the hostname or IP address for this server from the Local Services drop-down
list, and then clickOK.

Note: If you are configuring the Local Services on the web base server, this is
the same hostname or IP address you entered in the Host Address for Base
Server field.

Example: If you want to run Network Recording on a different server and
installed the Network Recording service andMonitor service on that server,
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choose the IP address for the Recording server from the IP Address for Local
Services drop-down list. If the computer hasmultiple NICs, multiple addresses
appear in the IP Address for Local Services drop-down list. Choose the IP
address used for network traffic.

Installation Type

Choose the type of installation you want to perform. Your options are:

n New Installation—install this version on a new system

n Upgrade—upgrade from a previous version

System Database

Use the SystemDatabase window to configure connection information for the Quality
Management system database (system database).

Note: You can only change the information in the SystemDatabase window from the
SystemConfiguration Setup (PostInstall.exe) or QualityManagement Administrator on
theWeb Base server. The SystemDatabase window in QualityManagement
Administrator on a desktop is read-only.
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Field Description

Host

Name/IP

Address

The hostname or IP address of the system database server (the server on which SQL

Server is installed).

If you need to specify a configured port on the system database server, choose Host

Name and use the following format in the IP Address field:

<IP address or hostname>:<port number>

where <IP address or hostname> is the IP address or hostname and <port number> is

the configured port number of the system database server.

Example: 10.188.252.11:1455 

SQL

Instance

Name

The SQL instance name of the SQL Server. Leave this field blank if you want to use the

default instance.

Username The username used by the DB Proxy service to access the system database. See

“Microsoft SQL Server” in the Installation Guide for more information.

Password The password used by the DB Proxy service to access the system database. See

“Microsoft SQL Server” in the Server Installation Guide for more information.

System Database fields

Configuration Settings Used By Services

If you change the settings on the SystemDatabase window, the following table showswhen
your changes take effect.

Service Configuration settings applied when...

Data API

Service

Restart the service.

DB Proxy

Service

Restart the service.

When services start using the changed configuration settings
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Service Configuration settings applied when...

Sync Service No restart required. The next sync period (every 10minutes) applies the

configuration settings.

Update IP Address or Hostname

When updating QualityManagement, you will be prompted to update the IP addresses or
hostnames for the servers.

To modify an the IP address or hostname for a server:

1. ClickModify, complete the fields, and then clickOK.

2. Repeat step 1 for each additional server.

3. Click Continue with These Changes.

To continue without making any changes to the IP address or hostname:

n Click Continue without Making Changes.

Database Exists

If the Database Exists dialog box appears, clickOK to upgrade your database.

The program upgrades the database and loads default data into the database.

Databases Loaded

If the Database Loaded dialog box appears, clickOK to dismiss the Database Loaded dialog
box.

This dialog box appears when the database loads successfully.
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Update IP Address or Hostname

If required, update the IP address for the following servers and then click Continue with These
Changes:

n Site Upload server (Site Services),

n Voice Record server (Record Server)

n Monitor server

n Media Encoding server (Encoding Server)

Note: This dialog only appears when you are upgrading from a previous version of
QualityManagement.

Services Started Successfully

ClickOK to dismiss the confirmation box.

Select an ACD

Choose an ACD from the Select an ACD drop-down list and then clickOK.

Choose Temporary Encoding Storage Location

Choose a directory where encoding files will be processed from the Directory drop-down list.
The specified directorymust be accessible by the Local System user.

Choose Temporary Storage Location

If you want to change the path to the temporary storage location, clickOpen , navigate to the
folder where you want to temporarily store recordings, and then clickOK.
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Note: The Choose Temporary Storage Location dialog box only appears if this is a new
installation.

Cisco Unified CC Database

Use the Cisco Unified CC Database window to configure connection information to the
Microsoft SQL server for the UnifiedUnified CCX database. QualityManagement uses this
information to sync agents and teams fromUnifiedUnified CCX.

The following image displays the Unified CC Database window for Unified CCE.

The following image displays the Unified CC Database window for Unified CCX.

Sync, Data API, andMANA uses the settings in the Cisco Unified CC Database window.

Note: You can only change the information in the Cisco Unified CC Database window
from the SystemConfiguration Setup (PostInstall.exe) or QualityManagement
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Administrator on theWeb Base server. The Cisco Unified CC Database window in
QualityManagement Administrator on a desktop is read-only.

If youmodify the information in the Cisco Unified CC Database window after the initial
installation and configuration, youmust restart the Sync services before your changes take
effect.

Field Description

Side A Server Name The name of the Unified CCX server for the Side A (primary) Cisco

Unified CC database.

Note: The server namemust match the case of the name on

the Unified CCX server. If the server name is all lowercase on

the Unified CCX server, youmust enter it as all lowercase in

this field.

If the server name contains a hyphen (-), replace the hyphen with an

underscore (_) when you enter the server name in this field. This

ensures the correct configuration of the file name.

System Configuration Setup appends _uccx to the name that appears

in this field the next time you run System Configuration Setup.

Note: Do not remove _uccx from the name.

Cisco Unified CC Database fields and buttons
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Field Description

Side B Server Name The name of the Unified CCX server for the Side B (secondary) Cisco

Unified CC database, if one exists.

Note: The server namemust match the case of the name on

the Unified CCX server. If the server name is all lowercase on

the Unified CCX server, youmust enter it as all lowercase in

this field.

If the server name contains a hyphen (-), replace the hyphen with an

underscore (_) when you enter the server name in this field. This

ensures the correct configuration of the file name.

System Configuration Setup appends _uccx to the name that appears

in this field the next time you run System Configuration Setup.

Note: Do not remove _uccx from the name.

Side A IP Address The IP address for the Unified CCX server for the Side A (primary)

Cisco Unified CC database.

Side B IP Address The IP address for the Unified CCX server for the Side B (secondary)

Cisco Unified CC database, if one exists.

DB Instance Name The name of the Cisco Unified CCX database. The name is <side A

server name>_uccx and the field is disabled by default.

Port The port number used by the Cisco Unified CCX database. The port

number is 1504 and the field is disabled by default.
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Field Description

User Login ID used to access the Cisco Unified CC database and

synchronize users in a Unified CCX environment. This user must

have write permission to the database. The login ID is uccxworkforce

by default.

Note: If you are using CiscoMediaSense, use uccxhruser for

the login ID. This login ID has the permissions required to

synchronize users and reconcile contacts. The uccxworkforce

login ID does not have permission to use contactcalldetail and

agentconnectiondetail tables that are required for

reconciliation.

Password Password used by uccxworkforce to access the Cisco Unified CC

database in a Unified CCX environment.

Filters Allows you to determine what data is synced and determines which

devices are available in a telephony implementation. See Touch-

Point Filtering for more information.

Configuration Settings Used By Services

If you change the settings on the Cisco Unified CC Database window, the following table
showswhen your changes take effect.
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Service Configuration settings applied when...

Sync

Service

No restart is required:

n After the initial installation

n After you fix incorrect sync information

The next sync period applies the configuration settings without restarting the Sync

service.

When there are substantial changes to the database, best practice recommends updating

the settings in the Cisco Unified CC Database in the following order:

1. Stop the Sync service and the Upload Controller service.

2. Back up the SQMDB catalog.

3. Change the configuration settings on the Cisco Unified CC Database window.

4. Start the Sync service.

5. Verify the data by looking for mass deactivations.

6. Restart the Upload Controller service. Restarting the Upload Controller services

adds new calls to the database.

MANA

Service

The next polling period applies the configuration settings.

Data

API ser-

vice

Restart the Data API service.

When services start using the changed configuration settings

Touch-Point Filtering

Touch-Point Filtering allows you to determine what data is synced and determineswhich
devices are available in a telephony implementation. A “touch point” is a 3rd party system that
has data that can be synced with QualityManagement for recording purposes. The ability to
filter this data so that QualityManagement sees only a subset of the touch point’s data is useful
in the following environments: 
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n Multi-tenancy environments where a single ACD/telephony implementation is used by
multiple customers and each customer has their ownQualityManagement installation.

n Environments where an ACD/telephony implementation hasmore data thanQuality
Management requires. For example:

l Only a subset of all extensions are assigned to agents and therefore required for
recording purposes.

l QualityManagement will only be used by a subset of the call center.

By default, all teams and users are synced and available to be configured in Quality
Management Administrator. Touch-Point Filtering allows you to you to configure filters so that
QualityManagement only has access to the ACD/Telephony data that matches the filter. The
available filters depend on the ACD and telephony implementations.

When you add a filter, the ACD Filter dialog box appears. The fields associated with this dialog
box are described in the following table.

Field Description

Name The name of the ACD filter.

Prefix

Type

The type of prefix that Touch-Point Filtering will use to filter the data. In this instance, the

data is filtered by Team Name.

Prefix

Value

The name of the team. Nowildcards are allowed.

Example: If you enter Team1, both Team1 and Team10will be synced.

Trim Pre-

fix

Remove the prefix before adding synced information to the Quality Management data-

base. Your options are as follows:

n True—removes the prefix. True is the default value.

n False—keeps the prefix

Example: QM_TeamA becomes TeamA.

ACD Filter fields
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Field Description

Extension

Range

The range of device extensions that you want to include in the sync.

An extension range comparison is done numerically. Pluses are limited from the numbers

and comparedmathematically. In this case, a range of 1 to 1000, would find the

extension 500 in range.

Device

Name

Range

The range of device names that you want to include in the sync. Device names are

compared alphabetically and/or lexicographically. So a range of 1 to 1000 would not find

500, instead you would have to specify the range as 0001 to 1000. This is because

device names can be any string and are not limited tomostly being numbers as

extension are.

Telephony Groups

A telephony group consists of at least one signaling source, one signaling group, one signaling
server, one recording cluster, and devices.

QualityManagement allows you to add backups for the signaling source, signaling group,
signaling server, recording cluster, and devices. Adding any one of these backups is optional.
However, Cisco recommends using backups for resiliency purposes.

Note: Some telephony group types do not support a backup signaling source.
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The TelephonyGroupswindow allows you to add, modify, and delete the following telephony
group types:

n CiscoMediaSense clusters

n Recording CUBE SIP CTI services

n Unified CM clusters

Field Description

Add Add a telephony group.

Rename Rename the selected telephony group.

Delete Delete the selected telephony group.

Telephony Groups fields and buttons
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Field Description

Revert

Recent

Changes

Reverts changes made after the last save to previously committed configuration set-

tings.

Show Gate-

way Record-

ings Prior to

Reconciliation

When selected, this check box allows archive users in a Unified CCX environment

to view root calls in the Recordings application before the calls are reconciled, includ-

ing all PCI events. When cleared, calls do not appear in the Recordings application

until reconciliation is complete and all PCI events are excluded. This check box is

clear by default.

Telephony Group Considerations

The following table describeswhat is supported based on telephony group type.

Telephony

Group

Type

Changes

Unified CM A telephony group can have any number of signaling groups.

Each CTI service in a signaling group can have a separately administered list of Unified

CM CTI Managers to connect to for JTAPI.

A signaling group can have any number of Recording Clusters.

All Others All other telephony group types can support multiple telephony groups, but they are

restricted to a single signaling group and Recording Cluster per telephony group. CUBE

supports primary and backup signaling services, but MediaSense supports only a

single signaling service.

Telephony Group Configuration

The TelephonyGroup Configuration dialog box appears when you add a telephony group. It
allows you to assign a name to the telephony group and associate it with a telephony signaling
method.
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Field Description

Name The name of the telephony group. The namemust be unique.

Telephony

Group Type

The telephony signalingmethod associated with the telephony group. The available

telephony types are as follows:

n CUBE—no additional configuration is required after you add this telephony

group.

n Unified CM—see Unified CM Configuration for more information.

n MediaSense—seeMediaSense Configuration for more information.

Telephony Group Configuration fields

Unified CM Configuration

TheUnified CMConfiguration dialog box appears when you add or edit a telephony group with
a Unified CM telephony type. It allows you to configure a Cisco Unified CM cluster.
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The Cisco Unified CMwindow also allows you to configure the following users:

n Simple Object Access Protocol (SOAP) Administrative XML Layer (AXL) user

n Unified CM Java Telephony Application Programming Interface (JTAPI) user

These users are used by the Computer Telephony Integration (CTI) service to log in to Unified
CM.

A Unified CM cluster comprises a set of Unified CM servers that share the same database and
resources and has one or more CTI Managers. The CTI Manager is a service that runs on
Unified CMand handles JTAPI events for every Unified CM in the cluster. For more
information on CTI Managers, see Signaling Groups.

You can specify one or more Unified CM telephony groups.

Note: A Unified CM telephony group requires at least one CTI Manager.

You enter each Unified CM in the Unified CM telephony group in SystemConfiguration Setup
so that the Desktop Recording service can find the location of the Recording CTI service.
QualityManagement stores an association between the Recording CTI service and the Unified
CMs in the cluster. If a Unified CM is not in the list, the Desktop Recording service will not know
where to register for events.

Note: Adding a new Unified CM telephony group here does not actually add a Unified
CM cluster. It creates the association between the Recording CTI service and the
Unified CMs in the cluster.

Field Description

Name The name of the telephony group.

Telephony Group

Type

The telephony signalingmethod for Unified CM. The field displays Unified CM

by default.

Unified CM Configuration fields and buttons
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Field Description

Endpoint only does

Screen Recording

When selected this check box indicates that the Unified CM telephony group is

being used for screen recording only. The Desktop Recording service will not

record audio when this box is selected. This only applies when you are using

one of the following recordingmethods:

n Network Recording

n Cisco CUBE Recording via SIP Recording

n CiscoMediaSense Recording

Enable Network

Recording

When selected this check box indicates that the Unified CM telephony group is

using Network Recording and the Recording CTI service will listen for SIP mes-

sages. The Recording CTI service will not listen for SIP messages when the

check box is cleared.

You can install the Recording CTI service and CUBE SIP CTI service on the

samemachine if you clear the Enable Network Recording check box.

Example: You are recording voice throughGateway Recording (using

the CUBE SIP CTI service) and recording screen from a single server.

Note: The Recording CTI service and CUBE SIP CTI service will

interfere with each other while listening for SIP messages if the Enable

Network Recording check box is selected.

CDR Configuration Allows you to enable the Unified CM’s Call Detail Records (CDR) Report. See

CDR Configuration for more information.

SOAP AXL

Access Username

The AXL (Administrative XML Layer) authentication username on the publisher

for this cluster. The SOAP AXL account is used to access devices in Unified

CM from the VoIP Devices window. This username is created when you

configure Unified CM.

SOAP AXL

Access Password

The AXL authentication password on the publisher. This password is created

when you configure Unified CM.
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Field Description

SOAP AXL

Access Version

The Unified CM version on the publisher.

Note: An error message will appear if the Version field is not configured.

JTAPI Username The JTAPI username for CTI. All phone devices, used for recording are

associated with this application user (end user). The Recording CTI service

logs into the Unified CM with this user. The usernamemust be between 1 and

32 alphanumeric characters. This field is enabled when you choose CTI or

Mixed from the Telephony SignalingMethod drop-down list.

JTAPI Password The JTAPI user’s password for CTI. This must be between 1 and 32

alphanumeric characters. This field is enabled when you choose CTI or Mixed

from the Telephony SignalingMethod drop-down list.

IP Address The host name or IP address of the subscriber (if any) Unified CMs. You can

enter one publisher Unified CM, and one or more subscriber Unified CMs.

Note: When using hostnames, verify the server can resolve the name of

the subscribers. If the hostname cannot be resolved, the Recording CTI

service cannot log in.

Publisher The field indicates whether or not the provided Host Name/IP address is asso-

ciated with the publisher CTI Manager. If the field is blank, the Host Name/IP

address is associated with a subscriber CTI Manager.

Add Add a new publisher or subscriber. See Subscriber Configuration for more

information.

Delete Remove the selected publisher or subscriber.

Find Subscribers Use the AXL user to locate subscribers associated with the publisher entered.

This is a good way to validate the AXL user and to populate the list of

subscribers, if any are found.
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CDR Information Formats for the QM3002 Notification Trigger

You can specify in which format you want to display the CDR information in the CDR
Configuration dialog box. Examples of the available formats are listed here.

In these reports, call durations are expressed inmilliseconds.

If the agent is listed as “Unknown” it means the agent has not successfully logged in to a PC
that has the Desktop Recording service. It is probable that the agent was not configured
correctly. Notifications for unknown agents are filtered out if the “Notify on users configured in
QM” check box is enabled.

CDR Configuration

CDR Configuration allows you to enable the Unified CM’s Call Detail Records (CDR) Report.
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Field Description

Unified CM

Version

Select the version of the Cisco Unified CM you are using.

Host

Name/IP

Address

Choose host name or IP address, and then enter the information for the Unified CM.

Username The name of the user with rights to access the CAR reports.

Password The password of the user with rights to access the CAR reports.

Ignored

Extensions

Displays the list of ignored extensions. Quality Management does not send

notifications about extensions that appear in this list. Select one of the following options

tomodify the extensions that appear in this list.

n Add—add a new extension to the list

n Remove—delete an extension from the list

n Edit—modify a selected extension in the list

CDR Configuration dialog box fields

Summary Only

Status Report

Start Time: 01/11/2008 15:25:53

End Time: 01/11/2008 16:25:53

Extensions with Missed Calls:

Ext Agent Found Missed % Missed

1545 JonesM 0 8 100%

2201 SmithB 0 15 100%

Detail (Tab Delimited)

Status Report

Start Time: 01/11/2008 15:23:41

End Time: 01/11/2008 16:23:41

Extensions with Missed Calls:

        Ext Agent Found Missed % Missed

        1545    JonesM 0 8 100%
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        2201    SmithB  0 16 100%

Missed Calls (all times in GMT):

CallID   Agent Ext ANI DNIS StartTime Duration

16778554 JonesM 1545 2671 1545 01/11/2008 03:29:3613000

16778560 JonesM 1545 2671 1545 01/11/2008 03:29:5214000

16778561 JonesM 1545 2671 1545 01/11/2008 03:30:097000

16778594 JonesM 1545 2671 1545 01/11/2008 03:36:0112000

16778596 JonesM 1545 2671 1545 01/11/2008 03:36:1811000

Detail (Plain Text)

Status Report

Start Time: 01/11/2008 15:24:57

End Time:   01/11/2008 16:24:57

Extensions with Missed Calls:

            Ext    Agent Found Missed % Missed

            1545   JonesM 0     8 100%

            2201   SmithB  0    16 100%

Missed Calls (all times in GMT):

Call ID = 16778554

Agent = JonesM

Ext     = 1545

ANI     = 2671

DNIS    = 1545

Start   = 01/11/2008 03:29:36

End     = 01/11/2008 03:29:49

Duration= 13 sec

Call ID = 16778560

Agent = JonesM

Ext     = 1545

ANI     = 2671

DNIS    = 1545

Start   = 01/11/2008 03:29:52

End     = 01/11/2008 03:30:06

Duration= 14 sec
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Managing Ignored Extensions

Select a Unified CM telephony group from the list of telephony groups in the TelephonyGroups
window, click CDR Configuration, and choose one of the following options:

n To add an ignored extension, click Add in the Ignored Extensions section, enter the
extension in the field, and then clickOK.

n To edit an ignored extension, select the extension from the Ignored Extensions list, click
Edit, make the necessary changes in the Edit Extension dialog box, and then clickOK

n To remove an ignored extension, select an extension from the Ignored Extensions list
and click Remove.

Configuring the QM3002 Notification Trigger

This task describes how to configure the QM3002 notification trigger.

1. Click CDR Configuration in the Unified CM Configuration window for a Unified CM
telephony group type.

The Configuration dialog box appears.

2. Select the version of the Cisco Unified CM you are using from the Unified CMdrop-
down list.

3. Choose Host Name or IP Address, and then enter the information for the Unified CM.

4. Type the Unified CMusername and password.

Enter the name and password of the user with rights to access the CAR reports.

5. Add the extensions that you do not want to receive notifications. SeeManaging Ignored
Extensions for more information

6. Configure the properties for the notification.

7. ClickOK.

Subscriber Configuration

Use the Subscriber Configuration dialog box to add a Unified CM server to the Cisco Unified
CM cluster.
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Field Description

Host

Name/IP

Address

The host name or IP address of the publisher or subscriber (if any) Unified CMs. You can

enter up to 8 subscriber Unified CMs.

Note: When using hostnames, verify the server can resolve the name of the

publisher or subscribers. If the hostname cannot be resolved, the Recording CTI

service cannot log in.

Is Pub-

lisher

Select this check box if the provided Host Name/IP address is associated with the pub-

lisher CTI Manager. Only one publisher CTI Manager is allowed. This check box is dis-

abled when a publisher CTI Manager is configured.

Note: A publisher CTI Manager must be configured before you can add subscriber

CTI Managers.

Subscriber Configuration fields

MediaSense Configuration

TheMediaSense Configuration dialog box appears when you edit a telephony group with a
MediaSense telephony type. It allows you to configure the CiscoMediaSense cluster
associated with the telephony group. QualityManagement uses this information to download
call recordings fromCiscoMediaSense.
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If youmodify the information in the CiscoMediaSense window after the initial installation and
configuration, youmust restart theMediaSense Subscription service before your changes take
effect.

Field Description

Name The name of the telephony group.

Telephony Group Type The telephony signalingmethod for CiscoMediaSense. The

field displays MediaSense by default.

Primary MediaSense API Server IP

Address or Hostname

The hostname or IP address of the primary Cisco

MediaSense API server.

Secondary MediaSense API Server

IP Address or Hostname

The hostname or IP address of the secondary Cisco

MediaSense API server.

MediaSense Subscription Service IP

Address or Hostname

The hostname or IP address for theMediaSense

Subscription service.

MediaSense Subscription Service

Port

TheMediaSense port number used by theMediaSense Sub-

scription service. Default = 8440.

MediaSense Configuration fields
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Field Description

Authentication Username The username for the CiscoMediaSense API server.

Authentication Password The password for the CiscoMediaSense API server.

Signaling Groups

A signaling group consists of one or more signaling services.

See TelephonyGroup Considerations for additional information on signaling groups.

For the Unified CM telephony group, you can specify a primary and backup CTI Manager
throughQualityManagement. AnyUnified CM that has the CTI Manager running on the
subscriber can be your primary or backup CTI Manager.

Note: You can configure anymachine as the primary CTI Manager, but it is a good idea
to avoid using the publisher, because it already has the highest load. Using another
server as the primary CTI Manager helps avoid decreasing the Unified CM
performance.

Field Description

Primary Signaling Details

Host Name/IP

Address

The hostname or IP address of the primary signaling service. A primary

hostname or IP address is required.

This signaling service can belong tomore than one signaling group.

CUCM CTI Managers

for JTAPI

The IP address of one or more primary CTI Managers. The CTI Manager is a

service that runs on Unified CM and handles JTAPI events for every Unified

CM in the cluster.

This option only appears for the CTI service.

Backup Signaling Details

Signaling Group fields and buttons
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Field Description

Host Name/IP

Address

The hostname or IP address of the backup signaling service. A backup

hostname or IP address is optional.

This signaling service can belong tomore than one signaling group.

Note: The signaling service remains on the backup server until you

manually initiate fail back to the primary server.

This option is not available for the CiscoMediaSense Subscription service.

CUCM CTI Managers

for JTAPI

The IP address of one or more backup CTI Managers. The CTI Manager is a

service that runs on Unified CM and handles JTAPI events for every Unified

CM in the cluster.

This option only appears for the CTI service.

Additional Associated

Servers

IP addresses for the remaining subscribers that are not associated with the

primary and backup CUCM CTI Manager for JTAPI.

Up Arrow or Down

Arrow

Use the Up or Down arrow buttons tomove the CUCMCTI Managers to the

desired location.

This button only appears for the CTI service.

Add + Allows you to add a CUCM CTI Manager.

This button only appears for the CTI service.

Delete - Allows you to delete a selected CUCM CTI Manager.

This button only appears for the CTI service.

Recording Clusters

QualityManagement supports Recording Clusters. A Recording Cluster is a group of one or
more Recording servers. A Recording server indicateswhich Recording Cluster it belongs to
when it connects to a signaling service.

You can assign a Recording servers to a Recording Cluster. When configuring a Recording
Cluster remember the following points:
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n If you have knowledge workers in a CUBE or MediaSense Recording environment who
require screen recording, you need to create a Recording Cluster that connects to a CTI
server and has no Recording servers assigned to it.

n You can assign one or more Recording servers to a Recording Cluster. A Recording
Cluster requires at least one primary Recording server. See TelephonyGroup
Considerations for additional information on recording clusters.

A primary signaling service will exhaust the capacity of all primary Recording servers
before sending calls to secondary Recording servers. A backup signaling service will
exhaust the capacity of all secondary Recording servers before sending calls to primary
Recording servers. This allows primary/backup signaling services and
primary/secondary Recording servers to be split geographically while keeping the traffic
as local as possible. Significant traffic should only traverse theWAN in specific failure
scenarios.

n A Recording server can only belong to one Recording Cluster.

n You canmove Recording servers between Recording Clusters.

Important: Youmust run SystemConfiguration Setup (PostInstall.exe) on all Recording
servers before you can assign a Recording server to a Recording Cluster. If you do not
run SystemConfiguration Setup on the Recording servers the Select Record Servers
dialog boxwill be empty.

Field Description

Primary Record

Servers

The primary Recording server assigned to this recording cluster.

Secondary Record

Servers

The secondary Recording server assigned to this recording cluster.

Left Arrow < or Right

Arrow >

Use the left or right arrow buttons tomove the selected Recording server to

the desired location.

Add Allows you to add one or more Recording server as primary or secondary

record servers.

Remove Allows you to delete a selected Recording server.

Recording Clusters fields and buttons
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Managing Telephony Groups

To add a telephony group:

1. From the TelephonyGroupswindow, select the TelephonyGroups node, click Add,
complete the fields, and then clickOK to create a telephony group.

2. If there are fields associated with the new telephony group, complete the fields.

Note: You cannot continue to the next step until you complete the fields.

3. Expand the new telephony group node, click Signaling Groups, click Add, complete the
field, and then clickOK to create a signaling group.

4. Complete the fields for the signaling group.

Note: You cannot continue to the next step until you complete the fields.

5. Expand the new signaling group node, click Recording Clusters, click Add, complete
the field, and then clickOK to create the new recording cluster.

6. Complete the fields for the Recording Cluster and then click Save.

Configuration Settings Used By Services

If you change the settings for a telephony group, the following table showswhen your changes
take effect.

Telephony

Group

Type

Service Configuration settings applied when...

CUBE CUBE SIP CTI Ser-

vice

Restart the service.

MediaSense Monitoring and

RecordingMedi-

aSense Subscription

service

Restart the service.

When services start using the changed configuration settings
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Telephony

Group

Type

Service Configuration settings applied when...

Unified CM Recording CTI Ser-

vice

Restart the service.

Quality Management

Administrator (VoIP

Devices)

Reload the VoIP Device window.

Desktop Recording

service

Restart the service.

Network Recording

service

Restart the service.

Note: If you add a backup Recording CTI Service from

the System Configuration Setup utility while in Update

Mode, youmust restart the Network Recording

service.

Active Directory Options

Choose one of the following options from the Active DirectoryOptions drop-down list.

n Use Active Directory—Choose this option if you want to use Active Directory to
authenticate user names and passwords.

n UseQMAuthentication—Choose this option if you want to useQualityManagement to
authenticate user names and passwords.

JTAPI Completed Successfully

ClickOK to dismiss the confirmation box.
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Enterprise Settings

Use the Enterprise Settingswindow to configure QualityManagement.

Note: The Active Directory section appears in the Enterprise Settingswindow only if
your system is configured to use Active Directory.

You can use Enterprise Settingswindow to do the following:

n Share login fields with other products. See the following topics for more information:

l Sharing UnifiedWorkforce Optimization with Multiple Products

l Share Login Fields

n Configure the locale for your system if your version of QualityManagement supports
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other languages in addition to English. See Locale for more information.

n Choose the default audio format for your recordings. See Audio Format for more inform-
ation.

n Specify when the DB Cleaner service runs. See Cleanup for more information.

n View license information and update software licenses, if you are not using an ACD, by
importing a new software license file. See License for more information.

n ConfigureMicrosoft Active Directory domains (in an Active Directory system only). See
Active Directory for more information.

n Enable Kerberos Authentication for Recording Controls. When enabled, a user must
enter their AD credentials to accessRecording controls. This check box is enabled only
when Active Directory is enabled.

Note: You will be prompted to restart the Jetty service. Changes to Kerberos
Authentication goes into effect after the Jetty service is restarted.

n Configure themethod (SMTP or SNMP) used to notify administrators or supervisors of a
system problem and decide if emailing reports will be allowed. See Integration
Configuration for more information.

n Configure the report logo that appears in reports generated in the Reporting application.
See Report Logo Configuration for more information.

Note: The Report Logo Configuration button is only enabled fromSystem
Configuration Setup (PostInstall.exe) or QualityManagement Administrator on
theWeb Base server.

n Configure session timeouts for Recording andQualityManagement andQuality
Management Administrator. See Session Timeout Options for more information.

n Configure the securitymode to allow only secure and encrypted connections. See Ser-
vice SecurityMode for more information.

Configuration Settings Used By Services

If you change the settings on the Enterprise Settingswindow, the following table showswhen
your changes take effect.
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Service
Configuration settings

applied when...

Quality Management Administrator (AD Authentication and

Administrator session timeout change)

Log into Quality Management

Administrator.

UnifiedWorkforce Optimization (AD Authentication and localization

changes)

Start the Data API service.

Kerberos Authentication for Recording Controls Restart the Jetty service

When services start using the changed configuration settings

Sharing Unified Workforce Optimization with Multiple Products

UnifiedWorkforce Optimization allows you to access several different products from a single
login page. You can choose to access all products with a single password or separate
passwords for each product when you run the SystemConfiguration Setup tool.

Share Login Fields

You can choose to allow access to one or more of the following products fromUnified
Workforce Optimization:

n QualityManagement

n WFM

You can also choose to share common login fields for these products by selecting the Share
Login Fields with Other Products check box. If you select this option for each product, users are
prompted for a single set of common login credentials.

If a user is not configured for multiple Cisco products or the user wants to log into both of the
Cisco products with different login credentials, the user can select the Separate Product Logins
check box in the Login window.

If you do not select the Share Login Fields with Other Products check box, users are prompted
for separate login credentials for each Cisco product.

Cisco recommends using shared login fields when the users use the same username and
password for both products.

See the User Guide for more information on single-user login authentication.
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Locale

Use the Locale section to enable the default language in the UnifiedWorkforce Optimization
interface. Users can change the default language when they log in to UnifiedWorkforce
Optimization.

Note: The Locale section only appears whenmultiple locales are available.

To change the default locale for the Unified Workforce Optimization interface:

n Select the desired language from the Locale drop-down list.

Storage Configuration

Use Storage Configuration tomanage the storage of recordings, including: the default audio
format and the database cleanup time.

Choose the default audio format. Your options are as follows:

n SPEEX—provides the smallest file size. Choose this option if your greatest concern is to
maximize storage space.When upgrading from 9.1 or lower, the default is SPEEX.

n WAV-8—files are approximately four times larger than SPEEX files. Choose this option if
you want to compromise between greater audio fidelity and storage space.

n WAV-16—files are approximately twelve times larger than SPEEX files. Choose this
option if you want themaximumaudio fidelity and you are not concerned with storage
space.

The Database Cleanup Time field specifies when the DB Cleaner utility runs. This utility
deletes expired recordings from the database. The value providedmust be between 00: and
23:59 in 1-minute increments. Choose a time when no uploads are occurring to reduce the
load on the system. Default = 00:05.

License

This section displays the available licenses and allows you to import licenses.

What appears in the License section after the initial installation depends on whether the
Synchronize Users with ACD check box is cleared or selected. If you select the Synchronize
Users with ACD check box, you are runningQualityManagement with Unified CCX with
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mixed-mode licensing enabled. QualityManagement obtains the licenses from the Cluster
View Daemon (CVD) in Unified CCX and then displays the active license information in the
License section. Your licenses can be updated through Unified CCX Licensing.

Note: If a connection to the CVD cannot bemadewhen initially running System
Configuration Setup, QualityManagement will continue to try connecting to the CVD.
You will not be able go to the next window until QualityManagement can successfully
connect to the CVD.

Note: If you add new license types (for example, change from only the QM license type
to QMand AQM license types), youmust ensure QualityManagement Administrator is
configured to support the new license types (for example, add a qualitymanagement
workflow and assign users to the AQM license).

Contact your sales representative to obtain a new license file.

Licensing Rules

The license type determineswhat QualityManagement records.

When you log into UnifiedWorkforce Optimization, you have access to all QualityManagement
applications allowed by the license and roles assigned to you.

The license determineswhat is recorded, not what is viewed, in UnifiedWorkforce
Optimization.

Example: If Agents X and Y use AQMor AQMA license, they can record their screens.
If the supervisor for these agents only has aQMor QMA license, the supervisor can still
view the screen recordingsmade by these agents. For more information on Licensing,
see "MixedMode Licensing" in the Integration Guide.

Importing a License File

To import a Cisco CR license file:

1. Click the Upload License button.

The Upload License File dialog box appears.

2. Navigate to the folder where your updated Cisco CR license file is stored, and select
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the file.

If you are fixing a corrupted license, upload your existing license file.

3. Click Upload File.

The Licensing Server uploads the Cisco CR license file.

Active Directory

The Active Directory section appears in the Enterprise Settingswindow only if your system is
configured to use Active Directory. Use the Active Directory section to configure Active
Directory domains.

n Theremust be at least one domain configured

n Each domainmust have at least one user path configured

Domain Information

The connection information that you enter for Active Directory in the Domain Information dialog
box is verified using the entered credentials, and the user paths are validated when you click
OK in the Domain Information dialog box.
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Field Description

Base DN The location of all Active Directory users in the directory server tree. This field is

autofilled with a sample format with variable names that you replace with the domain

information. Maximum number of characters allowed = 1000. If your hostname has more

than 3 parts, add additional DC=domain statements to the beginning of the Base DN

field.

Domain

Name

Defaults to the first part of the string entered in the Base DN field. In most cases this is

the domain name, but in some cases youmust edit the default.

Host

Name/IP

Address

The host name or IP address of the Active Directory server.

Domain Information fields and buttons
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Field Description

Port The port used to access the Active Directory server. The field is autofilled with the

default port 389, or 636 if you are using SSL (Secure Socket Layer).

Note: If you change the port to anything other than 389 or 636, clearing or

selecting the Use SSL check box will not change the port.

TheQuality Management server must allow socket communication on this port to be

able to access the Active Directory server for user authentication.

Display

Name

The name (not the login name, but the display name as configured in Active Directory) of

a user with read access to the Active Directory database. Maximum number of

characters allowed = 1000.

User

Password

The user’s password.

User

Search

Base

The node in the Active Directory folder under which the user resides. Maximum number

of characters allowed = 1000.

Use SSL Select this check box to use SSL for connection to Active Directory. The check box is

clear by default and indicates SSL is not enabled. Clearing or selecting this check box

changes the default port number in the Port field.
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Field Description

Admin

Group

The name of the security group in Active Directory. The users assigned to this security

group will be allowed to log in to Quality Management Administrator and Unified

Workforce Optimization as an business administrator by default.

The users in this Admin Group can be promoted to system administrator in System

Configuration Setup (PostInstall.exe). PostInstall.exe reconciles users against the

Admin Group.

Note: All users in the Admin Groupmust belong to the same domain specified in

the Base DN field.

Note: AD Account users associated with the Security Group setting are not

given an administrator role by default.

To assign the system administrator role to a user in this security group, see

Administrator Configuration.

Best practice: Create a security group with a unique name in Active Directory

and add the users who you want to have system administrator privileges in

Quality Management Administrator and UnifiedWorkforce Optimization. Specify

the name of that security group in this field. This prevents any conflict with

default security groups in Active Directory.

Note that adding users to the Domain Admins group is not appropriate in this

instance because the users in the Domain Admins group also have permission to

make changes in Active Directory.
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Field Description

Add

Certificate

Locate the Certificate Authority (CA) certificate for Active Directory. Active Directory

with SSL requires this certificate. The certificate provides the Active Directory identity

and public key for SSL communication.

Contact your Active Directory administrator for the location of the CA certificate for

Active Directory. In many cases, the Certificate Authority on the Active Directory

machine issues the CA certificate for Active Directory. If this is the case, you can

access the certificate from:

http://<Active Directory server IP address or

hostname>/<certsrv>

You can use certificate enrollment tools other than certsrv in this command.

Note: Quality Management can only import Distinguished Encoding Rules

(DER) encoded binary X.509 or Base-64 encoded X.509 formatted

certificates. These files typically have one of the following extensions: der, pem,

or cer.

Download the certificate from this website by clicking Download a CA certificate,

Certificate Chain, or CRL and save it to a folder. Then click Add Certificate to import the

certificate.

Note: After you import the certificate and save your changes, log out of Quality

Management Administrator and log back in to verify the certificate works.

View

Certificate

View the certificate associated with Active Directory.
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Field Description

User

Records

(OUs)

One or more paths to user records (OUs). Click Add to add at least one path, or Remove

to remove an existing path. Maximum number of characters allowed = 1000.

Youmust specify Active Directory paths from themost specific to the least specific

(from left to right in the path statement). For example, if the Active Directory tree is:

 ou=US

    ou=Minnesota

       ou=Minneapolis

          ou=Users

Then the user record appears as follows:

ou=Users,ou=Minneapolis,ou=Minnesota,ou=US

Quality Management will search subtrees by default. For example, you could write the

user record path as follows, andQuality Management will search all the subtrees under

Minnesota.

ou=Minnesota,ou=US

Add Add a user record.

Remove Remove a user record.

Edit. Modify a user record.

OK Save your changes.

Cancel Exit without saving changes.

Managing Active Directory Domains

To add or delete an Active Directory domain from the Enterprise Settings window:

n To add an Active Directory domain, click Add in the Active Directory section. The
Domain Information window appears. Complete the fields and clickOK.

n To delete an Active Directory domain, select the Active Directory domain you want to
delete from the list in the Active Directory section, and then click Remove.
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SMTP Configuration

SMTP Configuration allows you to configure the SMTP email connection.

Note: This feature is only enabled on theWeb Base server.

Notifications can be sent to the Event Viewer or in emails to specified recipients. To use email
notification, enable the Use Email Notification check box and then configure up to 5 email
addresses.

Notification emails will be sent from the sender email address configured in the SMTP
Configuration dialog box. If you are using email notification, youmust configure SMTP. This
can be done only from theQualityManagementWeb Base server.
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Field Description

Host Name/IP

Address

Choose Host Name or IP Address, and then enter the hostname or IP address of the

SMTP server.

Port The port used by theMANA service to communicate with the SMTP server.

Use

Authentication

Select this check box if authentication is needed to access the SMTP server.

User The username needed to access the SMTP server.

Password The password needed to access the SMTP server.

Authorization

Type

The type of authorization required. Your options are as follows:

n NONE

n BASIC

n TLS

n SSL

From Address The email address from which all notifications will come.

Emergency

Address

The email address where notification will be sent if the Quality Management

database is downwhen theMANA service attempts to get its initial configuration.

The notification email addresses configured in theMonitoring and Notification

window are stored in the Quality Management database, and thus will not be

functional in the event that the Quality Management database is unavailable when

theMANA service first starts.

If theMANA service has already obtained a valid configuration from theQuality

Management database, and the Quality Management database goes downwhile the

MANA service is running, theMANA service will use the valid configuration it

already has. As a result, the notification that the Quality Management database is

downwill go to the configured email address, not to the emergency address.

SMTP Configuration fields

To configure SMTP settings for email:

n Click SMTP Configuration, complete the fields, and then clickOK.
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SNMP Configuration

SNMP Configuration allows you to configure the SNMP connection.

Note: This feature is only enabled on theWeb Base server.

Notifications can be sent by Simple NetworkManagement Protocol (SNMP). SNMP is an
application-layer protocol that provides amessage format for communication betweenQuality
Management and a trap destination.

Field Description

Trap Destinations The available trap destinations.

Add Add a trap destination.

Remove Remove a trap destination.

Edit Edit a trap destination.

SNMP Configuration fields and buttons

To configure SNMP settings for notification:

n Click SNMP Configuration, choose one of the following options, and then clickOK.

l Click Add to add a new trap destination.

l Select a listed trap destination and then click Edit to change the IP address.

l Select a listed trap destination and then click Remove to delete IP address.
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Restart theWindowsSNMP service to enable your changes.

Note: Youmust restart the SNMP service any time youmake a change in trap
destinations, including on the initial setup.

Report Logo Configuration

Report Logo Configuration allows you to customize the logo that appears in reports generated
by the Reporting application in UnifiedWorkforce Optimization.

Custom logosmust conform to the following specifications:

n The logomust be 60 × 60 pixels

n It must be in PNG format

n The file must be named "logo.png"

To replace the default logo with your own custom logo:

1. Navigate to the C:\ProgramFiles\Cisco\WFO_QM\Jetty\report_solutions\reports
folder, copy the original logo.png and save it to a backup folder.

2. Copy and replace the custom logo.png to the following folders:

n C:\ProgramFiles\Cisco\WFO_QM\Jetty\report_solutions\reports

n C:\ProgramFiles\Common Files\QM\config

Note: By copying your custom logo file into the Common Files folder, it will
be available even if you upgrade to a new version. PostInstall
automatically copies it from the Common Files folder to the correct folder
within the QualityManagement file structure every time it is run.

3. Start SystemConfiguration Setup (PostInstall.exe) or QualityManagement Admin-
istrator.

4. On the Enterprise Settingswindow, click Report Logo Configuration.

5. Click Select New Logo, browse to the location of your logo, and then click Select
Image.

6. Click Save.

7. Restart the Jetty service.
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To restore the default logo:

1. On the Enterprise Settingswindow, click Report Logo Configuration.

2. Click Use Default Logo and then click Save.

3. Restart the Jetty service.

Allow Emailing of Reports

When selected, the Allow Emailing of Reports check box allows you to email a report to a
specific person or distribution list. For more information on creating a distribution list, see
Notification Distribution.

Session Timeout Options

You can configure QualityManagement Administrator or Recording andQualityManagement
in UnifiedWorkforce Optimization for one of the following options:

n Close all open popup windows and log off the user after a specified number of minutes of
inactivity (session timeout)

n Allow a user to remain logged in indefinitely (default setting)

To configure the session timeout period, enter the desired number of minutes of inactivity
before timeout occurs in theminutes field.

Note: When you change the Session Timeout value for QualityManagement
Administrator, youmust restart QualityManagement Administrator before the changes
can take effect.

If a user accessed one or more Recording andQualityManagement applications, each
application displays a TimeoutWarning dialog box 30 seconds before the application actually
times out. If the user does not respond to the TimeoutWarning dialog box, the dialog box and
the application are closed and an alert is sent to the user stating that the application timed out
and was closed.

When you are playing a customer conversation, the session remains in an active state. Unified
Workforce Optimization does not time out when you are playing a customer conversation.
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Service Security Mode

If you configured the servers to run with Secure Socket Layer (SSL) and plan to use Hypertext
Transfer Protocol Secure (HTTPS), some traffic will continue through non-secure transport.
Specifically, voice and screen uploadswill continue over non-secure transport as the data is
already encrypted.

Select the Allow secure / encrypted connections check box to enable secure
(HTTPS) connections for traffic other than voice and screen upload.When this check box is
selected, youmust use HTTPS when connecting to UnifiedWorkforce Optimization. Once
enabled, you will not be allowed to play back recordings or livemonitor a user if you are using
HTTP to connect to UnifiedWorkforce Optimization.

When the check box is selected, the useSSL flag for web, voice, and screen servers will be set
to true and their httpPort setting will use the statically defined value of 7001.

Note: You will need tomanually block port 80 if required. See theQualityManagement
Port Usage for more information on port usage.

When the check box is cleared, the useSSL flag for web, voice, and screen servers will be set
to false, and their httpPort setting will use port 80.

Licenses Validated Successfully

ClickOK to dismiss the License Validated Successfully confirmation box.

Change Administrator Password

Type a password for the administrator in the New password field, type the password again in
the Confirm new password field, and then clickOK.

This password allows the administrator to accessQualityManagement Administrator and
UnifiedWorkforce Optimization. The passwordmust be between 1 and 32 characters long. It is
case sensitive.
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Note: If you are installing QualityManagement for the first time, the Old password field is
disabled.

Gamification Metrics

Use theGamificationMetrics window to configure the connection settings to allow the retrieval
or posting of gamificationmetrics. Additional configuration options are provided in Recording
andQualityManagement when you log in to UnifiedWorkforce Optimization.
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Field or

Button
Description

Metric

Name

The name of themetric. The available metrics are as follows:

n Adherence—the agents' adherence data. This metric is pulled fromWFM and

requires additional configuration. Once configured, Quality Management will

retrieve the nightly, as well as historical performance data fromWFM.

n Quality—the agents' performance data from evaluations. This metric is pushed

from Recording andQuality Management and required no additional con-

figuration.

Data

Pushed

Indicates how the data is collected. The options are as follows:

n Yes—the data is pushed (or posted)

n No—the data is retrieved (or pulled)

Server The hostname or IP address of the server.

Update

Connection

Details

Configure the connection details for the selectedmetric.

Gamification Metrics fields and buttons

Gamification Configuration

Use theGamification Configuration dialog box to configure the connections settings for a
selectedmetric.
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Field or Button Description

Name The name of themetric. The available metrics are as follows:

n Adherence—the agents' adherence data. This metric is pulled from

WFM and requires additional configuration. Once configured, Quality

Management will retrieve the nightly, as well as historical performance

data fromWFM.

n Quality—the agents' performance data from evaluations. This metric is

pushed from Recording andQuality Management and required no addi-

tional configuration.

Data Push When this check box is selected, the data is pushed (or posted) specified

server. When this check box is cleared, the data is retrieved or pulled the

specified server.

Gamification Metrics fields and buttons
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Field or Button Description

Server Configuration

Hostname or

IP Address

The hostname or IP address of the server container for the gamification

metric. This field is enabled when you clear the Data Push check box.

For the adherencemetric, specify the hostname or IP address of theWFM

container.

Server Configuration

Port

The port number for the server for the gamificationmetric. This field is enabled

when you clear the Data Push check box.

Connection Con-

figuration Resource

Address

The location of the API where the performance data will be retrieved from.

When you choose the Adherencemetric, this field is prepopulated with the

path to the performance data and cannot be changed.

Connection Con-

figuration Schedule

The schedule for retrieving the performance data. By default the value is * * * *

*. You can adjust the retrieval schedule to suit your needs.

This field accepts a free form text value of the cron formatted

(http://www.nncron.ru/help/EN/working/cron-format.htm) schedule.

Managing Gamification Metrics

To update connection details for a metric:

n Click Update Connection Details, complete the fields in the Gamification Configuration
dialog box, and then clickOK.

Administrator Configuration

Note: When you upgrade from 9.2 or earlier, the only administrator that exists will be the
default administrator. The default administrator is a system administrator. Users who
were assigned the administrator role in the previous release will require additional
configuration. After upgrading to 11.0, you need to assign your administrator users
based on the new hierarchical administrative roles.

The Administrator Configuration window allows you to assign the system administrator role to
users who belong to the Admin Group. See the Domain Information for a description of the
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Admin Group and "Administrator" in the Administrator Guide for a description of the
administrator roles.

Important: Once you assign the system administrator role to a user in a non-Active
Directory environment, the default administrator user becomes obsolete and you can no
longer log in as a default administrator.

Note: You can only promote users to system administrator fromSystemConfiguration
Setup (PostInstall.exe) on theWeb Base server.

If you are using Active Directory, the Administrator Configuration window will only display
users in the security group that have a complete configuration (including a Last Name).

If you are not using Active Directory, the Administrator Configuration window will display users
configured in the User Administration window.
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Field or

Button
Description

Last Name The user's last name.

First Name The user's first name.

User ID The user ID assigned to the user. The format of an ACD user ID is <agent’s

PG>.<agent’s ICM Peripheral Number>.

Admin Role The administrator role assigned to the user. The options are as follows:

n System—the user is promoted to the system administrator role.

n None—the user is not a system administrator. The default is None.

To assign the business or telephony administrator role to a user, see "User

Administration" in the Administrator Guide.

Windows

Login

The user’s Windows user name.

Domain The user's domain name.

Change

Admin Role

Select one or more users and click the Change Admin Role button to change the

administrator role assigned to the users.

Administrator Configuration fields and buttons

Managing Administrators

n To promote one or more users to system administrators, select the users with the Admin
Role of None, click Change Admin Role, and then click Yes.

n To demote one or more system administrators to users, select the users with the Admin
Role of System, click Change Admin Role, and then click Yes.

Site Settings

Use the Site Settingswindow to configure one or more sites and associate teams and
Recording Clusters with each site.

135



Configuring QualityManagement

When you install the Site Upload Server on a server, this is the first screen to appear in System
Configuration Setup (PostInstall.exe).

Note: The Site Settingswindow only appears when you install the Site Upload Server.

You can use the Site Settingswindow to do the following:

n View the current site configuration

n Modify or remove a site

n Add or remove teams from a site

n Add or remove Encoding Servers from a site

n Add or remove Recording Clusters from a site

n Change the default site

n Specify when, where, and how many uploads can occur
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n Schedule uploading of peak and off-peak recordings from the agent desktops to the Site
Upload servers

n Configure storage locations

n Enable and configure two stage upload

Field Description

Delete Selected Site Remove an existing site.

Default Site The default site is assigned to new teams that have not been

associated with a site. In rare circumstances, it also becomes the

default site when a service cannot find a site for a recording.

Site Name The name of the site.

Peak Hours Begin The time, in 24-hour format, when peak hours in the contact center

begin. Must be between 00:00 and 23:59 in 1-minute increments.

Default = 09:00.

Peak Hours End The time, in 24-hour format, when peak hours in the contact center

end. Must be between 00:00 and 23:59 in 1-minute increments.

Default = 17:00.

Max Peak Hour Uploads Themaximum number of recordings that can upload simultaneously

during peak hours. Must be a value from 1 to 100. This limit is set to

conserve bandwidth on the network. When one upload completes,

another takes its place, but there can be nomore than the configured

number uploading at any one time. Default = 5.

Max Off Hour Uploads Themaximum number of recordings that can upload simultaneously

during off hours (the hours not specified as peak hours as defined by

the Peak Hours Begin and Peak Hours End fields). Must be a value

from 1 to 200. This limit is set to conserve bandwidth on the network.

When one upload completes, another takes its place, but there can be

nomore than the configured number uploading at any one time.

Default = 100.

Site Settings fields and buttons

137



Configuring QualityManagement

Field Description

Storage Location You can change the storage location to any local or external folder.

You do not have to store recordings on themachine that hosts the Site

Upload Server.

If you change the storage location, youmust run the Set Recording

HomeDirectory tool to restart the services.

Note: If you are using remote storage, theMedia API that is

part of the Site Upload Server must run as a user who has

access to the location you choose for recordings.

IP Address The IP address of themachine that hosts the Site Upload Server and

the voice recordings, and the path where voice recordings are stored.

Cache Location (Cloud-based storage only) The location where unencrypted voice and

screen recordings are stored. These files are used for playback. The

specified directory must be accessible by the local system users and

each of the Encoding servers. External location credentials must be

shared with the permanent storage location.

A cache location is required if you are using cloud-based storage.

Unencrypted files must be stored separate from the permanent

storage location for performance reasons. Note that the Jetty service

must be restarted when you change the cache location for the

changes to go into effect.

Local Site Cache Location Choose this option to store the unencrypted voice and screen

recording in a local site cache location.

Best Practices: If there is only one configuredMedia Encoder

and it is local, choose the Local Site Cache Location for best

performance.

This field appears in the Choose Site Location dialog box.
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Field Description

External Site Cache Loca-

tion

Choose this option to store the unencrypted voice and screen

recording in an external site cache location.

Best Practices If there are one or moreMedia Encoders and

they are not local, choose the External Site Cache Location.

You can specify any network location accessible to the Jetty

services and all Media Encoder services configured for this

site.

This field appears in the Choose Site Location dialog box.

Local Site Cache Location

Path

The path where voice and screen recordings are stored. Click Browse

and navigate to the storage folder.

This field appears in the Choose Site Location dialog box.

Site Cache Location User-

name

Enter the username required to access the site cache location. This

user must meet these requirements:

n The site cache locationmust know the user (the user is a

trusted domain user).

n If the user is a domain user, the domain specifiedmust be

trusted by the site cache location. This means the site cache

location that you are configuring has to be on a domain that

trusts or is trusted by the domain you are entering.

n The user must be able to log on as a service.

n The user must have read and write access to both the site

cache drive location entered AND the location where Quality

Management is installed on the local server.

Note: The Jetty andMedia Encoder services must be running

as this user.

This field appears in the Choose Site Location dialog box.
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Field Description

Site Cache Location Pass-

word

Enter the password required to access the site cache location.

This field appears in the Choose Site Location dialog box.

Local Storage Location Choose this option to store the voice and screen recordings on the

Quality Management server.

External Storage Location Choose this option to store the voice and screen recordings on an

external server.

Note: If you change the storage location from local to external

storage in updatemode, youmust first uninstall the PROXY

ProGateway service on the server that hosts the Site Upload

Server (in the Control Panel’s Add or Remove Programs,

remove PROXY ProGateway). When you run the Set

Recording HomeDirectory tool, the PROXY ProGateway

service is reinstalled automatically. See “Entering

Configuration Data in UpdateMode” in the Installation Guide

for more information.

Storage Location Path The path where voice and screen recordings are stored. Click Browse

and navigate to the storage folder.

Note: The default path is C:\Program Files\Common

Files\QM\Recordings. If you need to change the path, do not

specify the root directory (for example, D:\ or E:\). Always

include at least one folder in the path (for example, D:\Cisco).

Browse Locate a folder.
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Field Description

Storage Location Username If you selected an external storage location, enter the username

required to access that location. If the user is a domain user, enter the

namewith the format <domain>\<username>.

For external screen storage and playback to work, youmust provide a

domain user that has read and write access to the local server and the

external storage system.

This user must meet these requirements:

n The local server must know the user (the user is a trusted

domain user).

n If the user is a domain user, the domain specifiedmust be

trusted by the local server. This means the Recording server

that you are configuring has to be on a domain that trusts or is

trusted by the domain you are entering.

n The user must be able to log on as a service.

n The user must have read and write access to both the external

drive location entered AND the location where Quality

Management is installed on the local server.

Storage Location Password If you selected an external storage location, enter the password

required to access that location.
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Field Description

Enable Two Stage Upload When selected, two stage upload is enabled. Two stage upload

immediately uploads screen and audio recordings to a temporary

storage location. You can then configure a workflow to upload files

from the temporary storage location to the permanent storage location

at the End of Day.

Two stage upload functions in one of twomanners:

1. If you are using Desktop Recording (or Gateway Recording),

the Desktop Recording service will round robin through all

Recording Servers associated with the site. This will happen

regardless of the location of the Recording Servers. If you are

using Desktop Recording and need to limit your uploads to a

local Recording Server, you will need to configure a site for

that location.

2. If you are using Server Recording, the Desktop Recording ser-

vice will round robin through Recording Servers that are in the

same cluster as the agents. All recordings will go to your local

Recording Cluster. If no configuration information is available

for your local Recording Cluster, no recordings will upload

from those agents.

Enable two stage upload when:

n Your contact center has multiple sites that are separated by a

WAN and you want to use the Immediate Upload feature but

you have limited bandwidth.

n You are using Desktop Recording and your contact center

requires the agents to shut down their desktop at the end of a

shift. Shutting down the desktop interrupts the scheduled

upload based on the agent's workflow. Two stage upload

ensures the recordings are immediately uploaded to the

temporary storage location after a call.

On startup, the Desktop Recording service retrieves all site

information, including all two stage upload locations. When a

call ends, recordings aremoved to a temporary storage location
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Field Description

and then uploaded to the permanent storage location. The files

aremoved in the following order: voice, screen, ini. If there are

no two stage upload locations, two stage uploads are turned

off.

Recordings are uploaded using the round-robin method to the available

storage locations.

Note: When two stage upload is enabled, it is possible that

voice and screen recordings for a call might be stored in

different storage locations.

When cleared, recordings are uploaded directly to the central storage

location. When the upload occurs is determined by the workflow

assigned to the agent.

This check box is only enabled when at least one Recording Cluster is

assigned to the site.

Configure Two Stage

Upload

Click this button if you want to configure a temporary storage

location. The Two Stage Upload Configuration dialog box will display

the Recording Servers associated with the Recording Clusters

assigned to the site. Click theModify button associated with the

selected server to configure the UNC path, username, or password to

that server.

This button is enabled when you select Enable Two Stage Upload and

at least one Recording Cluster is assigned to a site.

Two Stage Upload Con-

figuration Server

The IP address or hostname of the of the Recording server that hosts

the temporary storage location.

This field appears in the Two Stage Upload Configuration dialog box.
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Field Description

Two Stage Upload Con-

figuration UNC

The storage location path to the TwoStageLocation folder on the

Recording server where voice and screen recordings are temporarily

stored. The pathmust be in UNC format. The default path is as

follows:

\\<server>\TwoStageLocation

where <server> is the IP address or host name of the Recording

server that host the temporary storage location.

The TwoStageLocation folder is automatically created the first time

the Recording server is started. The default path is as follows on the

Recording server:

<temporary recording storage location>\TwoStageLocation

where <temporary recording storage location> is the path to the

temporary recording directory. See Set Temporary Recording

Directory for more information.

Important: The TwoStageLocation folder properties must be

shared using Advanced Sharing and a username and password

must be configured to access this folder. The user must be

allowed the following permissions: Full Control, Change, and

Read. Quality Management uses this path and the specified

user name and passwords to access the TwoStageLocation

folder.

This field appears in the Two Stage Upload Configuration dialog box.

Two Stage Upload Con-

figuration Username

Enter the username required to access the TwoStageLocation folder

on the Recording server .

This field appears in the Two Stage Upload Configuration dialog box.

Two Stage Upload Con-

figuration Password

Enter the password required to access the TwoStageLocation folder

on the Recording server .

This field appears in the Two Stage Upload Configuration dialog box.
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Field Description

Modify Click this button tomodify the fields in the selected row.

This button appears in the Two Stage Upload Configuration dialog

box.

Team A list of assigned teams.

Encoding Server A list of assigned Encoding Servers.

Recording Cluster A list of assigned Recording Clusters

Edit Modify the assigned teams, Encoding Servers, or Recording Clusters.

Configuration Settings Used By Services

If you change the settings on the Site Settingswindow, the following table showswhen your
changes take effect.

Service Configuration settings applied when...

Upload Controller service The next End of Day applies the configuration settings. If you want the

changes to take effect immediately, restart the Upload Controller

service.

DB Cleaner service The next cleanup time applies the configuration settings. If you want

the changes to take effect immediately, restart the DB Cleaner

service.

Media webapp (Jetty

service)

Restart the Jetty service.

Network Recording service If two stage upload is enabled and youmove a Recording Cluster from

one site to a different site, youmust restart the Network Recording ser-

vice for that Recording Cluster for the changes to take effect.

When services start using the changed configuration settings
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Site Considerations

If you plan to usemultiple recording storage locations, you can associate each recording
storage location to a site.

When configuring sites, consider the following:

n A site is a single Site Upload server associated with a set of teams. A site can be
configured to be the system’s default site. The default site is used for teams that have not
been associated with a site or whenever a recording service cannot find a site for a
recording (this can happen in rare circumstances).

n You can configure one or more sites for a QualityManagement system and define the
teams that are assigned to each site.

n When a site is taken down for maintenance or failure, the recordings created by the
agents while the site was downwill be uploaded when the site recovers.

n When upgrading from 9.0 8.8 or earlier, QualityManagement will create a single site and
assign the Site Upload server, Upload Controller service, and all defined teams to that
site. Peak and off-peak settingswill also bemoved to the site. OnceQuality
Management is installed, you can addmore sites.

n When an agent plays a recording from the Recordings application, the Recordings
application will play back the recording from the Site Upload server that is associated
with the agent’s team.

n For Desktop Recording, QualityManagement records the agent’s calls while the agent is
logged in to the desktop.When the agent logs out, the recordings are uploaded to the
Site Upload server that is associated with the agent’s team. It is possible to have two dif-
ferent agents using the same computer at different times and have their recordings
uploaded to different Site Upload servers.

The following figure shows three sites—two external sites that communicate with the rest of the
system over aWAN and one site that communicate over a LAN. Each site has a Site Upload
server with an Upload Controller and a Recording Cluster. Each site has one or more teams
assigned to it and the users in those teamswill upload to the proper site.
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Site recording storage location example: TheWeb Base server is located in the
United States (site 3) and a Site Upload server is located in Germany (site 1) and all the
German teams or groups are assigned to the German site. When aGerman agent
records a call, the recording is uploaded to the German site recording storage location in
Germany.When the agent plays back the recording, the recording is retrieved locally
and avoids wide area network (WAN) traffic.

The following figure shows two sites using two stage upload feature.
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Two stage upload example: Immediately after a call, Site A and Site B upload the
recordings to their Recording server that hosts the temporary storage location. At the
End of Day, the recordings are then uploaded to the permanent storage location.

Patches

When you install a patch on the server that includes patches for the desktop, the patch installs a
webpage called Patches.htm on the server. If the automatic update feature is disabled, you can
download the patch for the desktop from http://<Web Base server>/TUP/QM/Patches.htm.

Managing Site Settings

n To view the existing site configuration, click Site Settings.

The Site Settingswindow appears.

n To view a different site, click the tab associated with the site.
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New sites appear in Site settingswhen you install QualityManagement on the server
associated with the new site and configure the new site in the Site Settingswindow.

n To remove a site, click the tab for the site you want to remove, click Delete Selected Site,
click Yes in the ConfirmDelete dialog box, choose where you want to move recordings
from the deleted site, and then clickOK.

TheManuallyMove Recordings dialog box appears. You need tomanuallymove the
existing recordings from the server associated with the old site to the server associated
with the new site. The teams from the old site are now assigned to the new site and
future recordings for those teamswill now be stored on the server for the new site.

n Tomodify a site, select the site’s tab, complete the fields, and then click Save.

n To change the default site, select a site from the Default Site drop-down list, and then
click Save.

n Tomodify the current upload settings for a site, click the site’s tab, complete the fields
under PeakUploads, and then click Save.

n To change the recording storage location:

a. Complete the fields under Storage Location and then click Save.

b. Select Tools > Set Recording HomeDirectory to restart the services.

n To enable two stage upload:

a. Select Enable Two Stage Upload.

b. Click Configure Two Stage Upload.

c. ClickModify and complete the fields.

d. ClickOK.

n Tomodify the list of assigned teams, Encoding Servers, or Recording Clusters to a site,
select the site’s tab, click Edit under Team, Encoding Server, or Recording Cluster, and
choose one of the following options: select one or more teams, Encoding Servers, or
Recording Clusters from the Teams, Encoding Servers, or Recording Clusters list and
click the > button tomove the teams to the Assigned Teams or Assigned Recording
Clusters list. Tomove all teams or Recording Clusters to the Assigned Teams or
Assigned Recording Clusters list click the >> button, and then click Save.

l Add teams, Encoding Servers, or Recording Clusters. Click Edit under the option
that you want to modify, select one or more items from the available list and click
the > button tomove the selected items to the assigned list, or click the >> button
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to move all items to the assigned list, and then clickOK.

l Remove teams, Encoding Servers, or Recording Clusters. Click Edit under the
option that you want to modify, select one or more items from the assigned list and
click the < button tomove the selected items to the available list, or click the
<< button tomove all items to the available list, and then clickOK.

Web Server Redundancy

QualityManagement can be configured to work with a network load balancer to create
redundancy for the web services. Web server redundancy provides the ability to always have
access to the QualityManagement (QM) applications in UnifiedWorkforce Optimization
interface.

The basic concept is that two web base servers (Side A and Side B) are installed and
configured and the network load balancer routes data request to Side A. If Side A goes down,
the load balancer will route data requests to Side B.With web server redundancy, users can
always have access the UnifiedWorkforce Optimization interface.

Furthermore, to ensure playback is always available, Site Services alsomust be installed on
theWeb Base servers as described in the following image.
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Configuring Web Base Servers for Web Server Redundancy

To configure the Web Base servers for Web Server Redundancy:

1. Log in to a primaryWeb Base server

2. Start SystemConfiguration Setup (PostInstall.exe).

3. Select Tools > Configure High Availability.

4. Complete the fields and click Save.

5. Log in to the secondaryWeb Base server and repeat steps 2 through 4.
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Configuring the Operations Server

There are some services that are installed with theWeb Base Services that are not able to be
redundant at this time. These services need to be disabled on the redundantWeb Base
servers and installed on a separate Operations server.

The services that run on theOperations server are as follows:

n MANA Services [Base]

n Sync Services [Base]

n DB Cleaner Services [Database]

n Reconciliation Services [Reconciliation]

On theOperations server, you will need to disable the following services:

n DB Proxy

n Data API

n Jetty

Licensing for Web Server Redundancy

EachWeb Base server requires a Base Redundancy license to be installed.

Configuring Upload Site Servers for Web Server Redundancy

The Site Upload services are involved in playing back audio and video. Tomake the Site
Upload services redundant, the Site Upload services should be install coresident with the Base
software on Side A and Side B and configured tomirror each other. The storage location for
the audio and video should be on an independent storage area network (SAN) and accessible
by both Base servers. This configuration is not directly supported in the product today. SQL
updates are required. Contact Cisco Installation Services for assistance in this process.

Configuring Load Balancing Monitors

In order for the network load balancer to properly route requests, you need to configure the
network load balancer to monitor certain CRS processes. The following table lists the relevant
configuration settings.
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Load Balancing Monitor Configuration

DB Proxy n Type: TCP

n Destination IP: <IP address>

where <IP address> is a unique IP address for each Base

server.

n Port: 52103

n Heartbeat Interval: 750Milliseconds1

Data API  n Type: TCP

n Destination IP: <IP address>

where <IP address> is a unique IP address for each Base

server.

n Port: 59103

n Heartbeat Interval: 750Milliseconds

Jetty n Type: TCP

n Destination IP: <IP address>

where <IP address> is a unique IP address for each Base

server.

n Port: 80/443, xxx

n Heartbeat Interval: 750Milliseconds*

Media Encoder n Type: TCP

n Destination IP: <IP address>

where <IP address> is a unique IP address for each Base

server.

n Port: 59109

n Heartbeat Interval: 5000Milliseconds*

1All heartbeat values in this table are recommendedminimumheartbeat intervals. Choose
heartbeat values that are appropriate for your site.
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Load Balancing Monitor Configuration

Upload Controller n Type: TCP

n Destination IP: <IP address>

where <IP address> is a unique IP address for each Base

server.

n Port: 59100, 2303

n Heartbeat Interval: 750Milliseconds*

Configuring Quality Management to use the Network Load Balancer

The IOR_HOSTNAME registry setting needs to bemodified to point the network load
balancer.

To configure the network load balancer:

1. From a command line on the Base server, enter the regedit command.

2. From the Registry Editor, locate the Site Setup folder. The path to this folder is HKEY_
LOCAL_MACHINE > SOFTWARE > Cisco > QM> Site Setup.

3. Change the IOR HOSTNAME to the VIP of the network load balancer that clients use
to accessUnifiedWorkforce Optimization.

4. Restart the services for QualityManagement or reboot the server.

External Storage and Services

If you select External Storage Location in the Site Settingswindow in SystemConfiguration
Setup, youmust configure the Jetty service and the Screen PlaybackGateway (PROXY Pro
Gateway) service.

This stepmust be done after you install the QualityManagementWeb Base Services and
before you start recording contacts.

To enable external storage and services:

1. Create a username and password for the external storage user on the external storage
server.

2. Configure the Jetty service and PROXY Pro Gateway service for external storage.
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Configuring Services for External Storage

To configure services for external storage:

1. Select Start > Administrative Tools > Services.

The Serviceswindow appears.

2. Right-clickMonitoring and Recording Jetty service and choose Properties.

TheMonitoring and Recording Jetty Service Properties window appears.

3. Click the LogOn tab, choose This Account by providing the username and password
for the external storage server, complete the fields, and then click Apply.

If the provided information is correct, the followingmessage will appear:

The account .\<username> has been granted the Log On As A

Service right.

where <username> is the username you provided in the This Account field.

4. Repeat step 2 and step 3 for the PROXY Pro Gateway service.

Inclusion List

QualityManagement uses the Inclusion List window to determine which calls to record and
which calls to ignore. QualityManagement only records calls that match the extension patterns
in the Patterns to be Recorded list.
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A tab appears in the Inclusion List window for each configured telephony group. You can
configure extension patterns for inclusion or exclusion for each telephony group.

The Patterns to be Recorded list contains extension patterns that will be recorded. By default,
the Patterns to be Recorded list displays an asterisk (*) in the Pattern column, Extension in the
Type column, and Either in the Direction column. This indicates that all incoming and outgoing
calls on all extensions in the telephony group will be recorded. As soon as specific extension
patterns are configured in the Patterns to be Recorded list, recording is limited to those
extension patterns only.
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The Pattern column lists the extension pattern that will be filtered in the Patterns to be
Recorded or Patterns to be Excluded fromRecording lists. You can use the following wildcards
to configure ranges:

n The asterisk (*) in a string can represent any quantity of any character, as long as the
other characters in the stringmatch.

n The questionmark (?) in a string can be replaced by any character, but the length of the
stringmust be exactly as represented.

Extension patterns can be further filtered by selecting:

n The direction of the call (for recorded calls only). Your options are:

l Inbound—filters all inbound calls that match the extension pattern

l Outbound—filters all outbound calls that match the extension pattern

l Either—filters all inbound and outbound calls that match the extension pattern

SeeGatewayRecording Considerations and CiscoMediaSense Recording
Considerations for more information.

n The type of call. Your options are:

l Any—filters all called, calling, and extensions calls that match the extension pattern

l Called—fillers all calls received by the phone numbers that match the extension
pattern

l Calling—filters all callsmade by the phone numbers that match the extension
pattern

l Extension—filters all extensions that match the extension pattern

l Excluded—excludes all inbound or outbound calls that match the extension pat-
tern.

To rearrange the order of extension patterns that appear in the Patterns to be Recorded list,
select an extension pattern from the list and use the Up or Down arrow buttons tomove the
extension pattern to the desired location. Extension patterns are filtered starting at the top of
the list and continues down to the bottom of the list.

The Patterns to be Excluded fromRecording list displays extension patterns that will not be
recorded. Extension patterns that appear in the Patterns to be Excluded fromRecording list
are filtered before any extension patterns that appear in the Patterns to be Recorded list. Only
extension patterns found in the Patterns to be Recorded list will be recorded.

157



Configuring QualityManagement

You can also import or export an inclusion/exclusion list for a single telephony group. Changes
to the inclusion/exclusion list take effect the next time the CTI service polls for configuration
(fiveminutes at most). Importing or exporting a large inclusion/exclusion list is quick (Less than
five seconds). However, it might take up 30 seconds to save a large inclusion/exclusion list to
the database.

Any changes youmake to the Inclusion List take window take effect at the next recording client
login.

Field Description

Add Add an extension pattern.

Remove Remove an extension pattern.

Modify

Type

Change the call type associated with an extension pattern.

Modify

Direction

Change the direction associated with an extension pattern.

Import Allows you to select the location and name of an inclusion/exclusion file to import. The file

must be in CSV format (see CSV Format for more information). Importing an

inclusion/exclusion list overwrites the existing file. An import does not merge changes.

Note: If the CSV file has errors in it, the import will fail and the existing data will

remain unchanged. An error message will indicate why the import failed and

identify the record that failed if applicable.

After importing a CSV file, youmust click Save to save your changes.

Export Allows you to select the location and specify a name for the exported inclusion/exclusion

list. The file must be in CSV format. Once exported, you can open the file in Microsoft

Excel.

Inclusion List buttons

CSV Format

TheCSV file containing the inclusion/exclusion list must use the following format:

158



Configuring QualityManagement

Pattern Type Bounds

A number pattern with optional * and ? wild-

cards

One of the following

types:

n Extension

n Calling

n Called

n Any

One of the following

directions:

n Inbound

n Outbound

n Either

n Excluded

When creating an inclusion/exclusion list, remember the following points:

n Exclusions arematched before inclusions, but exclusions can appear anywhere in the
CSV.

n Within each group (inclusions and exclusions), patterns arematched starting from the
top and working down the list.

n Additional columns after Pattern, Type, and Bounds are allowed in an imported CSV.
However, the additional columnswill be ignored.

Gateway Recording Considerations

The considerations in this topic apply to the followingGatewayRecordingmethod:

n Cisco CUBE Recording via SIP Recording

When the call direction cannot be determined, the Inclusion List will onlymatch a Direction with
a value of Either. All calls, both inbound and outbound, appears as inbound. Cisco
recommends setting the value of the Direction to Either when creating an exclusion for a
GatewayRecordingmethod.

Cisco MediaSense Recording Considerations

If you are using CiscoMediaSense Recording, the Inclusion List affects which recordings are
uploaded to QualityManagement. Initial recording decisions are based on the Cisco
MediaSense configuration.

When configuring the Inclusion List for CiscoMediaSense Recording, consider the following:
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n The entire call is recorded and saved on the CiscoMediaSense Recording cluster.

n QualityManagement only downloadsCiscoMediaSense recordings that appears in the
Patterns to be Recorded list.

n QualityManagement does not download CiscoMediaSense recordings that appear in
the Patterns to be Excluded fromRecording list.

n When the call direction cannot be determined, the Inclusion List will onlymatch a Dir-
ection with a value of Either. Cisco recommends setting the value of the Direction to
Either when creating an exclusion for CiscoMediaSense Recording.

Managing Extension Patterns

To manage extension patterns:

1. Select the appropriate telephony group cluster tab in the Inclusion List window.

2. Choose one of the following options:

l Add an extension pattern. Click Add beneath the Patterns to be Recorded or
Extensions to be Excluded, type a number in the Add Pattern dialog box, click
OK, and then complete the remaining fields in the table.

You can enter the exact number or use the * or ? wildcards plus numbers to
configure a range of numbers. For example:

Enter This: To Record:

6124 Number 6124.

61* Any number that start with 61 and are of any length.

EXAMPLE: 6124, 61555, 613

61?? Any number that start with 61 and are 4 digits long.

EXAMPLE: 6124, 6125, 6126

l Modify a call type. Select an extension pattern, clickModify Type, select the dif-
ferent type from the drop-down list, and then clickOK.
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l Modify a call direction. Select an extension pattern, clickModify Direction, select
a different direction from the drop-down list, and then clickOK.

l Remove an extension pattern. Select the extension pattern in Patterns to be
Recorded or Extensions to be Excluded, click Remove, and then clickOK.

l Import an inclusion/exclusion list. Click Import, select the location, the file name
of the inclusion/exclusion list, clickOK, and then click Save.

l Export an inclusion/exclusion list. Click Export, select the location, type the file
name of the inclusion/exclusion list, and then clickOK.

3. Click Save.

Excluding Extension Patterns

If you have a limited number of extension patterns you want to exclude from being recorded,
you can configure the Inclusion List to ignore only those extension patterns and record all
others.

Example: If you want to record all extension patterns except for extensions 3411, 3412,
and 3413, configure your inclusion list so that there is an asterisk in the Patterns To Be
Recorded list, and extensions 3411, 3412, and 3413 listed in the Patterns To Be
Excluded FromRecording list. 

Extension patterns listed in the Patterns To Be Excluded FromRecording list always take
precedence over extension patterns listed in the Patterns To BeRecorded section. You cannot
use the same extension pattern (specifically or through the use of wildcards) in both lists.

Example: 12* cannot appear in both lists.

Monitoring and Notification

Use theMonitoring and Notification window to enable theMonitoring and Notification (MANA)
service.

The following image displays theMonitoring and Notification window for Unified CCX.
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Only one notification trigger requires configuration: Problem ID QM3002 under QMTask
Settings. This trigger compares data in the Unified CM’s Call Detailed Records (CDR) Report
(for Unified CM versions 8.x and 9.x) with the QualityManagement database. Specifically, it
compares the call records in the Unified CMwith the call records in QualityManagement. If
there is a discrepancy, notification is sent.

Note: TheMANA CDR Report (QM3002 notification trigger) does not support devices
that are recorded byCiscoMediaSense. If your site is amixed-recording environment
where Server Recording, Network Recording, or Desktop Recording and Cisco
MediaSense Recording are used together, the CDR Report will not be accurate since
CiscoMediaSense devices result in false positives.

By default, Problem ID QM3002 is disabled. The notification trigger does not have to be
configured unless you enable that problem ID in the Notification Distribution dialog box.

You can createmultiple distribution lists. For each distribution list, you can choose to specify
the events that trigger notification.

Example: You can set up a distribution list for global outages (all QM1000 level errors)
and all “JTAPI not associated with a device” (specific QM2002 error).
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You can also configure the following information:

n Distribution list of persons receiving notification, if you configure email as ameans of
notification

n Email address of the person(s) receiving notification, if you configure email as themeans
of notification

n Trap destinations receiving notification, if you configure SNMP as themeans of
notification

n If and how often a renotification of the problem should be sent out

n Types of problems that will trigger notification

Note: You can only change the information in theMonitoring and Notification window
from the SystemConfiguration Setup (PostInstall.exe) or QualityManagement
Administrator on theWeb Base server. TheMonitoring and Notification window in
QualityManagement Administrator on a desktop is read-only.

Connection information is saved locally to theWeb Base server so the emergency user can still
be notified using email if a major component (for example, the database) is down, and the other
email addresses are not available. This allows theQualityManagement Administrator to edit
the emails and allowsMonitoring and Notification to notify one user when the configuration is
not accessible.

Field or

Button
Description

Use

Monitoring/

Notification

Service

Select this check box to enable theMANA service. If enabled, at least one notification

method (event viewer, SNMP, or email) must be enabled as well. This check box is

selected by default.

Distribution

List

The available distribution lists.

Add Add a distribution list.

Remove Remove a distribution list.

Edit Edit the selected distribution list.

Monitoring and Notification fields and buttons
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Field or

Button
Description

Polling

Period

Sets the interval at which theMANA service checks for the selected notification

triggers. Default = 10minutes, Minimum = 0minutes, Maximum = 1440minutes (1

day). The timer starts when the last polling task is complete.

Note: When you change the polling period, it takes one polling cycle before the

new polling period goes into effect.

Never Choose this option if you do not want to be renotified of a problem after the initial

notification.

Every N

Polling

Periods

Choose this option if you want to specify how frequently you want renotification to

occur after the initial notification and specify the number of polling periods. For

example, if you choose to be notified every 3 polling periods, you receive the initial

notification on the first polling period the problem is detected, no notification the next

two polling periods, and then another notification on the next polling period. This pattern

will continue as long as the problem is detected.

Every

Polling

Period

Choose this option if you want renotification to occur every polling period after the initial

notification.

QM Task

Settings

The fields listed in the QM Task Settings section are used to configure QM3002.

Miss

Threshold

Percentage of missed CDRs required to trigger notification.

Minimum

Misses

Lowest number of missed CDRs required to trigger notification.

Notify on

users

configured

in QM

When you select this option, Quality Management only generates notifications about

users who are configured in Quality Management.
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Field or

Button
Description

Notify on

users that

are logged

in

When you select this option, Quality Management only generates notifications about

users who are currently logged in to a desktop where the Desktop Recording service is

installed. This only applies to the Desktop Recording service.

Display

Type

Choose one of the following options.

n Summary Only—displays 1 row per agent with missed CDR that meet the above

criteria. See Summary Only for an example.

n Details (Tab Delimited)—displays eachmissed CDR in tab delimited format. See

Detail (Tab Delimited) for an example.

n Details (Plain Text)—displays eachmissed CDR in text format. See Detail (Plain

Text) for an example.

Configuration Settings Used By Services

If you change the settings on theMonitoring and Notification window, the following table shows
when your changes take effect.

Service Configuration settings applied when...

MANA service The next polling period applies the configuration settings.

When services start using the changed configuration settings

Notification Distribution

TheNotification Distribution dialog box allows you to create a distribution list, specify the
notification type for the distribution list, and assign the type of MANAmessages that are sent to
the distributions list.

The following image displays the Notification window for Unified CCX.
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TheMANAmessages are classified as follows:

n QM1xxx—indicates a global outage that might affect recording for the entire system.

n QM2xxx—indicates individual outages that might affect recording for individual users.

n QM3xxx—indicates a possible configuration problem. The notificationsmight not point to
an actual issue, so youmight want to turn these notifications off to avoid unnecessary
notifications.

n QM4xxx—indicates a problemwithMANA that prevents it from reporting problems.

Field Description

Distribution

List Name

The name of the distribution list.

Notification Distribution fields
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Field Description

Notification

Type

The type of notification you want to use to send notificationmessages. Your options

are:

n Event Viewer—use the Event Viewer for displaying notificationmessages

n Email—use email for sending notificationmessages

n SNMP—use SNMP for sending notificationmessages

Email

Addresses

The list of email addresses to which notification is sent. Maximum = 5 email addresses.

A comma is required to separate two or more email addresses.

Example: jane.doe@acme.com, john.smith@acme.com,

robert.dee@acme.com

Note: This field is enabled when you select Email as your notification type.

Available

Problems

The list of problems that will not trigger notification. Move any problem that does not

require notification to the Available Problems list. QM3002 appears in this list by

default.

Enabled

Problems

The list of problems that will trigger notification. By default, all problems are enabled,

except for QM3002. Youmust configure QM3002 under QM Task Settings in the

Monitoring and Notification window before you can enable this Call Detail Record

(CDR) task.

Note: QM3002 is not supported with CiscoMediaSense Recording.

Managing Notification Distribution Lists

To manage notification email addresses:

n To add a distribution list, perform the following steps.

l Click Add in the Notification Distribution section.

l Type the name of the distribution list in the Distribution List Name field.
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l Type the email addresses that are included in the distribution list in the Email
Addresses field.

l Move the type of problems you want sent to this distribution list to the Enabled
Problems list.

l ClickOK.

The new distribution list appears in the Distribution List.

n To remove a notification distribution list, select the distribution list from the Distribution
List, click Remove, and then clickOK.

The distribution list is removed from the Distribution List.

n To edit a notification distribution list, select the distribution list from the Distribution List,
and click Edit. In the Notification Distribution dialog box, modify the distribution list that
you want to change, and then clickOK.

Installation Complete

Start Services

Click Yes to start services.

The program starts the services for QualityManagement. When finished, the Services Started
Successfully confirmation box appears.

Services Started Successfully

ClickOK to dismiss the confirmation box.

Status

The Statuswindow reports the version of the installed QualityManagement components and
displays the status of the signaling servers by telephony group. Click refresh to see the latest
signaling server information.
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Configuration Settings Used By Services

If you change the product version, the following table showswhen your changes take effect.

Service Configuration settings applied when...

Upload Controller service Periodically check for a versionmismatch.

When services start using the changed configuration settings

Manually Installing the Cisco JTAPI Client

Follow the instructions in this task only if the SystemConfiguration Setup did not automatically
install the Cisco JTAPI Client in the Cisco environment.

Note: This task is not required if you are configuring QualityManagement for Cisco
MediaSense Recording.

To manually install the Cisco JTAPI Client:

1. Stop the Recording CTI service or CUBE SIP CTI service.

2. Download the Cisco JTAPI Client from the Unified CMPlug-ins webpage.

3. Install the Cisco JTAPI Client on theQualityManagement server where the Recording
CTI service or CUBE SIP CTI service is installed.

4. Copy the jtapi.jar file from the C:\WINDOWS\ java\lib folder to the C:\Program
Files\Cisco\WFO_QM\ext folder.

If you are not using the default path to the java\lib folder specified in step 4, copy the
jtapi.jar file to correct folder.

5. Start the Recording CTI service or CUBE SIP CTI service.

6. Start SystemConfiguration Setup from the executable PostInstall.exe in C:\Program
Files\Cisco\WFO_QM\bin.

7. Choose Tools > Test CTI Service.

The CTI Service Ready dialog box appears and displays the followingmessage:

The CTI Service test completed successfully.
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8. ClickOK to dismiss the dialog box and close the SystemConfiguration Setup window.

Rules for Upgrading or Modifying the ACD Database
in Update Mode

Observe the following rules when you change access to the Unified CCX Administration
database in updatemode:

n Do not change the location of the Unified CCX Administration database after initial
setup. If you do, youmight be unable to accessQualityManagement historical data if the
structure and contents of the new database is not the same as that of the old database.

n Stop the Sync Service and disable this service on startup to protect the Quality
Management database before you upgrade or rebuild the Unified CCX Administration
database.

Stopping the Sync Service Before Upgrading the ACD Database

Perform this task before you upgrade the Unified CCX Administration database.

To stop the Sync service:

1. Select Start> Administrative Tools > Services. The Serviceswindow appears.

2. Right-clickMonitoring and Recording Sync Service and choose Stop.

3. Right-clickMonitoring and Recording Sync Service again and choose Properties.

TheMonitoring and Recording Sync Service Properties window appears.

4. Choose Disabled from the Startup Type drop-down list, and clickOK to save your
changes.

5. Upgrade or rebuild the Unified CCX Administration database.

6. Return to the Serviceswindow, right-clickMonitoring and Recording Sync Service and
choose Start.

7. Right-clickMonitoring and Recording Sync Service again, choose Automatic from the
Startup Type drop-down list, and then clickOK to save your changes.

This action enables the Sync Service on startup.
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Note: Do not start Sync Service and enable the Sync Service for the hardware
profile until both Unified CCX Administration databases (if using High
Availability) are running and synchronized because the Sync Service reads data
from the Unified CCX Administration database. Failing to do so could potentially
deactivate users if there is a problemwith the Unified CCX Administration
upgrade or rebuild.

8. Verify the teams and agents in the upgraded Unified CCX Administration appear cor-
rectly.

Changing the Web Base Server

To change the IP address or host name for the Web Base server:

1. From the SystemConfiguration Setup tool, choose File > Choose Base Server.

The SystemConfiguration Setup dialog box appears window appears.

2. Choose the network address type. Your options are:

l IP Address—the IP address of the base server.

l Host Name—the FQDN or hostname of the base server.

3. Enter the IP address or hostname of base server.

The base server is the computer where you installed theWeb Base Services,
Database Services, Voice/Screen Services, and signaling service.

4. Enter the IP address or hostname of the UnifiedWorkforce Optimization Container.

The UnifiedWorkforce Optimization Container is located on the base server.

If you also purchasedWorkforceManagement (WFM), and configured it to point to the
container, it will share the container with QualityManagement.
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5. Choose one of the following options:

l If you are running SystemConfiguration Setup on the base server, choose the IP
address or hostname of the base server from the Local Services drop-down list,
and then clickOK.

l If you are running SystemConfiguration Setup on a different server, choose the
IP address or hostname for the server from the Local Services drop-down list,
and then clickOK.

Example: If you want to run Network Recording on a different server and
installed the Network Recording service andMonitor service on that server,
choose the IP address for the Network Recording server from the IP Address for
Local Services drop-down list. If the computer hasmultiple NICs, multiple
addresses appear in the IP Address for Local Services drop-down list. Choose
the IP address used for network traffic.

Changing Configuration Data in Update Mode

To change the configuration data in update mode:

1. Start SystemConfiguration Setup by running the PostInstall.exe.

This executable is located in the C:\ProgramFiles\Cisco\WFO_QM\bin folder.

2. Select the window you want to modify from the left pane, enter the new data in the right
pane, and then click Save on the toolbar or File > Save from themenu bar.
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l You can display the windows in any order you wish.

l If youmodify something in a window, youmust click Save to save your changes
before youmove on to another window.

l If youmake a change to a window but need to change back to the original
setting, click the Revert to Saved button on the toolbar. This discards any
changes youmade that have not been saved, and restores the settings in the
window to the last saved version.

3. When you finish, choose File > Exit or click Close.

SystemConfiguration Setup closes.

4. Stop and restart themodified service and all desktops for the change to go into effect.
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QualityManagement supports HTTPS using a self-signed certificate. The self-signed
certificate is sufficient to encrypt the communication path between theQualityManagement
server and the client browsers, however it has the following limitations:

n Agents see a certificate error or security alert the first time they accessUnifiedWork-
force Optimization.

n User security is not complete. Users are vulnerable to aman-in-the-middle attack (an act-
ive form of eavesdropping where private communication is controlled by a hacker).

n Errors appear when using HTTPS if you useWFO Finesse gadgets.

You can update the certificate so that users are not required to accept self-signed certificates.
This prevents the possibility of man-in-the-middle attacks.

Important: For a deployment that includesmultiple UnifiedWorkforce Optimization
products, if every user connects to UnifiedWorkforce Optimization on theQuality
Management base server, then you only need to update the certificate on that base
server. Follow the instructions in this section only if CAS is not connected to the Quality
Management base server and you want to use an HTTPS URL and a self-signed
certificate to accessUnifiedWorkforce Optimization.

Requirements

Follow these steps to update the QualityManagement signed certificate. In order to perform
this procedure, you will need the following:

n keytool.exe, located in the Cisco\WFO_QM\Java bin directory

Example: C:\Program Files\Cisco\WFO_
QM\Java\bin\keytool.exe

n A Certificate Authority (CA) from a commercial service, like Symantec VeriSign or
GoDaddy, or a local CA likeMicrosoft Active Directory Certificate Services (AD CS).
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Updating the Quality Management Signed Certificate

To update the Quality Management Signed Certificate:

Important: You can skip this task if you installing or upgrading fromQualityManagement
9.2 SR2 10.5 or later. The certificates for QualityManagement 10.0 or earlier improperly
identify the country code asUSA instead of US. You need to delete this certificate and
regenerate it with the correct US country code.

1. Log in to the QualityManagement base server with administrator rights.

Note: You can use Remote Desktop Protocol (RDP) to access the base server
from your desktop.

2. From the command line (cmd.exe), enter the following command to delete the existing
certificate:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Common Files\QM\config\.keystore"

-storepass C@labr1o -delete -alias jetty

3. Enter the following command to create the correct certificate. In the example below, the
command uses SHA2 encryption (there aremultiple commands for creating the correct
certificate; your commandmay vary).

Note: Replace <IP Address> in the following commandwith the IP address of
the base server before you enter the command.

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Common Files\QM\config\.keystore"

-storepass C@labr1o -selfcert -genkey -keyalg RSA -alias

jetty -keysize 1024 -dname "C=US, S=MN, L=Minneapolis,

O=Cisco Inc, OU=Quality Management, CN=<IP Address>" -sigalg

sha256WithRSA -validity 1000000 -v
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Example: "C:\Program Files\Cisco\WFO_
QM\Java\bin\keytool.exe" -keystore "C:\Program

Files\Common Files\QM\config\.keystore" -storepass

C@labr1o -selfcert -genkey -keyalg RSA -alias jetty -

keysize 1024 -dname "C=US, S=MN, L=Minneapolis, O=Cisco

Inc, OU=Quality Management, CN=198.51.100.23" -sigalg

sha256WithRSA -validity 1000000 -v

4. Press the Enter keywhen the Enter key password for <jetty> prompt appears.

5. Restart the Jetty service on the base server fromStart > Control Panel > System and
Security > Administrative Tools > Services.

6. Verify the certificate works by entering the following URL in your browser:

https://<base server>

where < base server> is the host name or IP address of the server that hosts the
UnifiedWorkforce Optimization Container.

A security warning will appear but you should still be able to log in to UnifiedWorkforce
Optimization with a valid username and password.

Creating a Certificate Signing Request (CSR) for the
Web Base Server

To create a Certificate Signing Request (CSR) for the Web Base server:

1. From the command line on the base server, enter one of the following commands:

n If the users will accessUnifiedWorkforce Optimization using an IP address, use:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Common

Files\QM\config\.keystore" -storepass C@labr1o -certreq

-alias jetty -file jetty.csr

This command generate a CSR for QualityManagement.

n If the users will accessUnifiedWorkforce Optimization using one or more
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domain names, use:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Common

Files\QM\config\.keystore" -storepass C@labr1o -certreq

-alias jetty -file jetty.csr -ext

san=dns:<myDomain>,dns:<yourDomain>

For information on using IP addresses in this instance, see Using an IP address
for a SAN in Internet Explorer.

Note: If you want to includemultiple domains, use a comma to separate
each domain.

This command uses the keytool -ext option to specifymultiple domain names.

Example: "C:\Program Files\Cisco\WFO_
QM\Java\bin\keytool.exe" -keystore "C:\Program

Files\Common Files\QM\config\.keystore" -storepass

C@labr1o -certreq -alias jetty -file jetty.csr -ext

san=dns:qmcert.pdi.ld,dns:qmcert2.pdi.ld

The jetty.csr resides in the following location:

C:\Users\<username>

where <username> is the login name for the user with administrator rights.

IP Address Limitations for SANs in Internet Explorer

Once you specify an IP address or host name as a Subject Alternative Name (SAN), you lose
the ability to connect to QualityManagement by using that IP address or host name in Internet
Explorer. Theoretically, you could specify an IP address or host name as a SAN using the
following format:

san=dns:<myDomain>,ip:<IP address>

Example: san=dns:mydomain.com,ip:192.0.2.0

178



Managing Certificates

However, Internet Explorer does not recognize IP addresses or host names and will display a
security error indicating a certificatemismatch.

Note: This format doeswork in Chrome.

To work around this limitation, you can specify the IP address or host name as a Domain Name
System (DNS) name using AD CS. See Certificates and Active Directory for more information.

Note: You cannot use keytool.exe to configure the IP address or host name as a DNS.
Most CAs do not allow this. Only AD CS allows your to specify an IP address or host
name as a DNS.

Certificates and Commercial Services

You can generate signedQualityManagement certificates using commercial services such as
VeriSign, Thawte, or GoDaddy.

The following topics describe how handle certificates from commercial services:

n Generating Certificates Using Commercial Services

n Expired Certificate from aCommercial Service

Generating Certificates Using Commercial Services

Step 1: Submit the CSR to your Certificate Authority.

The procedure for obtaining a signedQualityManagement certificate varies by vendor. Consult
your chosen vendor's website for instructions for requesting a signed certificate.

Note: Your CA will return to you a signedQualityManagement certificate, and possibly
one or more intermediate certificates.

See Expired Certificate from aCommercial Service for additional information.

Step 2: Import the root certificate from the Certificate Authority into the Quality
Management keystore.
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Import the CA root and any intermediate certificates into the keystore. These certificates can
be acquired from the CA used to generate the signedQualityManagement certificate.

Note that youmight not need these certificates if they are already part of the Java cacerts store
like VeriSign or Thawte. Lesser knownCAs like GoDaddy, or an internal AD CS, will need to
be installed on the base server and also on the client web browser.

1. Log in to the QualityManagement base server with administrator rights.

Note: You can use Remote Desktop Protocol (RDP) to access the base server
from your desktop.

2. From the command line on the base server, enter the following command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Cisco\WFO_

QM\Java\lib\security\cacerts" -storepass changeit -list -v

This command lists the existing CA certificates that comes bundled with QM Java.

Note: If your CA appears in this list, you do not need to install it.

3. If your root certificate is not already installed, enter the following command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Common Files\QM\config\.keystore"

-storepass C@labr1o -importcert -trustcacerts -alias <CA

name> -file <CA name>.cer

where <CA name> is the name of the certificate.

Important: Always import the root certificate first.

4. Click Yeswhen the when the following prompt appears:

Trust this certificate?

This prompt appears because the certificate is self-signed (that is, the certificate is
issuer of the certificate is also the owner) and the keytool cannot follow the chain back
to a trusted root CA.

Step 3: Import intermediate certificates into the Quality Management keystore.
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Note: You can skip this step if the QualityManagement certificate was signed by the root
CA. If the QualityManagement certificate was signed by an intermediate CA, then all
intermediate certificates in the chain back to the root certificatemust be imported.

From the command line on the base server, enter the following command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -keystore

"C:\Program Files\Common Files\QM\config\.keystore" -storepass

C@labr1o -importcert -trustcacerts -alias <CA name> -file <CA

name>.cer

where <CA name> is the name of the certificate.

This command imports the intermediate certificates into the QualityManagement keystore.

Step 4: Import the signed Quality Management certificate.

From the command line on the base server, enter the following command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -keystore

"C:\Program Files\Common Files\QM\config\.keystore" -storepass

C@labr1o -importcert -alias jetty -file jetty.cer

This command imports the signed certificate into the QualityManagement keystore.

Step 5: Restart the Jetty service.

On theQualityManagement base server, use theWindowsServices utility in the Control Panel
to restart the Jetty service.

Step 6: Import root and intermediate certificates into the client web browsers.

This step is not necessary in the following situations:

n TheQualityManagement certificate was signed by a well-knownCA such as VeriSign,
or Thawte. Most modern browsers comewith themajor commercial CA root certificates
already installed. Lesser knownCAsmight not be installed.

n You are using Internet Explorer and an Active Directory CA where theQuality
Management base server and clients are all in the same Active Directory domain

To determine if you need to perform this step, start the client web browser and try to access
UnifiedWorkforce Optimization using the following URL:
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https://<base

server>/cwfo/apps/login.html?userLang=en&userTheme=

cisco&userCountry=

where <base server> is the host name or IP address of the server of the QualityManagement
base server.

n If you can connect without errors or requests to install certificates, you do not have to per-
form this step.

n If you see amessage indicating that the issuer of the certificate is not trusted, you need
to perform this step.

Best Practices: Chrome providesmore descriptive error messageswhen updating
certificates. Use Chrome to troubleshoot certificate errors.

For more information about installing root and intermediate certificates on the desktop, see
Installing Root and Intermediate Certificates on Desktops.

Expired Certificate from a Commercial Service

Your CA will assign an expiration date to the QualityManagement certificate. When theQuality
Management certificate expires you will need to create a new CSR and import it to replace the
expired CSR. To replace an expired QualityManagement certificate:

1. Creating a Certificate Signing Request (CSR) for theWeb Base Server.

2. Generating Certificates Using Commercial Services.

To view the expiration date, double-click the QualityManagement certificate or after the Quality
Management is installed use the keytool -list command.

Certificates and Active Directory

You can generate signedQualityManagement certificates using Active Directory Certificate
Server (AD CS). AD CS is a CA.

When generating Active Directory certificates, remember the following points:

n The AD CS for the root domain generates its own self-signed certificate. The issuer and
owner are the same. AD CS also signs the certificate for the intermediate certificate.
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n A self-signed certificate is generated byQualityManagement when it is installed. When
a web browser encounters this certificate, it views the certificate as a security violation
and generates an error.

n The intermediate AD CS signs the certificate for the QualityManagement base server
and replaces the base server IP addresswith its own domain name in the Issuer field.

n When all the certificates are signed, each certificate is linked to the previous certificate,
with the final or root certificate included in the web browser's trusted root certificate
store. This is known as a certificate chain. In this scenario, the web browser does not
generate certificate errors.

n Root and intermediate certificatesmust be installed on both the QualityManagement
base server and the web browser on each client machine.

Verifying the AD CS Supports the SAN Certificate Feature

By default, the AD CS server does not allow the ability to add SAN attribute to certificates. You
need to enable this feature on you AD CS server.

AD CS has policymodules that provide different services. The policymodules provide different
types of extensions that can be enabled so clients can submit their requests for those features.

The CertificateAuthority_MicrosoftDefault.Policy is the default policymodule on aWindows
2003 Certificate server. By default, it does not allow the ability to add SAN attributes to
certificates.

Use the Certificate Database Tool to check the values of the Certificate Services registry keys
and enable the SAN attribute:

1. From the command line on theWindows 2003 or 2008 Certificate server, go to the
C:\Program Files\Support Tools directory and enter the following command:

certutil -getreg policy\EditFlags

The command lists the Certificate Services registry keys.
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2. Verify that EDITF_ATTRIBUTESUBJECTALTNAME2EditFlag is enabled.

3. If the EditFlag is not enabled, enter the following command:

certutil -setreg policy\EditFlags +EDITF_

ATTRIBUTESUBJECTALTNAME2

4. On aWindows 2008 Certificate server only, you need to enter these additional
commands:

certutil –setreg policy\SubjectAltName enabled

certutil –setreg policy\SubjectAltName2 enabled

net stop certsvc

net start certsvc

For more information, go to the following topics onMicrosoft website:

n PolicyModules: http://msdn.microsoft.com/en-us/lib-
rary/aa387348%28v=vs.85%29.aspx.

n SAN certificate feature: http://techontip.wordpress.com/2011/06/06/how-to-make-sure-
internal-certificate-authority-is-supporting-san-certificate-feature/

Generating Certificates Using Active Directory

Follow these steps to generate certificates using Active Directory Certificate Services
(AD CS).

Step 1: Create a root CA signed certificate from AD CS.
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1. Log in to the Active Directory server for the root AD CS.

Note: You can use Remote Desktop Protocol (RDP) to access the AD CS from
your desktop.

2. From Internet Explorer on the Active Directory server, enter the following URL:

http://<myRoot>/certsrv

where <myRoot> is the root domain's IP address or hosts name. The AD CS for this
domain is the root for this network.

Example: http://192.0.2.8/certsrv

3. Click Download a CA Certificate, Certificate Chain, or CRL.

4. Select Base 64 encoded.

Note: QualityManagement can only import Distinguished Base-64 encoded
X.509 formatted certificates. These certificates have the following extension:
CER.

5. Click Download the CA certificate and specify a descriptive name for the root
certificate.

Example: 192.0.2.8_root_x509.cer

SeeMicrosoft Knowledge Base 555252 and Expired Certificate fromAD CS for
additional information.

Step 2: Download the intermediate certificates.

Note: You can skip this step if there are no intermediate certificates.

Perform this procedure for each intermediate certificate.

1. Log in to the Active Directory server for the intermediate AD CS.

2. From Internet Explorer on the Active Directory server, enter the following URL:

http://<myIntermediate>/certsrv
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where <myIntermediate> is the intermediate domain's IP address or hosts name. The
AD CS for this domain where theQualityManagement base server.

Example: http://192.0.2.21/certsrv

3. Click Download CA certificate, certificate chain, or CRL.

4. Click Download CA certificate and specify a descriptive name for the intermediate
certificate.

Example: 192.0.2.21_intermediate-cert_x509.cer

Step 3: Use the CSR to create a signed Quality Management certificate.

Note: This step requires that the EDITF_ATTRIBUTESUBJECTALTNAME2EditFlag
is enabled in the Certificate Services registry. See Verifying the AD CS Supports the
SAN Certificate Feature for instructions.

1. Log in to the Active Directory server for the intermediate AD CS.

2. From Internet Explorer on the Active Directory server, enter the following URL:

http://<myIntermediate>/certsrv/

where <myIntermediate> is the intermediate domain IP address or host name. This is
the domain where theQualityManagement base server resides.

Example: http://192.0.2.8/certsrv

3. Click Request a Certificate.

Note: On someCA servers youmight get an additional page where youmust
click Advanced Certificate Request.

4. Click Submit a certificate request by using a base-64-encoded CMC or PKCS #10 file,
or submit a renewal request by using a base-64-encoded PKCS #7 File.

5. Open the CSR file that you created in Step 1 and copy the entire contents of the file into
the Saved Request field, including the following lines:
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----BEGIN NEW CERTIFICATE REQUEST----

----END NEW CERTIFICATE REQUEST

6. Select Web Server in the Certificate Template field.

7. To access theQualityManagement base server using an host name or IP address,
type the host name or IP address as a Subject Alternative Name (SAN) in the
Attributes field. The format is as follows:

SAN:DNS=<myDomain or IP address>

where <myDomain or IP address> is the host name or IP address.

Note: If you want to more than one host name or IP address, use an ampersand
to separate each host name or IP address.

Important: Once you specify a host name as a SAN DNS attribute, you will lose
the ability to connect to the QualityManagement base server using an IP
address. If you try connecting to the QualityManagement base server using an
IP address, you will a security error indicating a certificatemismatch. If you want
to continue connecting to QualityManagement base server using an IP address
in Internet Explorer, you need to also add the IP address as a SAN DNS
attribute to the Attributes field.

Example: SAN:DNS=my.domain.com&DNS=192.0.2.0

8. Click Submit.

9. Select Base 64 encoded and click Download certificate.

Note: QualityManagement can only import Base-64 encoded X.509 formatted
certificates. These certificates have the following extension: CER.

10. When prompted, provide a descriptive file name for the certificate.

Example: jetty.csr

11. Click Save As and specify where the file will be located.
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12. Go to the location of the certificate and double-click the certificate file.

13. Select Certification Path tab, and verify the certification path is correct. It should include
the IP address of the QualityManagement base server and the chain of certificates
back to the root CA (see graphic).

If the certification path is not correct, download the root and intermediate certificates
again from the correct AD CS domains.

If you added SAN attributes, click the Details tab and verify the SAN attributes are
correct.

Note: The AD CS will fail silently if the SAN attributes are not configured
properly.

See Expired Certificate fromAD CS for additional information.

Step 4: Import the root certificate into the Quality Management keystore.

1. Log in to the QualityManagement base server with administrator rights.

Note: You can use Remote Desktop Protocol (RDP) to access the base server
from your desktop.

2. From the command line on the base server, enter the following command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Cisco\WFO_

QM\Java\lib\security\cacerts" -storepass changeit -list -v

This command lists the existing CA root certificates that comes bundled with QM Java.
If your CA appears in this list, you do not have to proceed. If it is not in the list, continue
to the next step.
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3. Enter the following command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -

keystore "C:\Program Files\Common Files\QM\config\.keystore"

-storepass C@labr1o -importcert -trustcacerts -alias <CA

name> -file <CA name>.cer

where <CA name> is the certificate file name.

Important: Always import the root certificate first.

Example: "C:\Program Files\Cisco\WFO_
QM\Java\bin\keytool.exe" -keystore "C:\Program

Files\Common Files\QM\config\.keystore" -storepass

C@labr1o -importcert -trustcacerts -alias 192.0.2.8_

root_x509 -file 192.0.2.8_root_x509.cer

4. Click Yeswhen the when the following prompt appears:

Trust this certificate?

This prompt appears because the certificate is self-signed (that is, the certificate is also
the owner) and the keytool cannot follow the chain back to a trusted root.

Step 5: Import intermediate certificates into the Quality Management keystore.

Note: You can skip this step if the QualityManagement certificate was signed by the root
CA. If the QualityManagement certificate was signed by an intermediate CA, then all
intermediate certificates in the chain back to the root must be imported.

From the command line on theQualityManagement base server, enter the following
command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -keystore

"C:\Program Files\Common Files\QM\config\.keystore" -storepass

C@labr1o -importcert -trustcacerts -alias <CA name> -file <CA

name>.cer

where <CA name> is the certificate file name.
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Step 6: Import the Quality Management Jetty certificate into the Quality Management
keystore.

From the command line on theQualityManagement base server, enter the following
command:

"C:\Program Files\Cisco\WFO_QM\Java\bin\keytool.exe" -keystore

"C:\Program Files\Common Files\QM\config\.keystore" -storepass

C@labr1o -importcert -alias jetty -file jetty.cer

This command imports the signed Jetty certificate into the QualityManagement keystore.

If the importation is successful, you will see the followingmessage:

Certificate reply was installed in keystore.

Step 7: Restart the Jetty service.

On theQualityManagement base server, use theWindowsServices utility in the Control Panel
to restart the Jetty service.

Step 8: Import root and intermediate certificates into the client web browsers.

This step is not necessary in the following situations:

n TheQualityManagement certificate was signed by a well-knownCA such as VeriSign,
or Thawte. Most modern browsers comewith themajor commercial CA root certificates
already installed. Lesser knownCAsmight not be installed.

n You are using Internet Explorer and an Active Directory CA where theQuality
Management base server and clients are all in the same Active Directory domain

To determine if you need to perform this step, start the client web browser and try to access
UnifiedWorkforce Optimization using the following URL:

https://<base

server>/cwfo/apps/login.html?userLang=en&userTheme=

cisco&userCountry=

where <QualityManagement server> is the host name or IP address of the server of the
QualityManagement base server.

n If you can connect without errors or requests to install certificates, you do not have to per-
form this step.

190



Managing Certificates

n If you see amessage indicating that the issuer of the certificate is not trusted, you need
to perform this step.

Best Practices: Chrome providesmore descriptive error messageswhen updating
certificates. Use Chrome to troubleshoot certificate errors.

For more information about installing root and intermediate certificates on the desktop, see
Installing Root and Intermediate Certificates on Desktops.

Expired Certificate from AD CS

Your CA will assign an expiration date to the QualityManagement certificate. When theQuality
Management certificate expires you will need to create a new CSR and import it to replace the
expired CSR. To replace an expired QualityManagement certificate, see Creating a signed
Certificate Signing Request (CSR) for theWeb Base Server.

To view the expiration date, double-click the QualityManagement certificate or after the Quality
Management is installed use the keytool -list command.

Installing Root and Intermediate Certificates on
Desktops

To install the root on any intermediate certificates on a desktop:

1. Copy the root and any intermediate certificates to any location the desktop.

Note: The root certificatemust be installed first, and after that any intermediate
certificates. Follow these steps for each certificate you want to install.

2. Double-click the certificate to open the Certificate dialog box.

3. On theGeneral tab, click Install Certificate and then click Next.

4. Select the Place all certificates in the following store option, and then click Browse to
select a certificate store:
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n For the root certificate, choose Trusted Root Certificate Authorities store

n For intermediate certificates, choose Intermediate Certificate Authorities store

5. Click Next and then Finish. When asked if you want to install the certificate, click Yes.

6. ClickOK after the certificate is installed.

7. ClickOK to dismiss the dialog box.

To verify that the certificates where installed correctly:

Open Internet Explorer and enter the following URL:

https://<base

server>/cwfo/aps/login.html?userLang=en&userTheme=

cisco&userCountry=

where <base server> is the host name or IP address of the server that hosts the Quality
ManagementWeb Base Services.

If the certificates are correctly installed you should not see any security warnings. The URL
contains HTTPS and a Lock icon appears in the Address bar.
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You can install the Recording Thin Client from aweb page that resides on theQuality
Management server. QualityManagement creates this web page when you install theWeb
Base Services.

The web page is ScreenRecordingThinClient.htm. This page contains a link to the Recording
Thin Client. The Recording Thin Client allows screen recording on a Citrix server. The
Recording Thin Client does not support the Automated Update feature.

Install the Recording Thin Client on the Citrix server after you install the services for Quality
Management.

Installing the Recording Thin Client on a Citrix Server

To manually install the Recording Thin Client on a Citrix server:

1. Open the Citrix server’s web browser and access the ScreenRecordingThinClient.htm
on the base server.

http://<base server>/TUP/QM/ScreenRecordingThinClient.htm

Where <base server> is the IP address or hostname for the base server. Note that this
address is case sensitive.

2. Follow the installation instructions on the web page to upgrade the applications on the
desktop.

3. Restart the Citrix server when prompted to ensure the services start correctly.
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SNMP Integration
The following products include SNMP integration for their Monitoring and Notification (MANA)
service.

n CiscoQualityManagement 9.0, 10.0, or 10.5

MANA is responsible for sending notifications to administrators or supervisors when it detects
events that might negatively affect the functioning of the software or system.

This document covers SNMP integration and how to take advantage of thismethod of
notification when you install Cisco QualityManagement.

Definitions

The following table defines terms used in this document.

Term Definition

MIB Management Information Base. A defined hierarchy of data values managed by a

single SNMP Agent application.

OID Object Identifier. A unique string of digits representing a value defined in anMIB.

SNMP Simple Network Management Protocol. A common network protocol that

describes messages passed between SNMP-enabled applications.

SNMP Agent An SNMP-enabled application that acts as a client to an SNMP management

application by providing data values for registered OIDs.

SNMP GET An SNMP message used to get a value for a particular OID.

SNMP

Management

Application

An SNMP-enabled application that can get or set information from a local or

remote SNMP Agent application.

SNMP SET An SNMP message used to set a value for a particular OID.

Trap An unsolicited SNMP message sent from an SNMP agent to an SNMP

management application.
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SNMP Implementation

TheMANA service already hasmethods to alert administrators of potential problemswith
QualityManagement. These products extend this functionality to SNMP so that
hardware/softwaremanagement is provided for customerswho already use SNMP
management software.

TheMANA service provides unsolicited alerts when it detects problem events. The alert
contains the details of the problem, which enables action to be taken to prevent loss of software
functionality. The SNMP trapmessage contains the same information and can be sent out to
multiple SNMPmanagement stations.

MIBs

TwoMIBs are used to define the trapmessages sent by the QualityManagement software:

n TheCISCO-SMI MIB contains definitions of frequently-used objects

n TheCISCO-GENERIC-TRAPMIB file defines the trapmessage format

Whereasmost MIBs are very specific in their use and definitions, the Generic TrapMIB was
designed to define a genericmessage that can be sent by anyCisco application. The data
values contained in the trap are used to decode the trap’s contents.

For example, theseOIDs are used to specify a particular Cisco product:

n 1.3.6.1.4.1.29988.1.1.1—used only for QualityManagement

n 1.3.6.1.4.1.29988.1.1.2—used only for Cisco Agent Desktop

n 1.3.6.1.4.1.29988.1.1.3—used only for CiscoWorkforceManagement

Rather than use these very specific OIDs, the Generic TrapMIB uses this single OID:

n 1.3.6.1.4.1.29988.1.2—uses a variable that maps to the appropriate product name

Using MIBs

The Installation Guide and Administrator User Guide for QualityManagement explain how to
install the product software and configure it to enable the sending of SNMP traps. Once
configured, MANA will send the SNMP trapmessages to all the IP addresses configured.
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These IP addresses represent machines that are running some type of SNMPmanagement
software.

TheMIB files are used in order for themanagement software to display the information from a
Cisco generic trap in a readable format, or to allow decision code running on themanagement
station to interpret these traps.

The two CiscoMIBs describe the layout of information found in the Cisco trap in a language
that SNMPmanagement stations understand. TheMIB files need to be placed on a drive
accessible to the SNMPmanagement software. Once there, the administrator configures the
management station to load theMIB files. How this is done varies, based on the SNMP
management station software provider.

The SNMP error codes are the same as theMANA error codes. These error codes are
documented in the Error Code Dictionary for version 8.6 or later.

Generic Trap

The trapmessage defined in the CISCO-GENERIC-TRAPMIB is a set of string and numeric
values that define the event. TheOIDs, field names, and field descriptions are shown in the
table below.

OID Field Description

1.3.6.1.4.1.29988.1.1 cigtTimestamp Numeric. The date and time the event was generated.

Number of seconds since 1/1/1970.

1.3.6.1.4.1.29988.1.2 cigtProduct String. The name of the product sending the trap.

1.3.6.1.4.1.29988.1.3 cigtVersion String. The version of Quality Management that is installed.

1.3.6.1.4.1.29988.1.4 cigtModule String. TheQuality Management module reporting the

event. For Quality Management, this is MANA. In the

future, other modules might be used in addition toMANA.

Elements of a trap message
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OID Field Description

1.3.6.1.4.1.29988.1.5 cigtSeverity Numeric. The severity of the event.

1 = Informational. Normal processingmessages.

2 = Warning. Abnormal event that does not affect

product functionality.

3 = Error. Error that affects some product functionality.

4 = Fatal. Serious error that causes loss of basic

functionality.

1.3.6.1.4.1.29988.1.6 cigtEventCode String. An alphanumeric error code representing the event.

This code is used to look up additional information in the

Error Code Dictionary.

1.3.6.1.4.1.29988.1.7 cigtEventText String. A readable string describing the event.
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This section describes how to install and upgrade desktop applications for Quality
Management.

You can use one of the following options to install the desktop applications on desktops:

n Manual installation

n Administered installation—using one of the automated package distribution tools.

For best practices, seeWindows Installer Logging.

Windows Installer Logging

Best Practices: EnableWindows Installer logging to capture loggable when installing
desktop applications.

Windows Installer logging can be enabled. This ensures that any loggable issues are captured
efficiently. To enableWindows Installer logging, run installations using the following command:

<client installation executable> /l*v <logfile path and name>

where <client installation executable> is the name of the desktop application's executable file
and <logfile path and name> is the name and location of the log file. The <logfile path and
name> is optional. If you do not provide a name and location for the log file, the log file will be
saved to a temp folder.

Example: Cisco UnifiedWFOMonitoring and Recording Recording.msi /l*v
c:\installer.log

Note: Specify a location for the logfile path and namewhere you have write permission.

199



Deploying Applications on the Desktop

Client Installation Packages Locations

Microsoft Installer (MSI) packages and the executable for the Screen Player Plug-in are
located in the following location on a successfully installed production server and are intended
for bothmanual and automated deployment:

http://<Web Base server>/TUP/QM

You can also generateMSI packages using a client configuration tool and unconfigured
installation templates. The client configuration tool is available in the following location:

C:\Program Files\Cisco\WFO_QM\bin\ConfigureClients.exe

TheRecording andQualityManagement installation ISO contains unconfigured installation
templates that, with the use of a client configuration tool, can be configured so that desktop
applications are available prior to the installation of the services for Recording andQuality
Management .

The unconfigured installation templates are located in the following file structure on the
installation ISO:

n Recording andQualityManagement Clients:

l Admin

l Recording

l RecordingThinClient

Manual Installation

This section describes how to deploy desktop applicationsmanually, and covers the following
topics:

n Manual Installation Requirements

n Installing Desktop Applications

Manual Installation Requirements

When installing desktop applicationsmanually, note the following requirements:
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n Machine Policy Value for EnableUserControl—Themachine policy value for EnableUser-
Control must be set to either Not Configured or Enabled. If it is set to Disabled, you will
not be able to install any desktop applications on the client machine.

n Elevated Privileges Policy for Windows Installer Installation—To allow users with limited
privileges to install a desktop application on a computer youmust enable theWindows
policy “Always Install with Elevated Privileges” for both the User Configuration and the
Computer Configuration.

By default, Windows Installer installations run in the context of the logged-on user. When
this policy is enabled,Windows Installer installationswill run in a context with elevated
privileges, thus allowing the install to successfully complete complex tasks that require a
privilege level beyond that of the logged-on user.

To elevate the privileges on a user’s computer so the user can install the desktop
applications:

1. Start theMicrosoft Management Console (MMC) Active Directory Users and
Computers snap-in.

2. Right-click the appropriate organizational unit (OU) and select Properties from
the popupmenu.

3. On theGroup Policy tab, select the Group Policy object (GPO) and then click
Edit.

4. Expand Computer Configuration > Administrative Templates > WindowsCom-
ponents > Windows Installer.

5. Double-click Always install with elevated privileges.

6. Choose Set to Enabled, and then clickOK.

7. Expand User Configuration > Administrative Templates > WindowsCom-
ponents > Windows Installer.

8. Double-click Always install with elevated privileges.

9. Choose Set to Enabled, and then clickOK.

Youmust enable this GPOunder both the User Configuration and Computer
Configuration sections for it to take effect.
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Installing Desktop Applications

You can install the desktop applications fromweb pages that reside on theWeb Base server.
These web pages are created when you install theWeb Base Services.

Install the desktop applications after you install and configure the services for Recording and
QualityManagement .

To install desktop applications for Recording and Quality Management:

1. On the computer where you want to install the desktop application, start Microsoft Inter-
net Explorer.

2. Enter the appropriate installation web page address in the Address field. Your options
are as follows:

n http://<Web Base server>/TUP/QM/Administrator.htm—This page contains links
to the install files for all desktop applications—QualityManagement Administrator,
Desktop Recording service, and Cisco Screen Player Plug-in.

Note: QualityManagement Administrator is automatically installed on the
Web Base server.

n http://<Web Base server>/TUP/QM/Desktop.htm—This page contains a link to
the Cisco Screen Player Plug-in install files.

n http://<Web Base server>/TUP/QM/Recording.htm—This page contains a link to
the Desktop Recording service install files.

n http://<Web Base server>/TUP/QM/MSPackage.htm—This page contains a link
to theMicrosoft Visual C++ 2005 Redistributable Package (x86) install file. The
Microsoft Visual C++ 2005 Redistributable Package is only required for
managers and supervisors that want to use the Live ScreenMonitoring feature.

The installation web page appears.

3. Follow the instructions on the web page to install the desktop application.

4. Choose the option that applies to this installation:

n The followingmessage appears when installing the Desktop Recording Service
or the Recording Thin Client:
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A system reboot is pending. Reboot themachine before installing
<ProductName>.

To resolve this issue, restart the desktop, and then install Desktop Recording
Service or the Recording Thin Client again.

n If the previous option does not apply, no additional action is required.

Administered Installation

This section describes how to deploy desktop applications automatically, and covers the
following topics:

n Administered Installation Requirements

n Using Automated Package Distribution Tools

n Administered Installation Best Practices

n RecommendedDeployment PreparationModel

n Configuring Client Installation Files

Administered Installation Requirements

The requirements for an administered configuration are as follows:

n Execution—Installationsmust be executed on the target machine.

n Per-machine vs. per user—Installationsmust be deployed on a per-machine basis. Per-
user installations are not supported.

Using Automated Package Distribution Tools

You can deploy (push) executable-based desktop application installations through automated
package distribution tools that make use of theMicrosoft Windows Installer service.

Administered Installation Best Practices

Create a deployment package for each installation package.

Before deploying an installation package, the deployment engineer should test an installation
and an uninstallation of the deployment package.
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Best Practice: Deploy each installation package using its own deployment package.
Using separate deployment packages allows you to isolate potential issues faster than a
composite deployment package.

Recommended Deployment Preparation Model

Use the following deployment preparationmodel to test the deployment in a test environment
before you deploy an update on your production server.

1. Use a lab environment to model the pending deployment.

2. Verify that the required hardware and software are installed on the desktop clients. See
the Desktop RequirementsGuide for more information.

3. Install the servers to obtain valid client installation packages or use the
client configuration tool. See Client Installation Package Locations for the location of
the client installation packages on the server.

4. Manually deploy client installation packages to ensure that the installs are compatible
with your environment.

This will isolate product installation vs. automated deployment issues.

5. Create your deployment packages in accordance with the requirements listed in
Administered Installation Requirements.

Note: Cisco recommends creating installation and uninstallation deployment
packages.

6. Test the deployment packages.

7. At deployment time, modify your deployment packages, replacing the client installation
packages from the lab environment with valid client installation packages from the
production server.

Configuring Client Installation Files

To configure client installation files with the client configuration tool (ConfigureClients.exe
for Recording and Quality Management or ConfigureClient.exe for CAS):
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1. Create a virtual drive and then load the ISOon that drive.

2. Copy the Clients folder and all of its contents from the Recording andQualityMan-
agementinstallation ISO to a desktop.

3. On the desktop, open a commandwindow and navigate to the Clients folder.

4. Run the ConfigureClients.exe as administrator.

5. The configuration tool starts.

6. Type the IP address or hostname of theWeb Base server and press Enter.

7. Type the IP address or hostname of the Surrogate Host and press Enter.

The utility creates installation files for all QualityManagement desktop applications.

Managing Certificates

How youmanage certificates on a desktop depend on where the certificate is signed.

If your signed certificate is from awell knownCertificate Authority (CA) or you imported the
signed certificate into Active Directory, there is nothing additional that you need to do.Well
knownCAs, like VeriSign or Thawte, include certificates as part of the Java cacerts store.

If your signed certificate is fromActive Directory Certificate Server (AD CS), and you imported
the signed certificate into Active Directory, there is nothing additional that you need to do. If the
desktop client is not included in the Active directory domain, you need to import the certificate.

Lesser knownCAs, such asGoDaddy, will need to be installed on the client machine or
browser. You can add a trusted root CA to aGroup Policy object (GPO). Microsoft provides
instructions for adding a trusted root CA to aGPOat http://technet.microsoft.com/en-
us/library/cc738131.aspx.

Internet Explorer will look for the certificate in the internalmachine certificate store on the
desktop.

Upgrading the Desktop Applications

To upgrade Recording and Quality Management desktop applications:
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1. Choose one of the following upgrade options:

n If you are upgrading from a version prior to 11.0(1), youmust uninstall the
existing desktop applications before you install 11.0.

Important: Over-the-top upgrades from versions prior to 11.0(1) are not
supported and will be blocked.

n If you installing a version later than 11.0(1), you can install the desktop
applications over-the-top.

2. Install the following applications onto each desktop:

n Cisco Screen Player Plug-in

n Desktop Recording service

n QualityManagement Administrator—on the administrator’smachine only

See Installing Desktop Applications for more instructions.

Testing the Desktop Recording Service Installation on
Desktops

If you have desktops that run on different operating systems, test three or four desktops for
each operating system using Recording andQualityManagement in your environment and
generate test calls to phones associated with each of the desktops before a scheduled upload
occurs.

Example: You environment includes desktopswith administrative privileges and
laptopswith administrator privileges.

To test Desktop Recording Services after a fresh installation or an upgrade:

1. Log on to a desktop.

2. Generate test calls.

3. Verify the recordings uploaded successfully to the designated recording file storage loc-
ation.
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4. Repeat steps 1-3 for each desktop in your test set.

5. After testing the sample desktops, continue updating the remaining desktops.

Example: If your environment uses desktops and laptops, you need to test the following
scenarios:

n Desktop with administrator privileges

n Desktop with elevated privileges

n Laptop with administrator privileges

n Laptop with elevated privileges
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Removing Quality Management
To uninstall QualityManagement, youmust proceed in the following order:

n Uninstall any ET present.

n Uninstall the QualityManagement services.

Recordings are not uploaded from client or server computers when you removeQuality
Management. They aremaintained on the same drive where you installed the services for
QualityManagement. The default location on the storage server for uploaded recordings is:

C:\Program Files\Common Files\QM\Recordings

If you did not use the default location, you specify the custom location you used when you
installed QualityManagement.

NOTE: A user must log in as an administrator in order to remove anyQuality
Management applications.

Removing Services

When you removeQualityManagement services, the QualityManagement software is
completely removed except for the QualityManagement database. The components can be
removed in any order.

To remove Quality Management services, follow these steps:

1. Log into the QualityManagement server as the localmachine administrator or domain
administrator.

2. Start the Programs and Features utility in Control Panel.

There can be up to three programs listed for QualityManagement, depending on what
you installed on the server:

a. Cisco UnifiedWFO Monitoring and Recording ServicesFramework

b. Cisco UnifiedWFO Monitoring and Recording Services
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c. Cisco UnifiedWFO Monitoring and Recording Jetty

If you choose (a) for removal, (b) and, if present, (c) are also removed. If you choose
either (b) or (c) for removal, only that program is removed.

3. Click Uninstall, and follow the prompts.

4. After the uninstall is completed, you are prompted to reboot. You are given the option to
reboot now or later. It is recommended that you reboot immediately to complete the
uninstallation process.

Removing a Quality Management Desktop
Application

To uninstall the components identified in Removing Quality Management:

1. Open theWindowsControl Panel.

2. Double-click Add or Remove Programs.

3. From the list, select the application you wish to remove and click Remove.

If you are runningWindows 7, a RebootWarning dialog boxmight appear behind the
current window after you uninstall the application. Move the current window out of the
way to check for the RebootWarning dialog box.

If you are prompted to reboot themachine to remove the software, click No. This reboot
prematurely terminates background installation activities. You canmanually reboot the
machine before you install any software.

If you intend to reinstall QualityManagement after completely removing an older
version (a clean install), verify that the recording storage folder structures are removed
before installing the new version.

Windows removes the application.

4. Restart themachine.

Removing the Quality Management Databases

Using theWindowsControl Panel on theQualityManagement server to remove services does
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not remove theQualityManagement database (SQMDB).

Important: If you intend to reinstall or upgradeQualityManagement, and you want to
retain historical data, youmust not remove theQualityManagement database.

To remove the Quality Management database completely:

1. On the server that hosts the QualityManagement database, launch and log in to
Microsoft SQL Server Management Studio.

2. In the left navigation pane, expand the Databases node and right-click SQMDB.

3. From the popupmenu, choose Delete.

The Delete Object window appears.

4. Select the Close existing connections check box and then clickOK.
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Backup and Restore
There are two situationswhen you need to create a backup of the QualityManagement data.

n Upgrading your system to the latest version of QualityManagement.

n Making a disaster recovery backup for QualityManagement data.

The data that you should back up includes theQualityManagement database, the .keystore file
if you are using signed certificates, and your custom logo.

Quality Management Database Disaster Recovery

The SQMDB database stores historical data and report data. Cisco recommends backing up
the SQMDB database periodically for the purpose of database disaster recovery.

Best Practices: Always back up the SQMDB database before an upgrade. This allows
you to roll back to the previous version, if necessary.

Back up the SQMDB database to another folder on the computer that hosts theMicrosoft SQL
Server.

To back up your Quality Management system:

1. On the server that hosts the QualityManagement database, launch and log in to
Microsoft SQL Server Management Studio.

2. Right-click the database name (SQMDB) under the Databases node.

A menu appears.

3. Choose Tasks > BackUp.

The Restore Database window appears.

4. Complete the fields and clickOK.

To restore your Quality Management system from the backup files:
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1. CloseQualityManagement Administrator.

2. Stop the following services for QualityManagement:

n DB Cleaner service

n DB Proxy service

n MANA service

n Sync service

n Upload Controller service

n Network Recording service

n Monitor service

n Jetty on the Site Upload server and theWeb Base server

n MediaSense Subscription service

3. On the server that hosts the QualityManagement database, launch and log in to
Microsoft SQL Server Management Studio.

a. Right-click the database name (SQMDB) under the Databases node.

A menu appears.

b. Choose Tasks > Restore > Database.

The Restore Database window appears.

c. Complete the fields and clickOK.

4. Restart the services for QualityManagement you stopped in step 2.

Jetty SSL Certificate File Recovery

To back up the .keystore file:

1. On theWeb Base server where the .keystore file resides, go to the following directory:

C:\ProgramFiles\Common Files\QM\config\

2. Copy the .keystore file and save it to a safe location.

To restore the .keystore file:

1. Go to the location where the backup .keystore file resides and copy the .keystore file.

2. On theWeb Base server, paste the .keystore file in the following directory:

C:\ProgramFiles\Common Files\QM\config\
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Custom Logo File Recovery

To back up your custom logo:

1. Navigate to the C:\ProgramFiles\Cisco\WFO_QM\Jetty\report_solutions\reports
folder.

2. Copy the logo file and save it to a backup folder.

To restore your custom logo:

1. Start postinstall.exe or QualityManagement Administrator.

2. On the Enterprise Settingswindow, click Report Logo Configuration.

3. Click Select New Logo, browse to the location of your logo, and then click Select
Image.

4. Click Save.

5. Restart the Jetty service.
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